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About this Manual
The manual describes the features of QuickDAQ 2104, how to get started using QuickDAQ 
2014, and how to create a typical application to acquire and analyze data from a data 
acquisition device. 

Note that QuickDAQ 2014 is referred to as QuickDAQ throughout this manual.

Intended Audience

This document is intended for engineers, scientists, technicians, or others responsible for 
acquiring and analyzing measurement data. It is assumed that you are familiar with the 
Windows operating environment, that you are familiar with measurement principles. 

Organization of this Manual

This manual is organized as follows:

• Chapter 1, “Introduction to QuickDAQ,” provides an overview of the features of 
QuickDAQ.

• Chapter 2,  “Quick Start,” describes how to install and start QuickDAQ. 

• Chapter 3, “Understanding the Interface,” describes the basic elements of the Data Logger 
and FFT Analyzer interfaces of QuickDAQ. 

• Chapter 4,  “Configuring Channels, Acquisition Settings, and Digital Filters,” describes 
how to configure the channels and acquisition settings of a supported device using 
QuickDAQ. 

• Chapter 5, “Configuring the Display of the Data Logger Interface,” describes how to 
configure the settings of the Channel Plot, Channel Display, and Statistics windows when 
using the Data Logger interface of QuickDAQ. 

• Chapter 6, “Configuring the Display of the FFT Analyzer Interface,”  describes how to 
configure the settings of the Channel Plot, Channel Display, and Statistics windows when 
using the FFT Analyzer interface of QuickDAQ.

• Chapter 7, “Examples Using the Data Logger Interface,” provides step-by-step 
instructions that you can follow to create applications when using the Data Logger 
interface of QuickDAQ.

• Chapter 8, “Examples Using the FFT Analyzer Interface,” provides step-by-step 
instructions that you can follow to create applications when using the FFT Analyzer 
interface of QuickDAQ.

• Chapter 9, “Support,” provides technical support information.

A glossary and index complete this manual. 
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Conventions Used in this Manual

The following conventions are used in this manual: 

• Notes provide useful information that requires special emphasis, cautions provide 
information to help you avoid losing data or damaging your equipment, and warnings 
provide information to help you avoid catastrophic damage to yourself or your 
equipment.

• Items that you select or type are shown in bold. 

Related Information

This manual is intended to be used with the documentation for your data acquisition device.

Where to Get Help

Should you encounter problems installing or using QuickDAQ, the Data Translation Technical 
Support Department is available to provide technical assistance. Refer to Chapter 9 starting on 
page 383 for information on how to contact the Technical Support Department. 
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Features
Three versions of QuickDAQ 2014 are available:

• QuickDAQ 2014 Base – This free-of-charge application allows you to perform the 
following functions:

− Discover and select your devices.

− Configure all input channel settings for the attached sensors.

− Load/save multiple hardware configurations.

− Generate output stimuli (fixed waveforms, swept sine waves, or noise signals).

− On each supported data acquisition device, acquire data from all channels supported 
in the input channel list.

− Choose to acquire data continuously or for a specified duration.

− Choose software or triggered acquisition.

− Log acquired data to disk in an .hpf file.

− Display acquired data during acquisition in either a digital display using the Channel 
Display window or as a waveform in the Channel Plot window.

− Choose linear or logarithmic scaling for the horizontal and vertical axes.

− View statistics about the acquired data, including the minimum, maximum, delta, and 
mean values, and the standard deviation in the Statistics window.

− Export time data to a .csv or .txt file; you can open the recorded data in Microsoft 
Excel® for further analysis.

− Read a previously recorded .hpf data file. 

− Customize many aspects of the acquisition, display, and recording functions to suit 
your needs, including the acquisition duration, sampling frequency, trigger settings, 
filter type, and temperature units to use.

• QuickDAQ 2014 FFT Analysis Option – When enabled with a purchased license key, the 
FFT Analysis option includes all the features of the Base package plus these features:

− The ability to switch between the Data Logger time-based interface and the FFT 
Analyzer block/average-based interface.

− Supports software, freerun, or triggered acquisition with accept and reject controls for 
impact testing applications.

− Allows you to perform single-channel FFT (Fast Fourier Transform) operations, 
including AutoSpectrum, Spectrum, and Power Spectral Density, on the acquired 
analog input data. You can configure a number of parameters for the FFT, including 
the FFT size, windowing type, averaging type, integration type, and so on.

− Allows you to display frequency-domain data as amplitude or phase.

− Supports dB or linear scaling with RMS (root mean squared), peak, and peak-to-peak 
scaling options

− Supports linear or exponential averaging with RMS, vector, and peak hold averaging 
options.
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− Supports windowed time channels.

− Supports the following response window types: Hanning, Hamming, Bartlett, 
Blackman, Blackman Harris, and Flat top.

− Supports the ability to lock the waveform output to the analysis frame time.

− Allows you to configure and view dynamic performance statistics, including the input 
below full-scale (IBF), total harmonic distortion (THD), spurious free dynamic range 
(SFDR), signal-to-noise and distortion ratio (SINAD), signal-to-noise ratio (SNR), and 
the effective number of bits (ENOB), for selected time-domain channels in the Statistics 
window.

− Supports digital IIR (infinite impulse response) filters.

• QuickDAQ 2014 Advanced FFT Analysis Option – When enabled with a purchased 
license key, this version includes all the features of the Base package with the FFT 
Analysis option plus these features:

− Allows you to designate a channel as a Reference or Response channel.

− Allows you to perform two-channel FFT analysis functions, including Frequency 
Response Functions (Inertance, Mobility, Compliance, Apparent Mass, Impedance, 
Dynamic Stiffness, or custom FRF) with H1, H2, or H3 estimator types, 
Cross-Spectrum, Cross Power Spectral Density, Coherence, and Coherent Output 
Power.

− Supports the Exponential response window type.

− Supports the following reference window types: Hanning, Hamming, Bartlett, 
Blackman, Blackman Harris, FlatTop, Exponential, Force, and Cosine Taper windows.

− Supports real, imaginary, and Nyquist display functions.

− Allows you to save data in the .uff file format.

Supported Devices

You can acquire and analyze data from a number of devices using QuickDAQ, including the 
following:

• All DT-Open Layers devices that support A/D streaming 

• MEASURpoint instruments

• TEMPpoint instruments

• VOLTpoint instruments

• DT8824 and DT8824-HV instrument modules

• DT8837 instrument modules (analog input operations only)

Analog output operations are supported on devices that support D/A streaming. Single-value 
analog output operations are currently not supported.
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Modes of Operation

You can use QuickDAQ in one of two operation modes:

• Acquisition mode – Use this mode if you want to acquire data in the analog input stream 
and/or output an analog waveform. This mode requires use of at least one of the 
supported Data Translation devices; refer to page 18 for a list of supported devices.

• File reader mode – Use this mode if you want to view a previously recorded data file. 
Note that you cannot acquire new data using the File reader mode.



Introduction to QuickDAQ
Licensing Requirements
QuickDAQ 2014 includes a 14-day trial version of the FFT Analysis and Advanced FFT 
Analysis options. Once you start the software, you have 14 consecutive calendar days in 
which to try the features of the application.

To use the trial version, click Continue Evaluation.

Note: If you do not want to show the License Info dialog, select the Don’t show this dialog 
at startup checkbox. You can access the License Info dialog from the License Information... 
option of the Help menu.

When the 14-day trial period has elapsed, you can continue using the Base package, but the 
features of the FFT Analysis and Advanced FFT Analysis options are no longer available. The 
License Info dialog will no longer be shown.
21
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If you want to continue using the analysis features, you must purchase either the FFT Analysis 
license key or the Advanced FFT Analysis license key depending on the features that you 
require. See page 18 for the list of features that each option provides. To purchase a license, 
perform the following steps:

1. Click Purchase License. 
The appropriate Data Translation web page is displayed.

2. Purchase the license key for the analysis package that you want.

3. Click Enter License from the License Info dialog.
The Enter License Key dialog is displayed.

4. If desired, you can copy the license key to the clipboard.

5. Enter the license key or paste the license key from the clipboard using the Paste from 
Clipboard button, and click Apply License and Continue.
If the application was running when you entered the license key, the application will restart. 
Otherwise, the application continues with either the Device Selection dialog, if an existing 
configuration file is not found, or the main interface.

Note: If, after the trial period has expired, you try to load a configuration file that was saved 
with the FFT Analysis or Advanced FFT Analysis option, the configuration will not load and 
an error message will be generated.

If you have a license file for the FFT Analysis option but try to load a configuration file that 
was saved with the Advanced FFT Analysis option, the configuration will load but any FRF 
channels or other non-supported parameters will be missing.
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Resolution Requirements
A minimum vertical screen resolution of 768 is required for proper operation of QuickDAQ.

In addition, it is recommended that you set the default font size to 100%. To do this, select 
Control Panel, Display, and then choose Smaller (100%).
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Installing the Software
The QuickDAQ software is installed automatically when you install the device driver for your 
hardware. 

No other software installation is required.
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Getting Started
To get started with QuickDAQ, follow these steps:

1. Connect a supported device to the network (Ethernet/LXI devices) or to the USB port of 
your computer (for USB devices), and connect your sensors to the device.

2. Start QuickDAQ.
The Device Selection window appears.

Note: If you ran QuickDAQ before and the devices that were used are still present and 
are not acquiring data, the Device Selection window is bypassed. If the devices support 
password protection, you must supply the correct password before the application 
launches. Refer to the user’s manual for your device to determine the default password.

For devices that do not support password protection and that are currently acquiring 
data, a warning dialog box appears notifying you that another application is using the 
device. You cannot continue with QuickDAQ until the device is not acquiring data.

For devices that support password protection and that are currently acquiring data, the 
software alerts you that the device is acquiring data and gives you the option to abort 
acquisition and continue, or to cancel.

3. By default, the application "discovers" all devices that are available for the specified 
device family and displays their IP address (for Ethernet devices) or module name (for 
USB devices) in the drop-down list. If you want to refresh this list to determine if other 
devices are available, click Refresh. 
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Notes: The Device Family dropdown shows only the interfaces that are installed on your 
system.

OpenLayersDevices is the Device Family name for all Open Layers modules.

MEASURpoint-USB is the Device Family name for the USB versions of MEASURpoint, 
TEMPpoint, and VOLTpoint instruments. 

MEASURpoint-ENET is the Device Family name for all Ethernet versions of 
MEASURpoint, TEMPpoint, and VOLTpoint instruments.

DT8824 is the Device Family name for all DT8824 Series instrument modules.

DT8837 is the Device Family name for the DT8837 instrument module.

4. Select the IP address (for Ethernet devices) or module name (for USB devices) for the 
device that you want to use from the list of Available Devices, and click Add.
Information about the device, including the model number, serial number, firmware version, driver 
version, and scanning status is displayed. 

5. For Ethernet devices, if your supported device is not included in the list of available 
devices, but you want to manually connect to it, do the following:

a. Click Advanced.

b. Enter the IP address of the device that you want to connect to, and click OK. 
Information about the device, including the model number, serial number, firmware version, 
driver version, and scanning status is displayed.

c. From the Device Selection window, click Add.   
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d. If the device supports password protection, the Password Required dialog box 
appears:

e. If prompted, enter the password for the device. Refer to the user’s manual for your 
device to determine the default password. By default, the Mask password text box is 
checked so that you cannot read the password as it is being typed. If desired, you can 
uncheck this box, if desired. (Note that the software does not allow you to continue if 
you do not enter the appropriate password for the device.) 
29
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Note: If the device that you want to add does not support password protection and the 
device is currently acquiring data, a warning dialog box appears notifying you that 
another application is using the device. You cannot continue with QuickDAQ until the 
device is not acquiring data.

If the device that you want to add supports password protection and the device is 
currently acquiring data, the software alerts you that the device is acquiring data and 
gives you the option to abort acquisition and continue, or to cancel.

6. (Recommended) If you want to rename your device, do the following:

a. Click the Row Selector button for the device.

b. Click the IP address or module name in the Name column to highlight it and enter a 
meaningful name to represent each available device.   

7. (Optional) If you want to remove a device from list of selected devices, click the Row 
Selector button for the device, and then click Remove.

8. Once you have added all the devices that you want to use with the application, click OK. 
The latest state is saved and used when the application is next run, and the QuickDAQ interface is 
displayed.   
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9. Configure the input channels of the device. (See page 84.)

10. If you are using the FFT Analysis option or Advanced FFT Analysis option, choose either 
the Data Logger or FFT Analyzer interface mode. (See page 47).
The Base package provides the Data Logger interface mode only.

11. If you are using the Data Logger interface mode, perform these steps:

a. Configure the recording settings of the device using the Recording tab of the 
Acquisition Config window. (See page 119.)

b. Configure the frequency settings of the device using the Freq tab of the Acquisition 
Config window. (See page 125.)

c. If you are using analog output channels, configure the parameters of the Output tab in 
the Acquisition Config window. (See page 138.)

d. If you are using digital filters, configure the digital filter settings. (See page 162.)

e. Set up the parameters of the Channel Plot, Channel Display, and/or Statistics 
windows. (See Chapter 5 starting on page 167.)

12. If you are using the FFT Analyzer interface mode, perform these steps:

a. Configure the recording settings of the device using the Recording tab of the 
Acquisition Config window. (See page 122.)

b. Configure the frequency settings of the device using the Freq tab of the Acquisition 
Config window. (See page 128.)

c. Configure the trigger parameters of the device using the Trigger tab of the Acquisition 
Config window. (See page 131.) 
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d. Configure the window functions for FFT channels using the Window tab of the 
Acquisition Config window. (See page 135.)

e. If you are using analog output channels, configure the parameters of the Output tab of 
the Acquisition Config window. (See page 138.)

f. If you are using digital filters, configure the digital filter settings. (See page 162.)

g. Set up the parameters of the Channel Plot, Channel Display, and/or Statistics 
windows. (See Chapter 6 starting on page 189.)

13. To start acquisition, click the Record menu and then click Start, click the Record toolbar 
button (  ), or press the F5 key.
The results are displayed in the Channel Plot window and in the Channel Display window.
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Toolbar B
Overview of the Interface
The Base package of QuickDAQ provides a Data Logger interface, shown in Figure 1.

If you using the FFT Analysis option or Advanced FFT Analysis option, you can choose either 
the Data Logger or FFT Analyzer interface using the Mode menu. Figure 2 shows the FFT 
Analyzer interface of QuickDAQ.

Both interface modes include menus, toolbar buttons, a configuration area, which includes the 
Acquisition Config window and the Plot and Data Config window, a display area, which 
includes the Channel Display window, Channel Plot window, and Statistics window, and the 
Acquisition Status window. 

Figure 1: Data Logger Interface of QuickDAQ
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Toolbar B
Figure 2: FFT Analyzer Interface of QuickDAQ

This chapter describes the features of both interface modes of QuickDAQ.

Note: You can customize the look of the interface, as desired. However, if you want to revert 
to the default layout, select Windows from the list of menus and select Reset Window Layout 
to Default Layout.

uttons

Configuration Area

Display Area

Acquisition Status Window
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Menus
QuickDAQ provides the following menus: File, Edit, Record, Plot, Configuration, Windows, 
Mode, and Help. 

File Menu

This section describes the options provided in the File menu.

New Hpf Data File 

When you click the New Hpf Data File option of the File menu or click the New HPF Data 
File toolbar button , you can create a new (empty) data file for use with QuickDAQ. You 
can name and save the data file, as desired. The format of this file is High Performance binary 
(.hpf). 

By default, the data file is stored in the following location:

For Windows Vista, Windows 7, or Windows 8:
C:\Users\<username>\AppData\Local\Data Translation\QuickDAQ\Data

For Windows XP:
C:\Documents and Settings\<user name>\Local Settings\Application Data\
Data Translation\QuickDAQ\Data

Note: To see the AppData folder, ensure that you set your view options to show hidden files. 
For example, in Windows 7, select Control Panel -> Appearance and Personalization -> 
Folder Options, select the View tab, and then select the Show hidden files, folders, and 
drives checkbox. Consult the documentation for your operating system for more 
information.

Open Hpf Data File 

When you click the Open Hpf Data File option of the File menu or click the Open HPF Data 
File toolbar button , you can open an .hpf data file that was created using QuickDAQ. 

A sample data file, called QuickDAQ Data.hpf, is provided, by default, in the following 
location:

For Windows Vista, Windows 7, or Windows 8:
C:\Users\<username>\AppData\Local\Data Translation\QuickDAQ\Data

For Windows XP:
C:\Documents and Settings\<user name>\Local Settings\Application Data\
Data Translation\QuickDAQ\Data
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Close Hpf Data File 

The Close Hpf Data File option closes an opened data file (.hpf), restoring the previous state 
of QuickDAQ.

Export Data

When you click the Export Data menu option from the File menu, or click the Export Data 
toolbar button , the File Export dialog appears. This dialog is different for each interface 
mode.

File Export Dialog for the Data Logger Interface

The File Export dialog for the Data Logger interface is shown in Figure 3.

Figure 3: File Export Dialog for the Data Logger Interface

Configure this dialog as follows:

1. Under the Channels to Save area of the dialog, you can select whether to save the data 
from all channels or only those that are visible in the Channel Plot window or Channel 
Display window.

To save data from all channels, select All channels.

To save data from only the visible channels, select Visible channels only.
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2. Under the Data Options area of the dialog, select which data to save.

You can save all scans by selecting Save all data, or save a subset of scans by selecting 
Save range of scans and entering the first scan and the last scan to save.

3. Under the Output File Format area of the dialog, select the file format to use when 
exporting the data:

− Tab Delimited Text (.txt) – This file format is used by a number of applications, 
including Microsoft Excel. 

− Comma Delimited Text (.csv) – This file format is used by a number of applications, 
including Microsoft Excel.

Note: In tab delimited text (.txt) files, the time column shows the relative time in seconds 
of when the sample was acquired. 

In comma delimited text (.csv) files, the time column shows the Excel time, where the 
number represents the number of days since 1900-Jan-0, plus a fractional portion of a 24 
hour day. If you chose to display data as absolute time, then the first sample represents the 
start time of the acquisition. If you chose to display data in relative time, then the first 
sample represents time 0. Within Excel, you can format this column to use a more 
meaningful time option if you wish by right-clicking the selected column, choosing 
Format Cells, choosing Time, and selecting the option you want to use.

If you wish, you can export information about the device and channels that correspond to 
the saved data, by selecting the Include device and channel info checkbox.

4. Under Filename generation, specify how to create the name of the file. You can choose 
one of the following options:

− Filename – The specified filename is created when you click the Export button. Each 
time you click the Export button, you will be prompted to overwrite the file. 
SavedRange.uff is an example of a filename that was created using the Filename 
option.

− Filename-Sequence – The specified filename is created and a starting number that you 
define is appended to the filename when you click the Export button. Each time you 
click the Export button, the number that is appended to the filename is incremented by 
one. SavedRange.txt-1 is an example of a filename that was created using the 
Filename-Sequence option.

− Filename-DateTime – The specified filename is created and the current date and time is 
appended to the filename when you click the Export button. Each time you click the 
Export button, the filename with the current date and time is created. 
SavedRange-2012-06-25_02-39-59-PM.txt is an example of a filename that was created 
using the Filename-DateTime option.
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5. In the Filename text box, enter or browse to the name of the file that will contain the 
exported data.
The path showing where the file is located is shown.

The default location for saving the data files is as follows:

For Windows Vista, Windows 7, or Windows 8:
C:\Users\<username>\AppData\Local\Data Translation\QuickDAQ\Data

For Windows XP:
C:\Documents and Settings\<user name>\Local Settings\Application Data\
Data Translation\QuickDAQ\Data

6. Click the Export button to export the data to the file you specified.

7. Once the file is created, you can open the file in Microsoft Excel by clicking the Open in 
Excel button.

8. When you are finished exporting the data, close this dialog box by clicking the Done 
button.

File Export Dialog for the FFT Analyzer Interface

The File Export dialog for the FFT Analyzer interface is shown in Figure 4.

Figure 4: File Export for the FFT Analyzer Interface
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Configure this dialog as follows:

1. Under the Data Domain to Save area of the dialog, choose the type of data to save. 

For time domain data, select Time History Data.

For frequency domain data, select Frequency Domain Data.

2. If you selected Time History Data, select which records to save under the Time Domain 
Data Options area of the dialog.

You can save all the records by selecting Save all data, or save a subset of records by 
selecting Save range of records and entering the first record and the last record to save.

3. If you select Frequency Domain Data, you can select which data to save under the 
Frequency Domain Data Options area of the dialog.

You can save the average of all records by selecting Save averaging results, or save a 
subset of source records by selecting Save range of source records and entering the first 
record and the last record to save.

If you are using the Advanced FFT Analysis option and are using FRF channels, you also 
choose whether to save real data by selecting Save Real FRF data or complex data by 
selecting Save Complex FRF data.

4. Under the Channels to Save area of the dialog, you can select whether to save the data 
from all channels or only those that are visible in the Channel Plot window.

To save data from all channels, select All channels.

To save data from only the visible channels in the Channel Plot window, select Visible 
channels only.

5. Under the Output File Format area of the dialog, select the file format to use when 
exporting the data:

− Universal File Format-ASCII (.uff) – Available only in the Advanced FFT Analysis 
option of QuickDAQ, this file format is used by a number of applications, including 
ME’scope™ from Vibrant Technology.

− Tab Delimited Text (.txt) – This file format is used by a number of applications, 
including Microsoft Excel. 

If this file format is selected, you can also choose to export information about the 
device and channels that correspond to the saved data, by selecting the Include device 
and channel info checkbox.

− Comma Delimited Text (.csv) – This file format is used by a number of applications, 
including Microsoft Excel.

If this file format is selected, you can also choose to export information about the 
device and channels that correspond to the saved data, by selecting the Include device 
and channel info checkbox.
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Note: In tab delimited text (.txt) files, the time column shows the relative time in seconds 
of when the sample was acquired. 

In comma delimited text (.csv) files, the time column shows the Excel time, where the 
number represents the number of days since 1900-Jan-0, plus a fractional portion of a 24 
hour day. If you chose to display data as absolute time, then the first sample represents the 
start time of the acquisition. If you chose to display data in relative time, then the first 
sample represents time 0. Within Excel, you can format this column to use a more 
meaningful time option if you wish by right-clicking the selected column, choosing 
Format Cells, choosing Time, and selecting the option you want to use.

6. Under Filename generation, specify how to create the name of the file. You can choose 
one of the following options:

− Filename – The specified filename is created when you click the Export button. Each 
time you click the Export button, you will be prompted to overwrite the file. 
SavedRange.uff is an example of a filename that was created using the Filename 
option.

− Filename-Sequence – The specified filename is created and a starting number that you 
define is appended to the filename when you click the Export button. Each time you 
click the Export button, the number that is appended to the filename is incremented by 
one. SavedRange.uff-1 is an example of a filename that was created using the 
Filename-Sequence option.

− Filename-DateTime – The specified filename is created and the current date and time is 
appended to the filename when you click the Export button. Each time you click the 
Export button, the filename with the current date and time is created. 
SavedRange-2012-06-25_02-39-59-PM.uff is an example of a filename that was created 
using the Filename-DateTime option.

7. In the Filename text box, enter or browse to the name of the file that will contain the 
exported data.
The path showing where the file is located is shown.

The default location for saving the data files is as follows:

For Windows Vista, Windows 7, or Windows 8:
C:\Users\<username>\AppData\Local\Data Translation\QuickDAQ\Data

For Windows XP:
C:\Documents and Settings\<user name>\Local Settings\Application Data\
Data Translation\QuickDAQ\Data

8. Click the Export button to export the data to the file you specified.

9. Once the file is created, you can open the file in Microsoft Excel by clicking the Open in 
Excel button.

10. When you are finished exporting the data, close this dialog box by clicking the Done 
button.
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Save Current Plot Image

The Save Current Plot Image option saves the current plot image from the Channel Plot 
window to a file.

To save the image to a file, specify the name of the file and choose one of the extensions to save 
the file as a graphic. 

The default location for saving the current plot image files is as follows:

For Windows Vista, Windows 7, or Windows 8:
C:\Users\<username>\AppData\Local\Data Translation\QuickDAQ\Data

For Windows XP:
C:\Documents and Settings\<user name>\Local Settings\Application Data\
Data Translation\QuickDAQ\Data

Open Current Data in Excel

The function of the Open Current Data in Excel menu option depends on the interface mode, 
described below.

Note: Before using this option, ensure that Microsoft Excel is installed on your computer. In 
addition, you must stop acquisition before trying to use this option, or the application cannot 
open the file.

Open Current Data in Excel Using the Data Logger Interface 

If you choose the Open Current Data in Excel menu option from the File menu or click the 
Open Current Data in Excel toolbar button , the application opens a tab-separated 
(tmp.tvs) file in Microsoft Excel that contains all the time domain data for the visible channels 
in the Channel Plot window.

You can then perform further analysis of your data using Excel or other utilities. 

Open Current Data in Excel Using the FFT Analyzer Interface 

If you are using the FFT Analyzer Interface and choose the Open Current Data in Excel menu 
option from the File menu or click the Open Current Data in Excel toolbar button , you 
can specify either Time History Data or Frequency Domain Data. 

If you select Time History Data, the application opens a tab-separated (tmp.tvs) file in 
Microsoft Excel that contains all the time domain data for the visible channels in the Channel 
Plot window.

If you select Frequency Domain Data, the application opens a tab-separated (tmp.tvs) file in 
Microsoft Excel that contains the average frequency domain data for the visible channels in 
the Channel Plot window.
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You can then perform further analysis of your data using Excel or other utilities. 

Load Configuration

The Load Configuration option opens an .xml file of stored configuration settings.

Save Configuration

The Save Configuration option saves the current application configuration to a user-specified 
filename with the .xml extension.

The default location for saving the configuration file is as follows:

For Windows Vista, Windows 7, or Windows 8:
C:\Users\<username>\AppData\Local\Data Translation\QuickDAQ\Config.

For Windows XP:
C:\Documents and Settings\<user name>\Local Settings\Application Data\
Data Translation\QuickDAQ\Config

Open Hpf Data Folder

The Open Hpf Data Folder option opens Windows Explorer in the current folder that is used 
to store .hpf data files. This provides a quick way to browse your data files.

The default location for saving the data files is as follows:

For Windows Vista, Windows 7, or Windows 8:
C:\Users\<username>\AppData\Local\Data Translation\QuickDAQ\Data

For Windows XP:
C:\Documents and Settings\<user name>\Local Settings\Application Data\
Data Translation\QuickDAQ\Data

Open Export Data Folder

The Open Export Data Folder option opens Windows Explorer in the current folder that is 
used to store exported data files. This provides a quick way to browse your exported files.

The default location for saving exported files is as follows:

For Windows Vista, Windows 7, or Windows 8:
C:\Users\<username>\AppData\Local\Data Translation\QuickDAQ\Data

For Windows XP:
C:\Documents and Settings\<user name>\Local Settings\Application Data\
Data Translation\QuickDAQ\Data
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Page Setup

The Page Setup option allows you to configure the page before you print it. Options are 
available for configuring the size, orientation, and margins of the page.

Print Preview

The Print Preview option allows you to preview the image from the Channel Plot window 
before you print it.

Print

The Print option prints the picture from the Channel Plot window to a printer.

Exit

The Exit option closes QuickDAQ, and saves the current device configuration in the 
QuickDAQConfiguration.xml file in the default configuration folder. You can also close the 
application by clicking the  button in the top, right-hand side of the application.

Notes: A backup configuration file (QuickDAQConfiguration.xml.bak) is saved in the 
default configuration folder when QuickDAQ is exited. If, when starting QuickDAQ, an error 
occurs and the configuration file cannot be restored, the backup file is used to restore the 
configuration.

If the device is acquiring data through another application, a warning dialog box appears 
notifying you that you cannot save the current configuration if you close the application.

Exit without saving current configuration

The Exit without saving current configuration option closes QuickDAQ, but does not save 
the current device configuration.

Edit Menu

The Edit menu has the following menu options:

• Copy plot data to clipboard – Copies the data from the Channel Plot window to the 
Windows clipboard.

• Copy plot image to clipboard – Copies the image from the Channel Plot window to the 
Windows clipboard.
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Record Menu

The Record menu has the following menu options:

• Start – Starts data acquisition on the device and logs the data to a High Performance 
binary file (.hpf). This is equivalent to clicking the Record button (  ) on the 
toolbar or pressing the F5 key. You can specify the name of the data file by opening a new 
Hpf file, described on page 36, or by using the Recording tab, described on page 119.

Note: You can use the scrollbar on the x-axis to pause tracking and scroll back through 
the data to the beginning of acquisition. Refer to page 70 and page 71 for more 
information on pausing and resuming tracking. 

For long duration acquisitions, ensure that your computer’s power options are set to 
never hibernate; refer to page 384 for more information.

• Pause – Pauses recording. This is equivalent to clicking the Pause button (  ) on 
the toolbar or pressing the spacebar. To resume recording, click the Pause menu option, 
click the Pause button, or press the spacebar again.

• Stop – Stops the application from receiving data from the device. This is equivalent to 
clicking the Stop button (  ) on the main menu or holding down the Shift key 
and pressing the F5 key. You must stop acquisition to make configuration changes.

Plot Menu

The Plot menu has the following menu options:

• Plot Area Mouse Mode – You can select one of the following controls for the Channel Plot 
window:

− Select – Allows you to select items in the view area to zoom or to scroll. This is 
equivalent to using the Select control (  ) of the Channel Plot window, or holding 
down the Ctrl and Alt keys while pressing the V key.

− Zoom – Allows you to select a region in the view to magnify (zoom). This is equivalent 
to using the Zoom Box (  ) control of the Channel Plot window, or holding down 
the Ctrl and Alt keys while pressing the Z key.

Once in zoom mode, you can hold down the left mouse button, dragging the mouse to 
select the region that you want to magnify, and release the mouse button to magnify 
the area. The zoom action affects both axes.

− Cursor – Allows you to move the position of a data-cursor on the curve. This is 
equivalent to using the Data-Cursor (  ) control of the Channel Plot window, or 
holding down the Ctrl and Alt keys while pressing the C key.

Once in Data-Cursor mode, hold down the left mouse button and drag the mouse to 
move the data cursor. When the Data-Cursor is active, right-click the mouse to change 
the cursor style, line style, and/or color of the cursor; refer to page 74 for more 
information.
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• Axis Mouse Mode – You can select one of the following controls for the axis:

− Scroll – Allows you to scroll through the axes. This is equivalent to using the Axes 
Scroll (  ) control of the Channel Plot window.

Once in this mode, hold down the left mouse button and drag the mouse over the axis 
(up and down for the y-axis, or right and left for the x-axis) to scroll through the axes.

If you want to change the magnification (zoom) of the axes while this mode is selected, 
hold down the Ctrl button while holding down the left mouse button, and drag the 
mouse over the axis (up and down for the y-axis, or right and left for the x-axis).

− Zoom – Allows you to change the magnification (the zoom) of the axes. This is 
equivalent to using the Axes Zoom (  ) control of the Channel Plot window.

Once in this mode, you can change the magnification (the zoom) of the axes by holding 
down the left mouse button and dragging the mouse over the axis (up and down for 
the y-axis, or right and left for the x-axis). 

Configuration Menu

The Configuration menu has the following menu options:

• Input Channel Configuration – When you click this menu option or click the Input 
Channel Configuration toolbar button (  ), the Configure Devices dialog box 
appears. Using this dialog box, you can specify which input channels are sampled, and 
configure the sensor type, engineering units, number of millivolts per engineering unit, 
and the test point number for each channel. 

Refer to page 84 for more information about configuring channels.

• Digital Filter Configuration – This menu option is enabled only in the QuickDAQ FFT 
Analysis and Advanced FFT Analysis packages. 

When you click this menu option or click the Digital Filter Configuration toolbar button 
(  ), the Digital Filter Configuration dialog box appears. Using this dialog box, you 
can specify the type of IIR (infinite impulse response) filter that you want to apply for 
each channel and the parameters for the each filter, including the filter category (low pass, 
high pass, band pass, band stop), filter order, cutoff frequencies, and dB ripple.

Refer to page 162 for more information about configuring digital filters.

• Device Selection – Opens the Device Selection window, allowing you to select the devices 
for use with QuickDAQ in acquisition mode. Refer to page 27 for more information about 
using the Device Selection window.

Windows Menu

The Windows menu provides the following menu options:

• Acquisition Config window – Check this window option to show the Acquisition Config 
window. If this window option is unchecked, the Acquisition Config window is hidden. 
The Acquisition Config window allows you to configure the acquisition parameters of the 
data acquisition devices. Refer to Chapter 4 starting on page 83 for more information on 
this window.
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• Plot and Data Config window – Check this window option to show the Plot and Data 
Config window. If this window option is unchecked, the Plot and Data Config window is 
hidden. The Plot and Data Config window allows you to configure the appearance of the 
display. Refer to Chapter 5 starting on page 167 for more information on this window.

• Channel Plot window – Check this window option to show the Channel Plot window. If 
this window option is unchecked, the Channel Plot window is hidden. This window 
allows you view the data from your device in a plot view. Refer to page 66 and page 169 
for more information on this window.

• Channel Display window – Check this window option to show the Channel Display 
window. If this window option is unchecked, the Channel Display window is hidden. 
This window allows you view the data from your device in a digital display that 
resembles the front panel of the device. Refer to page 78 and page 169 for more 
information on this window.

• Channel Statistics window – Check this window option to show the Channel Statistics 
window. If this window option is unchecked, the Channel Statistics window is hidden. 
This window allows you view statistics about the data that you acquired. Refer to page 79 
for more information on this window.

• Reset Window Layout to Last Saved – Allows you to change the window layout to the 
last saved configuration.

• Reset Window Layout to Default Layout – Allows you to change the window layout to 
the default state. 

Mode Menu

The Mode menu is disabled (grayed out) if you are using the Base package of QuickDAQ.

If you using the FFT Analysis option or Advanced FFT Analysis option of QuickDAQ, the 
Mode menu provides the following options:

• Data Logger – This option selects the Data Logger interface. This is the interfaced 
provided in the Base package of QuickDAQ. Use this interface if you want to acquire data, 
display time-domain data, and log time-domain data to disk, and do not want to perform 
FFT analysis on the data using this application.

• FFT Analyzer – This option selects the FFT Analyzer interface. Use this interface if you 
want to acquire data, perform FFT analysis on the data, display the time-domain and/or 
frequency-domain data, and log the data to disk.

Note: If you are using the FFT Analysis option or Advanced FFT Analysis option of 
QuickDAQ, you can toggle between the two interfaces. The application remembers the 
configuration between toggles. However, when the application is closed, only the active 
interface mode is saved. 

If you want the configuration of both interface modes to be saved, you must manually save 
the configuration for the interface that is not active before the application is closed.
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Help Menu

The Help menu provides the following options:

• User Manual – Opens this manual, which describes the functionality of QuickDAQ.

• License Info – Opens the License Info dialog, described in page 21, which allows you to 
purchase and enter a license key for the FFT Analysis or Advanced FFT Analysis option of 
QuickDAQ.

• About – Provides version information about the QuickDAQ application.

You can also open this manual using the Help toolbar button (  ).
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Toolbar Buttons
The following buttons are provided on the toolbar:

•  – New HPF Data File – Creates a new (empty) data file for use with QuickDAQ. This 
is equivalent to using the New Hpf Data file menu option under the File menu, described 
on page 36. 

You can name and save the data file, as desired. The format of this file is High 
Performance binary (.hpf). 

By default, the data file is stored in the following location:

For Windows Vista, Windows 7, or Windows 8:
C:\Users\<username>\AppData\Local\Data Translation\QuickDAQ\Data

For Windows XP:
C:\Documents and Settings\<user name>\Local Settings\Application Data\
Data Translation\QuickDAQ\Data

•  – Open HPF Data File – Opens an .hpf data file that was created using QuickDAQ. 
This is equivalent to using the Open Hpf Data file menu option under the File menu, 
described on page 36. 

A sample data file, called QuickDAQ Data.hpf, is provided, by default, in the following 
location:

For Windows Vista, Windows 7, or Windows 8:
C:\Users\<username>\AppData\Local\Data Translation\QuickDAQ\Data

For Windows XP:
C:\Documents and Settings\<user name>\Local Settings\Application Data\
Data Translation\QuickDAQ\Data

•  – Export Data – Opens the Export Data dialog box. This is equivalent to selecting the 
Export Data menu option of the File menu, described on page 37.

•  – Open Current Data in Excel – After you stop recording, you can click this button 
to open a tab-separated (tmp.tvs) file in Microsoft Excel that contains all the time domain 
data for the visible channels in the Channel Plot window. 

You can then perform further analysis of your data using Excel or other utilities. 

This is equivalent to selecting the Open Current Data in Excel menu option of the File 
menu, described on page 42.

Note: Before using this option, ensure that Microsoft Excel is installed on your computer. 

•   – Record – Starts data acquisition on the device and logs the data to a High 
Performance binary (.hpf) file. This is equivalent to selecting the Start menu option of the 
Record menu or pressing the F5 key. You can specify the name of the data file using the 
Recording tab, described on page 119.
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Note: You can use the scrollbar on the x-axis to pause tracking and scroll back through 
the data to the beginning of acquisition. Refer to page 70 and page 71 for more 
information on pausing and resuming tracking.

For long duration acquisitions, ensure that your computer’s power options are set to 
never hibernate; refer to page 384 for more information.

•  – Pause – Pauses recording. This is equivalent to selecting the Pause menu 
option of the Record menu or pressing the spacebar. To resume recording, click the Pause 
button, click the Pause menu option, or press the spacebar again.

•  – Stop – Stops acquisition. This is equivalent to the Stop menu option under the 
Record menu or holding down the Shift key and pressing the F5 key. You must stop 
acquisition to make configuration changes.

•  – Digital Filter Configuration – Opens the Digital Filter Configuration dialog. This 
is equivalent to using the Digital Filter Configuration menu option of the Configuration 
menu, described on page 46.

Note: This toolbar button is enabled only in the QuickDAQ FFT Analysis and Advanced 
FFT Analysis packages.

•  – Input Channel Configuration – Opens the Configure Devices dialog. This is 
equivalent to using the Input Channel Configuration menu option of the Configuration 
menu, described on page 46.

•  – Style – Allows you to configure the theme colors used by the application. You 
can select one of the following theme colors:

− Office 2010 Blue

− Office 2010 Silver

− Office 2010 Black

− Visual Studio 2010

− Windows 7

− Office 2007 Blue

− Office 2007 Black

− Office 2007 Silver

− Vista Glass

− Custom Scheme – Allows you to select your own color scheme to use for the 
application.

•  – Help – Opens the this manual to describe QuickDAQ. This is equivalent to clicking 
the User’s Manual menu option of the Help menu, described on page 48.
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Window Positioning
The configuration area of the interface contains the Acquisition Config and the Plot and Data 
Config windows. The display area of the interface contains the Channel Plot, Channel Display, 
and Channel Statistics windows. The Acquisition Status window is located under the Channel 
Plot, Channel Display, and Statistics windows.

This section describes how to move, resize, dock, and hide windows in the interface. The 
remaining sections of this document describe each window in more detail.

Moving, Resizing, and Docking Windows

Note: The Acquisition Status window is docked automatically. You cannot undock the 
Acquisition Status window.

You can move a window anywhere on the desktop by clicking the title bar or tab of the 
window and, while holding down the mouse button, dragging the window to the location 
you want. When you release the mouse button, this "floating" window remains in the location 
that you selected.

You can resize a window by clicking on any of the outside edges of the window and, while 
holding down the mouse button, dragging the window to the desired size. When you release 
the mouse, the window is scaled automatically.

You can also dock a window by doing the following:

1. Click the title bar or tab of the window.

2. Drag the window to where you want to dock it.
A guide diamond appears. 

For windows in the configuration area, the four guides on the outside of the diamond represent the 
four sides of the configuration area. The center square docks the tabbed window in the 
configuration area. Additional guides are provided when you move the windows in the 
configuration area, allowing you to dock the window to the left side of the configuration area or to 
the right or left side of the display area.

For windows in the display area, the four guides on the outside of the diamond represent the four 
sides of the display area. The center square docks the tabbed window in the display area.
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3. Move the pointer over the corresponding portion of the guide (the designated area is 
shaded), and release the mouse.

For example, if you want to dock the Acquisition Config window to the left side of the 
configuration area, drag the Acquisition Config window toward the middle of the 
configuration area, move the pointer over the guide on the far left, and then release the mouse 
button.

Notes: To return a window in the display area to its most recent docked location, press CTRL 
while you double-click the title bar of the window.

To dock/undock a window in the configuration area, press CTRL while you double-click the 
title bar of the window.

Hiding a Window

For all windows, except the Acquisition Status window, you can hide the window by clicking 
the "X" at the top, right corner of the window. To show the window again, click the Windows 
menu, and the check the name of the window to show. Any window name that is not checked 
under the Windows menu is hidden. 

You can hide the Acquisition Status window and the windows in the configuration area, if 
desired, by clicking the Auto-Hide pin (  ) in the top, right corner of the window. When 
the window is hidden, a tab for the window is created; the size of the display area is increased. 
When the window is shown, the size of the display area is decreased. To see the window 
again, hover over the tab for the window. Click the Auto-Hide pin again to display the 
window.

Move the pointer over this guide to 
dock the window to the top of the 

selected area.

Move the pointer over this guide to 
dock the window to the right of the 

selected area.

Move the pointer over this guide to 
dock the window to the bottom of the 

selected area.

Move the pointer over this guide to 
dock the window to the left of the 

selected area.

For windows in the configuration area, move the 
pointer over this guide to dock the tabbed window 

in the configuration area.

For windows in the display area, move the pointer 
over this guide to dock the tabbed window in the 

default location in the display area.
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Resetting the Window Layout

If you want to reset the windows to their default view, select the Windows menu, and select 
Reset Window Layout to Default Layout. 

You can also reset the display area to its last saved configuration by selecting the Windows 
menu, and selecting Reset Window Layout to Last Saved.
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Acquisition Config Window
The contents of the Acquisition Config window depend on the interface mode that is selected, 
as described below.

Acquisition Config Window for the Data Logger Interface

When using the Data Logger interface, the Acquisition Config window provides the following 
tabs for configuring the acquisition and output settings used by the device. Based on the 
information you set, the current sample rate, sample interval, and number of scans used by 
the device are displayed. 

• Recording tab – This tab allows you to set up the file name for the data file, enable or 
disable continuous acquisition, and to specify the acquisition duration and x-axis span. 

Refer to page 119 for more information about using this tab to configure the recording 
settings.
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• Acquisition tab – This tab allows you to set up the parameters that apply to the analog 
input subsystem, including the per channel sampling frequency of the device, the trigger 
source that starts the acquisition, the channel configuration (single-ended or differential), 
input voltage range, the temperature units to use when converting voltage data to 
temperature, and/or the filter type. Refer to page 121 for more information about using 
this tab to configure the acquisition settings.
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• Output tab – This tab appears if your device supports continuous analog output 
operations. It allows you to set up the parameters for an analog output signal. You can 
define the type of waveform to output (fixed, sweep, or noise), and all the parameters that 
apply to that waveform type, including the signal or noise type, sweep mode, whether the 
signal is output continuously or as a burst, the frequency of the output signal, whether to 
ramp up or down, and how to start the operation. Refer to page 138 for more information 
about using this tab to configure the output settings. 
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Acquisition Config Window for the FFT Analyzer Interface

If you are using the FFT Analyzer interface, the Acquisition Config window provides the 
following tabs for configuring the acquisition and output settings used by the device:

• Recording tab – This tab allows you to set up the data file name, enable or disable 
continuous acquisition, specify how many records to acquire, process, and average, and 
enter notes about the acquisition. 

A record is a block of data whose length is equal to the size of the FFT. An average is a series 
of measurements that are combined to create a result. The results from the last completed 
measurement are combined, point by point, with the results from the previous 
measurement. The combined results are retained and displayed as they are updated.

Refer to page 122 for more information about using this tab to configure the recording 
settings.
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• Freq tab – This tab allows you to set up the maximum frequency that you are interested in 
analyzing, the FFT size, and other parameters that apply to the analog input subsystem, 
including the channel configuration (single-ended or differential), input voltage range, the 
temperature units to use when converting voltage data to temperature, and/or the filter 
type. Refer to page 128 for more information about using this tab to configure the 
frequency settings.
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• Trigger tab – This tab allows you to specify the trigger source that starts acquisition on the 
device, and the trigger mode. Refer to page 131 for more information about using this tab 
to configure the triggers settings.
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• Window tab – This tab allows you to specify a windowing function to apply to the FFT 
channel to reduce spectral leakage errors. If you are using the FFT Analysis option, the 
Window tab appears as shown in Figure 5. If you are using the Advanced FFT Analysis 
option, the Window tab appears as shown in Figure 6.

Refer to page 135 for more information about using this tab to configure a windowing 
function.

Figure 5: Window Tab for the FFT Analysis Option

Figure 6: Window Tab for the Advanced FFT Analysis Option

• Output tab – This tab allows you to set up the parameters for an analog output signal, if 
your device supports analog output operations. You can define the type of waveform to 
output (fixed, sweep, or noise), and all the parameters that apply to that waveform type, 
including the signal or noise type, sweep mode, whether the signal is output continuously 
or as a burst, the frequency of the output signal, whether to ramp up or down, and how to 
start the operation.
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Refer to page 138 for more information about using this tab to configure the output 
settings.
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Plot and Data Config Window
The contents of the Plot and Data Config window depend on the interface mode that is 
selected, as described below.

Plot and Data Config Window for the Data Logger Interface

When you are using the Data Logger interface, the Plot and Data Config window allows you 
to select which channels you want to plot and specify the appearance of the display area.

Refer to Chapter 5 for information about how to configure the settings of the Plot and Data 
Config window.
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Plot and Data Config Window for the FFT Analyzer Interface

When you are using the FFT Analyzer interface, the Plot and Data Config window allows you 
to select which channels you want to plot, add and remove single FFT functions, add and 
remove two-channel FFT functions (if you purchased the Advanced FFT Analysis option of 
QuickDAQ), specify the type of data analysis operations to perform on the selected channels, 
and specify the appearance of the display area. Figure 7 shows the Plot and Data Config 
window for the FFT Analysis option. 

Figure 7: Plot and Data Config Window for the FFT Analysis Option
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Figure 7 shows the Plot and Data Config window for the Advanced FFT Analysis option.

Figure 8: Plot and Data Config Window for the Advanced FFT Analysis Option

Refer to Chapter 6 for information about how to configure the settings of the Plot and Data 
Config window.
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Channel Plot Window
You can access the Channel Plot window by clicking the Channel Plot tab in the display area 
of the interface or by clicking the Channel Plot menu option under the Windows menu.

During acquisition, the results are plotted in the Channel Plot window in real time. In 
file-reader mode, the results are read from the file and plotted in the Channel Plot window.

The following sections describe how to set up the scaling for the y- and x-axes on the Channel 
Plot window, how to use the scrolling options for the Channel Plot window, and how to use 
the controls provided for the Channel Plot window. Refer to Chapter 5 starting on page 167 for 
more information about the Channel Plot window.
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Setting Up the Y-Axis

If you right-click on the y-axis, the following dialog box is displayed:

These options are described below.

Y Axis Setup

If you select Y Axis Setup, the following dialog appears:

You can set up the following parameters for the y-axis:

• Gridlines – Select Show Minor if you want to display the minor gridlines on the y-axis; 
select Show Major if you want to display the major gridlines on the y-axis.

• Scaling – Select Autoscale if you want the application to determine the scale of the y-axis 
automatically. If you want to specify the scale of the y-axis, select Manual and then enter 
the minimum and maximum values for the y-axis.

• Precision – You can select the number of significant digits after the decimal point to 
display on the y-axis and in the cursor text; values range from 0 to 8 (2 is the default).
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• Format – You can change for the format of the axis to see either the actual Number (such 
as 200) or the number in Exponent form (such as 2.0e+002).

• Lin/Log – For time-domain channels, you can change the y-axis of the plotted data to 
either Linear or Log10.

If you are using the FFT Analyzer interface and Linear scaling is selected for the FFT 
channel (using the Data - Scaling tab of the Plot and Data Config window), you can 
change the y-axis of the plotted data to either Linear or Log10. If you are using the FFT 
Analyzer interface and dB scaling is selected for the FFT channel (using the Data - Scaling 
tab of the Plot and Data Config window), this setting is not applicable.

Zoom to Fit in View

Select this menu option to scale the y-axis for the selected channel to the minimum and 
maximum values of the actual input signal(s) that are in the current view.

Zoom to Fit All

Select this menu option to scale the y-axis for the selected channel to the minimum and 
maximum values of the actual input signal(s) that were acquired, regardless of whether the 
data is in the current view.

Setting Up the X-Axis

If you right-click on the x-axis, the following dialog box is displayed:
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X Axis Setup

If you select X Axis Setup, the following dialog appears:

You can set up the following parameters for the x-axis:

• Gridlines – Select Show Minor if you want to display the minor gridlines on the y-axis; 
select Show Major if you want to display the major gridlines on the y-axis.

• Scaling – Specify the scale of the x-axis by entering the minimum and maximum values 
for the x-axis.

• Precision – You can select the number of significant digits after the decimal point to 
display on the x-axis and in the cursor text; values range from 0 to 8 (3 is the default).

• Format – If you are using the FFT Analyzer interface, you can change for the format of the 
x-axis to see either the actual Number (such as 200) or the number in Exponent form (such 
as 2.0e+002).

• Lin/Log – If you are using the FFT Analyzer interface, you can change the axis of the 
plotted data to either Linear or Log10. 

Zoom to Fit All

Select this menu option to scale the x-axis for the selected channel to the minimum and 
maximum values of the actual input signal(s) that were acquired.

Edit Label

Select this menu option to change the text that is displayed for the x-axis.
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Pause Tracking

If the application is recording, you can click this popup menu option to pause tracking for a 
specific plot. The plot stops updating, but data is still recorded to disk. The tracking for other 
plots is unaffected by this action.

A specific plot can also be paused by using the scrollbar for the x-axis to scroll through the 
data. After tracking is paused, the scrollbar continues to be updated so that you can scroll to 
the data as it is being acquired.

If you want to pause tracking for all channels, use the Tracking Pause  button on the 
toolbar instead. Refer to page 71 for more information.

While tracking is paused, you can use the controls for the Channel Plot window, described on 
page 71, to analyze the data that was previously recorded.

Resume Tracking

If recording is still in progress, you can resume tracking for a specific plot by clicking the 
Resume Tracking popup menu option. The tracking for other plots is unaffected.

To resume tracking for all plots whose tracking was paused, click the Tracking Resume  
button on the toolbar. Refer to page 71 for more information.

Scrolling Options

If you right-click on the scrollbar of the x-axis, the following dialog box is displayed:

The options are as follows:

• Scroll Here – Moves the scroll bar to the point of the mouse click that opened the scroll 
bar dialog.

• Left Edge – Moves the scroll bar to the left edge of the acquired data.

• Right Edge – Moves the scroll bar to the right edge of the acquired data.

• Page Left – Updates the content of the scroll area with the page of data to the left of the 
data is currently being displayed.
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• Page Right – Updates the content of the scroll area with the page of data to the right of the 
data is currently being displayed.

• Scroll Left – Scrolls to the left.

• Scroll Right – Scrolls to the right.

Using the Channel Plot Window Controls

A toolbar, shown in Figure 9, provides a number of controls for the Channel Plot window.

Figure 9: Toolbar of the Channel Plot Window

Tracking Resume 

If the application is recording and tracking was paused, you can click this button to resume 
tracking for all plots on the display. The display is then updated with the current data in real 
time.

To resume tracking on a specific plot rather than on all plots, right-click the x-axis and select 
the Resume Tracking popup menu option; refer to page 70 for more information.

Tracking Pause 

If the application is recording, you can click this button to pause tracking on all plots of the 
display. The display stops updating, but data is still recorded to disk. While tracking is paused 
you can use the other controls to analyze the data that was previously recorded.

To pause tracking on a specific plot rather than on all plots, right-click the x-axis and select the 
Pause Tracking popup menu option or use x-axis scrollbar to scroll through the data; refer to 
page 70.

Axes Scroll 

When you click this button, you can scroll through the axes by holding down the left mouse 
button and dragging the mouse over the axis (up and down for the y-axis, or right and left for 
the x-axis).

If you want to change the magnification (zoom) of the axes while this button is selected, hold 
down the Ctrl button while holding down the left mouse button, and drag the mouse over the 
axis (up and down for the y-axis, or right and left for the x-axis).

When this button is selected, the Axes Zoom button is unselected.
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Axes Zoom 

When you click this button, you can change the magnification (the zoom) of the axes by 
holding down the left mouse button and dragging the mouse over the axis (up and down for 
the y-axis, or right and left for the x-axis). 

When this button is selected, the Axes Scroll button is unselected.

Zoom-Out All 

When you click this button, the magnification of all axes is reduced (zoomed out) by a factor 
of 2.

Zoom-In All  

When you click this button, all axes are magnified (zoomed in) by a factor of 2.

Zoom All to Fit in View Y 

When you click this button, the scale of all y-axes are adjusted to the minimum and maximum 
values of the actual input signal(s).

Link X Axes to Selected 

Click the x-axis for the plot that you want to link to (the master plot), then click the Link X 
Axes to selected button to link the x-axes of all the other plots (the slave plots) with the same 
data domain (time domain or frequency domain). You can then use the scrolling controls on 
the master plot to affect the view of all the slave plots with the same data domain at the same 
time.

For example, assume that you have three plots (a time-domain plot in volts, a 
frequency-domain plot, and a time-domain plot in degrees C). If you choose the x-axis of the 
plot in volts and click the Link X Axes to selected button, the time-domain plot in volts is the 
master plot and the time-domain plot in degrees C is the slave plot. When you zoom into the 
data or scroll through the x-axis of the master plot, the application also zooms into the data or 
scrolls through the x-axis for the slave plot. The frequency-domain plot is unaffected.

If you zoom into or scroll through the x-axis of the slave plot, none of the other plots is 
affected. To resynchronize the slave plot with the master plot, either zoom into or scroll 
through the x-axis of the master plot, or unlink the x-axes in the master plot and relink them in 
the master plot using the Link X Axes to selected button.
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Link Y Axes to Selected 

Click the y-axis for the plot that you want to link to (the master plot) then click the Link Y 
Axes to selected button to link the y-axes of all the other plots (the slave plots) that have the 
same data domain (either time domain or frequency domain). You can then use the scrolling 
controls on the master plot to affect the view of all the slave plots with the same data domain 
at the same time.

For example, assume that you have three plots (a time-domain plot in volts, a 
frequency-domain plot, and a time-domain plot in degrees C). If you choose the y-axis of the 
plot in volts and click the Link Y Axes to selected button, the time-domain plot in volts is the 
master plot and the time-domain plot in degrees C is the slave plot. When you scroll through 
the y-axis of the master plot, the application also scrolls through the y-axis for the slave plot. 
The frequency-domain plot is unaffected.

If you scroll through the y-axis in the slave plot, none of the other plots is affected. To 
resynchronize the slave plot with the master, either scroll through the y-axis in the master plot, 
or unlink the y-axes in the master plot and relink them using the Link X Axes to selected 
button.

Link Cursors to Selected   

Locks data cursors together so that by moving the locked data cursor, all the data cursors 
move together. To use this button, click the Data-Cursor button, click the data cursor that you 
want to lock to, and then click the Link Cursors to Selected button. Once it is locked, moving 
the locked data cursor moves all the data cursors. 

Select 

When you click this button, you can select items in the view area to zoom or scroll. This is 
equivalent to holding down the Ctrl and Alt keys while pressing the V key, or selecting the 
Plot menu, selecting Plot Area Mouse Mode, and choosing the Select menu option.

Zoom Box 

When you click this button, you can select a region in the view to magnify (zoom) by holding 
down the left mouse button, dragging the mouse to select the region that you want to magnify, 
and releasing the mouse button. The zoom action affects both axes.

This is equivalent to holding down the Ctrl and Alt keys while pressing the Z key, or selecting 
the Plot menu, selecting Plot Area Mouse Mode, and choosing the Zoom menu option.
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Data-Cursor 

When you click this button, you can move the position of a data-cursor on the curve by 
holding down the left mouse button and dragging the mouse. 

This is equivalent to holding down the Ctrl and Alt keys while pressing the C key, or selecting 
the Plot menu, selecting Plot Area Mouse Mode, and choosing the Cursor menu option.

When the Data-Cursor is active, right-click the mouse to change the cursor style, line style, 
and/or color of the cursor; the following menu appears:

You can change the cursor style to one of the following settings:

• Value-XY – Choose this style to display a single value at a particular point on the X- and 
Y-axes.

• Period – Choose this style to display the period, in seconds, between two vertical cursors. 
You can drag each cursor independently.

• Frequency – Choose this style to display the frequency, in Hertz, between two vertical 
cursors. You can drag each cursor independently.

• Peak-Peak – Choose this style to display the value between two horizontal cursors. This is 
the number of volts or sensor units. You can drag each cursor independently.

• Band Power – Available with the FFT Analysis and Advanced FFT Analysis options. 
When the spectrum function (selected on the Data - Function tab of the Plot and Data 
Config window) is AutoSpectrum or PSD, and the scaling type is Linear (selected on the 
Data - Scaling tab of the Plot and Data Config window), select this style to display the 
square root of the sum of the values between the cursor lines.

When the spectrum function (selected on the Data - Function tab of the Plot and Data 
Config window) is Spectrum, and the scaling type is Linear (selected on the Data - 
Scaling tab of the Plot and Data Config window), select this style to display the square 
root of the sum of the squared values between the cursor lines.
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The following example shows a period data cursor, where two data cursors show the period, 
in seconds, between two data points:

You can change the line style to one of the following settings:

• Solid – Choose this style to display the cursors as solid lines.

• Dash – Choose this style to display the cursors as a dashed lines.

• Dot – Choose this style to display the cursors as a dotted lines.

• DashDot – Choose this style to display the cursors as lines of dash-dot elements.

You can change the color of the cursors to one of the provided basic colors or to any custom 
color you desire.

Copy to Clipboard 

When you click this button, you can copy either the graph (the picture) or the data that is 
displayed in the Channel Plot window to the clipboard.

Save Plot Image 

When you click this button, you can save the image from the Channel Plot window to a file. 
Specify the name of the file and choose one of the extensions to save the file as a graphic. 

The default location for saving the image files is as follows:

For Windows Vista, Windows 7, or Windows 8:
C:\Users\<username>\AppData\Local\Data Translation\QuickDAQ\Data

For Windows XP:
C:\Documents and Settings\<user name>\Local Settings\Application Data\Data 
Translation\QuickDAQ\Data
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Print 

When you click this button, you can print the picture from the Channel Plot window to a 
printer.

Preview 

When you click this button, you can preview the image from the Channel Plot window before 
you print it.

Page Setup 

When you click this button, you can configure the page before you print it. Options are 
available for configuring the size, orientation, and margins of the page.

Show Legend 

When you click this button, you can show or hide the legend that defines the colors used for 
each channel on the plot. An example follows:   

Show Data Point Markers 

When you click this button, you can show or hide markers that indicate the actual samples on 
the curve, as shown in the following example. The diamond markers indicate the actual 
samples. 

If you click on a data point marker, a label for the channel is displayed. 

Note: When moving the data-cursor with the data point markers shown, the data-cursor 
snaps to the closest sample on the curve. 
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Channel Display Window
You can access the Channel Display window by clicking the Channel Display tab in the 
display area of the interface or by clicking the Channel Display menu option under the 
Windows menu.

During acquisition, the newest value for each enabled channel is displayed in the Channel 
Display window in real time. The Channel Display window allows you to view data from 
your device in a digital display. By default, the layout represents the channel locations on the 
front panel of the device. Refer to Chapter 5 starting on page 167 for more information about 
the Channel Display window.
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Statistics Window
You can access the Statistics window by clicking the Statistics tab in the display area of the 
interface or by clicking the Channel Statistics menu option under the Windows menu.

Statistics are handled differently depending on the interface mode you selected, as described 
below.

Statistics in the Data Logger Interface

If you are using the Data Logger interface, statistics are displayed in the Statistics window in 
real time as data is acquired, provided that the Visible Statistics checkbox in the Plot and 
Data Config window is selected for the channel.

The Statistics window shows the minimum, maximum, and mean values of the data, along 
with the difference between the minimum and maximum values (called the delta) and the 
standard deviation for each enabled channel:

In file-reader mode, the results are read from the file and the statistics are shown in the 
Statistics window.

Note: To save the data that is displayed in the Statistics window, either take a screen shot of 
the Statistics window or click the Statistics tab, press Ctrl-A (to select all listed channels), and 
press Ctrl-C to past the data into another application.

Refer to page 186 for more information about statistics in the Data Logger interface.

Statistics in the FFT Analyzer Interface

If you are using the FFT Analyzer interface, the statistics that you select using the Stats tab, 
described on page 234, are displayed in the Statistics window in real time as data is acquired, 
provided that the Visible Statistics checkbox in the Plot and Data Config window is selected 
for the channel.

In file-reader mode, the results are read from the file and the statistics that you selected using 
the Stats tab are shown in the Statistics window:
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Using the Stats tab, you can choose to display the following statistics for the enabled channels:

• Minimum value, maximum value, mean value, delta of minimum and maximum values, 
and standard deviation statistics

• Dynamic statistics – Allows you to quantify the analog characteristics of the data that is 
acquired through the A/D converter on the device. You can select either RMS (Root Mean 
Squared) or Vector averaging to compute the following statistics:

− IBF – Input Below Full-Scale

− THD – Total Harmonic Distortion

− SFDR – Spurious Free Dynamic Range

− SINAD – Signal-to-Noise And Distortion

− SNR – Signal-to-Noise Ratio 

− ENOB – Effective Number of Bits 

Note: To save the data that is displayed in the Statistics window, either take a screen shot of 
the Statistics window or click the Statistics tab, press Ctrl-A (to select all listed channels), and 
press Ctrl-C to past the data into another application.

Refer to page 234 for more information about statistics in the FFT Analyzer interface.
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Acquisition Status Window
The Acquisition Status window, located under the Channel Plot, Channel Display, and 
Statistics windows, contains different information depending on the interface mode you are 
using, as described below.

Acquisition Status Window When Using the Data Logger Interface

If you are using the Data Logger interface, the Acquisition Status window shows the status of 
the device, including whether the device is acquiring data or idle and how many scans have 
been completed.

Acquisition Status Window When Using the FFT Analyzer Interface

If you are using the FFT Analyzer interface, the Acquisition Status window shows the status 
of the device, as well as the Record Number and the Link Time Series Data checkbox, 
described on page 227, and the Accept and Reject buttons, described on page 134.
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Configuring Channels of a Device

Notes: To configure the channels, you must have selected a supported device or have opened 
an .hpf file that contains configuration settings for a supported device. 

You can change the following settings in an .hpf file: Channel Name, Ref/Resp (Advanced 
FFT Analysis option only), EU, mv/EU, and EU offset; once you’ve changed these settings, 
you can reprocess the data with the changes

If acquisition is in progress, you must choose Stop from the Record menu or click the Stop 
toolbar button (  ) before you can change the configuration of a device.

Choose the Input Channel Configuration toolbar button (  ) or the Input Channel 
Configuration option from the Configuration menu to configure the channels from which to 
acquire data in the analog input data stream. The Configure Devices dialog appears. 

The elements of the Configure Devices dialog depend on the specified device. For example, 
Figure 10 shows the Configure Devices dialog for a MEASURpoint instrument:

Figure 10: Example Configuration of a MEASURpoint Instrument
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Figure 11 shows an example configuration for the DT9836. 

Figure 11: Example Configuration of a DT9836 Module
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Figure 12 shows an example configuration for the DT9837C. 

Note: The Ref/Resp heading appears only if you are using the Advanced FFT Analysis 
option of QuickDAQ.

Figure 12: Example Configuration for the DT9837C
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Figure 13 shows an example configuration for the DT9829. 

Figure 13: Example Configuration for the DT9829

Enabling Channels

Select the channels that you want to enable for acquisition by clicking the checkbox under the 
Enable column. Only data from the enabled channels is included in the analog input data 
stream.

Note: For the DT9805 and DT9806 modules, the CJC channel is enabled automatically if any 
of the analog input channels are configured for a temperature sensor type. You can disable 
this channel, if desired.

If you want to enable all the channels at once, click the Multi-channel Actions button
(  ) and then click Enable all Channels. If you want to enable several but not 
all channels at once, highlight the channels that you want to enable, click the Multi-channel 
Actions button, and then click Enable all Selected Channels.

If you want to disable all the channels at once, select the Multi-channel Actions button, and 
then click Disable all Channels. If you want to disable several but not all channels at once, 
highlight the channels that you want to disable, click the Multi-channel Actions button, and 
then click Disable all Selected Channels.
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Channel Name

For each channel, you can specify a meaningful name for each channel, if desired, by 
highlighting the channel under the Channel Name column and entering a new name.

Input Type

For devices that support multiple sensor types for each channel, you can configure the type of 
measurement to perform for the channel using the Input Type column. If you are using the 
DT9829 module, for example, you can choose from one of the following selections: 
VoltageInput, Current, Thermocouple, RTD, Strain Gage, Bridge, Thermistor, or Resistance.

If your device supports dedicated measurement types for each channel, the Input Type 
column does not appear.

Ref/Resp

If you are using the Advanced FFT Analysis option of QuickDAQ and you want to use a 
two-channel FFT function, select Reference for the channel that will create the stimulus, and 
select Response for the channels that will measure the effect of the stimulus. You must select 
at least one enabled analog input channel as the Reference channel. 

You can then compare the spectrum of the response channel to the spectrum of the reference 
channel by adding a two-channel FFT function to the list of channels. Refer to page 202 for 
more information about adding two-channel FFT functions.

Analog Input Channel Settings for Devices that Support Voltage

This section describes the settings that you can configure for the analog input channels on 
your device.

Sensor Type

This setting is only available for MEASURpoint instruments. To measure voltage from a 
thermocouple or RTD channel on a MEASURpoint instrument, select Volts as the Sensor Type.

Range

If your device supports multiple input ranges, set the input range for each analog input 
channel. 

For example, the following devices support multiple input ranges:

• DT8874, DT9847, DT8873, and DT9873 instruments: ±10 V, ±100 V, or ±400 V 

• DT8875 instruments: ±10 V, ±100 V, or ±600 V

• DT8876 instruments: ±100 mV, ±1.0 V, or ±10 V 

• DT8824 instrument modules: ±10 V, ±1.25 V, ±0.625 V, or ±0.3125 V 
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• DT8824-HV instrument modules: ±600 V, ±75 V, ±37.5 V, or ±18.75 V 

• DT9829 modules: ±10 V, ±2 V, or ±0.2 V

If you want to specify the same voltage range for all multi-range channels, click the 
Multi-channel Actions button (  ), select Set all Multi-Range Channels, and 
select the specific voltage range.

Engineering Unit (EU)

For voltage inputs, you can choose Volts or one of the following engineering units to display 
the data, based on the sensor that is attached to the channel:

If you select Custom, you can define your own engineering units.

If you want to specify the same engineering units for all voltage channels, click the 
Multi-channel Actions button (  ), select Set all Voltage Channel Units, and 
select the specific engineering units to use from the list above.

If you want to set the engineering units for some but not all analog input channels at once, 
select the Multi-channel Actions button, click Set all Selected Channel Units, and select the 
desired engineering units.

mV/EU

Enter the number of millivolts per engineering unit (mV/EU) by which to scale the raw 
voltage based on the engineering units that you selected.

EU Offset

You can enter an offset (EU Offset) value to add to the scaled signal.
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Enable Termination Resistor

Some devices support the option of enabling the bias return termination resistor for voltage 
inputs. Typically, this box should be checked (termination resistor is enabled) when your 
signal source is floating or grounded, and should be unchecked (termination resistor is 
disabled) when the signal source has a grounded reference.

Refer to your hardware documentation for more information on whether to enable or disable 
this resistor.

Point #

If desired, you can enter a number representing the test point to which this channel 
corresponds. By default, values start at 1 and increment with each channel.

Analog Input Channel Settings for Devices that Support 
Thermocouples

This section describes the analog input settings that you can configure for devices, such as the 
MEASURpoint instruments, DT9829 modules, and DT9805/DT9806 modules, that support 
thermocouples.

Sensor Type

Select the type of thermocouple that is connected to each channel under the Sensor Type 
column. Values are as follows:

• Type B 

• Type E 

• Type J 

• Type K

• Type N

• Type R 

• Type S 

• Type T 

• Volts (if you want to measure voltage instead; refer to page 88 for more information on 
configuring channels for voltage measurements)

If you want to specify the same thermocouple type for all channels, click the Multi-channel 
Actions button (  ), select Set all Thermocouple Channels, and select the 
specific thermocouple type.
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Engineering Unit (EU)

For channels that are configured for thermocouple inputs, the data is returned in Celsius, 
Fahrenheit, or Kelvin. You select the engineering units using the Acquisition Config tab, 
described on page 127.

If you selected a Sensor Type of Volts, refer to page 89 for more information. 

EU Offset

You can enter an offset (EU Offset) value to add to the scaled signal.

Point #

If desired, you can enter a number representing the test point to which this channel 
corresponds. By default, values start at 1 and increment with each channel.

Analog Input Channel Settings for Devices that Support RTDs

This section describes the analog input settings that you can configure for devices, such as the 
MEASURpoint instruments and DT9829 modules, that support RTDs.

Sensor Type

The available choices for Sensor Type depend on whether you are using RTDs on a 
MEASURpoint instrument (which uses an IVI-COM driver) or other devices, such as the 
DT9829 module, which use a DT-Open Layers device driver.

Sensor Type Selections for MEASURpoint Instruments

If you are using a MEASURpoint instrument, the following sensor types are available for RTD 
channels:

• Euro PT1000 (for 2- and 4-wire RTDs)

• Euro PT500 (for 2- and 4-wire RTDs)

• Euro PT100 (for 2- and 4-wire RTDs)

• American PT1000 (for 2- and 4-wire RTDs)

• American PT500 (for 2- and 4-wire RTDs)

• American PT100 (for 2- and 4-wire RTDs)

• Euro PT1000 3 Wire (for 3-wire RTDs)

• Euro PT500 3 Wire (for 3-wire RTDs)

• Euro PT100 3 Wire (for 3-wire RTDs)

• American PT1000 3 Wire (for 3-wire RTDs)

• American PT500 3 Wire (for 3-wire RTDs)

• American PT100 3 Wire (for 3-wire RTDs)
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• Ohms (if you want to measure resistance instead; refer to page 95 for more information on 
configuring channels for resistance measurements)

• Volts (if you want to measure voltage instead; refer to page 88 for more information on 
configuring channels for voltage measurements)

If you want to specify the same RTD type for all channels, click the Multi-channel Actions 
button (  ), select Set all RTD Channels, and select the specific RTD type.

Sensor Type Selections for the DT9829 and Other DT-Open Layers Devices

If you are using a DT9829 module or any other device that uses a DT-Open Layers device 
driver, the following sensor types are available for RTD channels:

• Custom

• Pt3750

• Pt3850

• Pt3911

• Pt3916

• Pt3920

• Pt3928

The Sensor Type identifies the Temperature Coefficient of Resistance (TCR) value that is used 
by the Callendar-Van Dusen transfer function to determine temperature for RTDs. The 
Callendar-Van Dusen transfer function is described as follows:

where,

• RT is the resistance at temperature (TCR).

• R0 is the resistance at 0° C.

• A, B, and C are the Callendar-Van Dusen coefficients for a particular RTD type. (The value 
of C is 0 for temperatures above 0° C.)

Table 1 lists the coefficients that are used by the Callendar-Van Dusen transfer function for 
each Sensor Type.

RT R0 1 AT BT
2
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If you specify the Sensor Type as Custom, you must specify the values for the R0, A, B, and C 
coefficients used in the transfer function.

RTD R0

This setting is not available for MEASURpoint instruments. For all other devices, specify the 
appropriate R0 coefficient for the selected Sensor Type. This value is used by Callendar-Van 
Dusen transfer function to determine temperature.

For example, for a Sensor Type of Pt3929, select 100 Ω as the RTD R0 value.

A Coeff

This setting is not available for MEASURpoint instruments. For all other devices, specify the 
appropriate A coefficient for the selected Sensor Type. This value is used by Callendar-Van 
Dusen transfer function to determine temperature.

For example, for a Sensor Type of Pt3929, select 39.888e-4 as the A Coeff value.

B Coeff

This setting is not available for MEASURpoint instruments. For all other devices, specify the 
appropriate B coefficient for the selected Sensor Type. This value is used by Callendar-Van 
Dusen transfer function to determine temperature.

For example, for a Sensor Type of Pt3929, select –59.15e-8 as the B Coeff value.

Table 1:  Callendar-Van Dusen Coefficients Supported By RTD Channels 

nsor 
pe

Temperature 
Coefficient of 

Resistance (TCR)
R0 

Coefficient A Coefficient B Coefficient C Coefficient Applicable Standar

750 0.003750 Ω / Ω /° C 1000 Ω 3.81 x 10–3 –6.02 x 10–7 –6.0 x 10–12 Low Cost

850 0.003850 Ω / Ω /° C 100 Ω, 
500 Ω, 
1000 Ω

3.9083 x 10–3 –5.775 x 10–7 –4.183 x 10–12 DIN/IEC 60751 
ASTM-E1137

911 0.003911 Ω / Ω / ° C 100 Ω 3.9692 x 10–3 –5.8495 x 10–7 –4.233 x 10–12 US Industrial Standa

916 0.003916 Ω / Ω /° C 100 Ω 3.9739 x 10–3 –5.870 x 10–7 –4.4 x 10–12 Japanese JISC 
1604-1989

920 0.003920 Ω / Ω /° C 98.129 Ω 3.9787 x 10–3 –5.869 x 10–7 –4.167 x 10–12 SAMA RC21-4-1966

928 0.003928 Ω / Ω /° C 100 Ω 3.9888 x 10–3 –5.915 x 10–7 –3.85 x 10–12 ITS-90
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C Coeff

This setting is not available for MEASURpoint instruments. For all other devices, specify the 
appropriate C coefficient for the selected Sensor Type. This value is used by Callendar-Van 
Dusen transfer function to determine temperature.

For example, for a Sensor Type of Pt3929, select –38.5e-13 as the C Coeff value.

Sensor Wiring

This setting is not available for MEASURpoint instruments. For all other devices, specify the 
wiring configuration that is used to connect the RTD to the analog input channel. Available 
selections are TwoWire, ThreeWire, and FourWire.

Engineering Unit (EU)

For RTD inputs, the data is returned in Celsius, Fahrenheit, or Kelvin. You select the 
engineering units using the Acquisition Config tab, described on page 127.

If you selected a Sensor Type of Ohms for a MEASURpoint instrument, refer to page 95. If you 
selected a Sensor Type of Volts for a MEASURpoint instrument, refer to page 89.

EU Offset

You can enter an offset (EU Offset) value to add to the scaled signal.

Point #

If desired, you can enter a number representing the test point to which this channel 
corresponds. By default, values start at 1 and increment with each channel.

Analog Input Channel Settings for Devices that Support 
Thermistors

This section describes the analog input settings that you can configure for devices, such as the 
DT9829 modules, that support thermistors.

A Coeff, B Coeff, and C Coeff

To determine the temperature of a thermistor, the software uses the Steinhart-Hart equation:

where,

• T is the temperature.

• R is the resistance at T, in ohms, that is supplied by the device.

1
T
--- A BlnR Cln R( )3+ +=



Configuring Channels, Acquisition Settings, and Digital Filters
• A, B, and C are the Steinhart-Hart coefficients for a particular thermistor type and value, 
and are supplied by the thermistor manufacturer. 

Using software, you specify the A coefficient under the A Coeff column, the B coefficient 
under the B Coeff column, and the C coefficient under the C Coeff column. 

Sensor Wiring

Specify the wiring configuration that is used to connect the thermistor to the analog input 
channel. Available selections are TwoWire, ThreeWire, and FourWire.

Engineering Unit (EU)

For thermistors, the data is returned in Celsius, Fahrenheit, or Kelvin. You select the 
engineering units using the Acquisition Config tab, described on page 127.

EU Offset

You can enter an offset (EU Offset) value to add to the scaled signal.

Point #

If desired, you can enter a number representing the test point to which this channel 
corresponds. By default, values start at 1 and increment with each channel.

Analog Input Channel Settings for Devices that Support Resistance

This section describes the analog input settings that you can configure for devices, such as 
MEASURpoint instruments and DT9829 modules, that support resistance.

Sensor Type

This setting is only available for MEASURpoint instruments.

To measure resistance from a channel on a MEASURpoint instrument, select Ohms as the 
Sensor Type.

Resistance Range

This setting is not available for MEASURpoint instruments. For all other devices, specify the 
range of the resistor that you are trying to measure. 

For example, the DT9829 module provides the following ranges: 0 to 4 kΩ and 4kW to 20 kΩ.
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Sensor Wiring

This setting is not available for MEASURpoint instruments. For all other devices, specify the 
wiring configuration that is used to connect the resistor to the analog input channel. Available 
selections are TwoWire, ThreeWire, and FourWire.

Engineering Unit (EU)

For resistance measurements, you can choose Ohms or one of the following engineering units 
to display the data:

EU Offset

You can enter an offset (EU Offset) value to add to the scaled signal.

Point #

If desired, you can enter a number representing the test point to which this channel 
corresponds. By default, values start at 1 and increment with each channel.
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Analog Input Channel Settings for Devices that Support Current

This section describes the analog input settings that you can configure for devices, such as 
DT9829 modules, that support current measurements.

Engineering Unit (EU)

For current measurements, you can choose mAmps or one of the following engineering units 
to display the data:

EU Offset

You can enter an offset (EU Offset) value to add to the scaled signal.

Enable Termination Resistor

Some devices support the option of enabling the bias return termination resistor for current 
inputs. Typically, this box should be checked (termination resistor is enabled) when your 
signal source is floating or grounded, and should be unchecked (termination resistor is 
disabled) when the signal source has a grounded reference.

Refer to your hardware documentation for more information on whether to enable or disable 
this resistor.

Point #

If desired, you can enter a number representing the test point to which this channel 
corresponds. By default, values start at 1 and increment with each channel.
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Analog Input Channel Settings that Support IEPE Inputs

This section describes the settings that you can configure for devices, such as the DT8837, 
DT9837 Series, and DT9847 Series devices, that support IEPE inputs on the analog input 
channels.

Range

Set the input range for each analog input channel. 

Coupling Type

Select AC (AC coupling) to remove any DC offset from your measurement, or select DC (DC 
coupling) if the signal source has no offset voltage or if the DC content of the acquired signal is 
important. Most IEPE input signals require AC coupling. 

If you want to set the coupling type for all analog input channels at once, select the 
multi-channel Actions button (  ), click Set all Channel Coupling, and select 
either AC or DC.

Note: On some devices, such as the DT9839 and DT9839E, AC or DC coupling is determined 
by the way the input is wired to the device; therefore, this software setting is not available for 
these devices.

Current Source

Enable use of the 4 mA current source by checking the Current Source checkbox, or disable 
use of the 4 mA current source by unchecking the Current Source checkbox. Most IEPE input 
signals require use of the current source.

If you want to set the current source for all analog input channels at once, select the 
multi-channel Actions button (  ), click Set all Channel Current Source, and 
select either Enabled or Disabled.

Note: On some devices, such as the DT9839 and DT9839E, use of the current source is 
determined by the way the input is wired to the device; therefore, this software setting is not 
available for these devices.

Engineering Unit (EU)

You can choose from one of the following engineering units to represent the data, based on the 
sensor that is attached to the channel:
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If you select Custom, you can define your own engineering units.

If you want to set the engineering units for all analog input channels at once, select the 
Multi-channel Actions button (  ), click Set all Channel Units, and select the 
desired engineering units.

If you want to set the engineering units for some but not all analog input channels at once, 
select the Multi-channel Actions button (  ), click Set all Selected Channel 
Units, and select the desired engineering units.

mV/EU

Depending on the engineering units that you selected, you can enter the number of millivolts 
per engineering unit (mV/EU) by which to scale the raw voltage.

EU Offset

Depending on the engineering units that you selected, you can enter an offset (EU Offset) 
value to add to the scaled signal.

Point #

If desired, you can enter a number representing the test point to which this channel 
corresponds. By default, values start at 1 and increment with each channel.

Dir

Specify one of the following sensor directions for the analog input channel, if desired: X+, X-, 
Y+, Y-, Z+, Z-, or Scalar (no direction).
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Analog Input Channel Settings for Devices that Support Strain 
Gages and Bridges

This section describes the settings that you can configure for the analog input channels on 
devices, such as the DT9838 and DT9829 modules, that support strain gages and bridges.

Enable Shunt Resistor

For devices that support an internal shunt resistor, you can quickly verify your wiring by 
enabling the internal shunt resistor and acquiring data from the strain gage or bridge. You can 
then determine whether the value that you measured is what you expected. (Be sure to disable 
the shunt resistor after you have verified your wiring.) 

Note that this use of the shunt resistor is different from the use of the shunt resistor when 
performing shunt calibration. Shunt calibration is done using the Configuration and 
Calibration wizard, described next. During shunt calibration, the software automatically 
enables the shunt resistor for the calibration procedure and disables it once calibration has 
been performed. 

Configuration and Calibration Wizard

You can use the Configuration and Calibration wizard to set up the parameters for the strain 
gage or bridge-based sensor and, if desired, calibrate it.

When you click the Configure and Calibrate button, a screen similar to the following is 
displayed:
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Depending on your device, the following selections may be available:

• Full Bridge Based Sensor – for load cells, pressure transducers, torque transducers, and 
general-purpose bridge-based sensors

• Strain Gage – for strain gage sensors

• Voltage Based Sensor – for voltage inputs or non-strain gage inputs
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If your bridge-based sensor or strain gage supports TEDS (Transducer Electronic Data Sheet) 
data in hardware, the LED on this screen turns green. Click the Apply TEDs Values button to 
apply the TEDS data to the channel configuration.

If your sensor does not support TEDS data in hardware, the LED on this screen turns red. If a 
TEDS data file (virtual TEDS) is available for your sensor, click the Open TEDs data file.... 
button, select the TEDS data file to read, and click Open. The TEDS values are applied to the 
channel configuration.

Click Next to continue to the next page of the wizard.

Parameters for Full Bridge Based Sensors

If the sensor type is Full Bridge Based Sensor, a screen similar to the following appears:

If you applied TEDS values from the sensor hardware or data file, the TEDS values are 
displayed in the fields on this screen.
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You can configure the following parameters:

• Transducer Rated Output – Specify the rated output of the transducer in terms of mV/V 
excitation.

• Transducer Capacity – Specify the full-scale range of the transducer in its native 
engineering units.

• Using Sense Lines – For the selected analog input channel, enter Yes if remote sense lines 
are used or No if remote sense lines are not used in the wiring of the strain gage to the 
device.

The wiring diagram changes depending on this selection. To see the wiring diagram of the 
strain gage to the device, click the  button.

• Lead Wire Resistance – For the selected analog input channel, specify the lead wire 
resistance, in ohms. Note that if remote sense lines are used, then this value is set to 0 
automatically.

• Excitation Voltage – Specify the value of the excitation voltage that will be applied to all 
analog input channels on the device.

• Nominal Gage – For the selected analog input channel, enter the nominal gage resistance, 
in ohms, that is specified by the manufacturer of the sensor.

• Unit – For the selected analog input channel, select one of the following engineering units 
to represent the data, based on the sensor that is attached to the channel:

If you select Custom, you can define your own engineering units.

Click Next to continue to the calibration page of the wizard. A screen similar to the following 
appears:
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A balanced bridge produces zero volts under ideal conditions with zero strain applied. In 
practice, however, the output of a bridge in an unstrained condition is offset from zero slightly 
due to imperfect matching of bridge resistances.

You can adjust the offset of the channel by performing offset nulling on the channel. To 
perform offset nulling, select the Offset Nulling checkbox, click Next, and then click 
Calibrate. Internally, this value is subtracted from all subsequent measurements before the 
voltage is converted to the selected engineering units. Note that you wish, you can reset the 
value by clicking the Reset button. 

You can use shunt calibration to correct span errors in the measurement path. To perform 
shunt calibration, select the Shunt Calibration checkbox, and click Next. A screen similar to 
the following appears:
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If you want to enter a value rather than use a shunt resistor to perform the shunt calibration 
procedure, select Physical Value as the Calibration Type. The page changes to allow you to 
enter a value. Enter the physical value to apply to the bridge, and click the Calibrate button.

If your device supports an internal shunt calibration resistor, you can use this resistor to 
perform shunt calibration as follows:

1. Select Shunt Resistor as the Calibration Type.

2. Select Internal for the Select Resistor Source combo box.

3. Ensure that the internal RSHUNT+ and RSHUNT– lines are connected across the gage 
and that no strain is applied to the specimen. (The internal shunt resistor is automatically 
enabled for this procedure and automatically disabled when the shunt calibration 
procedure is complete.) 

4. For the Select Node to Shunt combo box, select the node (R1 to R4) that you want to 
shunt.

5. Click the Calibrate button.
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If you want to use an external shunt calibration resistor to perform shunt calibration, do the 
following:

1. Select Shunt Resistor as the Calibration Type.

2. Select External for the Select Resistor Source combo box.

3. Ensure that the external shunt resistor is connected across the gage, and that no strain is 
applied to the specimen. 

4. For the Select Node to Shunt combo box, select the node (R1 to R4) that you want to 
shunt.

5. Click the Calibrate button.

The calculated value, measured value, and correction coefficient are displayed. Note that you 
wish, you can reset the values by clicking the Reset button.

Click Finish when you are done using the wizard.

Parameters for Strain Gage Sensors

If the sensor type is Strain Gage, a screen similar to the following appears:



Configuring Channels, Acquisition Settings, and Digital Filters
If you applied TEDS values from the sensor hardware or data file, the TEDS values are 
displayed in the fields on this screen.

You can configure the following parameters:

• Bridge Type – Select one of the following bridge configurations for each analog input 
channel; refer to the user’s manual for your device for more information about each of 
these configuration types:

− Quarter Bridge 

− Quarter Bridge Temp Comp 

− Full Bridge Axial Poisson

− Full Bridge Bending 

− Full Bridge Bending Poisson 

− Half Bridge Bending 

− Half Bridge Poisson 

A circuit diagram is shown for the selected configuration type. To see how to wire the 
strain gage to the device, click the  button.

• Excitation Voltage – Specify the value of the excitation voltage that will be applied to all 
analog input channels on the device.

• Nominal Gage – For the selected analog input channel, enter the nominal gage resistance, 
in ohms, that is specified by the manufacturer of the strain gage.

• Gage Factor – For the selected analog input channel, enter the gage factor that is specified 
by the manufacturer of the strain gage.

• Using Sense Lines – For the selected analog input channel, enter Yes if remote sense lines 
are used or No if remote sense lines are not used in the wiring of the strain gage to the 
device.

The wiring diagram changes depending on this selection. To see the wiring diagram of the 
strain gage to the device, click the  button.

• Lead Wire Resistance – For the selected analog input channel, specify the lead wire 
resistance, in ohms. Note that if remote sense lines are used, then this value is set to 0 
automatically.

• Min Range – For the selected analog input channel, specify the minimum strain value for 
the range.

• Max Range – For the selected analog input channel, specify the maximum strain value for 
the range.

• Unit – For the selected analog input channel, select one of the following engineering units 
to represent the data, based on the sensor that is attached to the channel:
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If you select Custom, you can define your own engineering units.

• Poisson Ratio – Depending on the bridge type, specify the Poisson ratio for each analog 
input channel. If you click the  button, the following Poisson ratios are displayed for 
various materials:

Click Next to continue to the calibration page of the wizard. A screen similar to the following 
appears:
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A balanced bridge produces zero volts under ideal conditions with zero strain applied. In 
practice, however, the output of a bridge in an unstrained condition is offset from zero slightly 
due to imperfect matching of bridge resistances.

You can adjust the offset of the channel by performing offset nulling on the channel. To 
perform offset nulling, select the Offset Nulling checkbox, and click Next. A screen similar to 
the following appears:
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Click Calibrate. Internally, the calibrated offset is subtracted from all subsequent 
measurements before the voltage is converted to strain. Note that you wish, you can reset the 
value by clicking the Reset button. 

You can use shunt calibration to correct span errors in the measurement path. To perform 
shunt calibration, select the Shunt Calibration checkbox, and click Next. A screen similar to 
the following appears:
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If an internal shunt calibration resistor is provided by the device, you can use the internal 
shunt resistor to calibrate the strain gage. In this case, select Internal in the Select Resistor 
Source combo box, and ensure that the internal RSHUNT+ and RSHUNT– lines are connected 
across the gage and that no strain is applied to the specimen. (The internal shunt resistor is 
automatically enabled for this procedure and automatically disabled when the shunt 
calibration procedure is complete.) Then, for the Select Node to Shunt combo box, select the 
node that you want to shunt (the values depend on the bridge type that you selected). 

If you want to use a user-supplied external shunt calibration resistor, select External for the 
Select Resistor Source combo box, ensure that the external shunt resistor is connected across 
the gage, and that no strain is applied to the specimen. Then, for the Select Node to Shunt 
combo box, select the node that you want to shunt (the values depend on the bridge type that 
you selected).

Once the shunt calibration parameters have been configured, click Calibrate. The calculated 
value, measured value, and correction coefficient are displayed. Note that you wish, you can 
reset the values by clicking the Reset button.

Click Finish when you are done using the wizard.
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Parameters for Voltage Based Sensors

If the sensor type is Voltage Based Sensor, a screen similar to the following appears:

You can configure the following parameters:

• Unit – You can choose from one of the following engineering units to represent the data, 
based on the input that is attached to the channel:

If you select Custom, you can define your own engineering units.
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• Sensor Scaling – Depending on the engineering units that you select, you can enter the 
number of millivolts per engineering unit (mV/EU) by which to scale the raw voltage.

• Sensor Offset – Depending on the engineering units that you select, you can enter an 
offset value to add to the scaled signal.

Click Finish when you are done using the wizard.

Point #

If desired, you can enter a number representing the test point to which this channel 
corresponds. By default, values start at 1 and increment with each channel.

Digital Input Settings

If your device supports the ability to report the value of the digital input port in the analog 
input data stream, enable the digital input (DIN) channel.

The engineering units are automatically set to Bits.

Tachometer Settings

This section describes the settings that you can configure for tachometer channels that are 
supported in the analog input data stream.

Engineering Unit (EU)

For each tachometer channel, you can choose from one of the following engineering units to 
plot the data:

• RPM – Choose RPM if you want to plot the data from the tachometer in RPMs.

• Sec – Choose Sec if you want to plot the data from the tachometer in seconds.

• Hz – Choose Hz if you want to plot the data from the tachometer in Hertz.

Ticks/Rev

When you select RPM as the engineering unit for the tachometer, enter the number of ticks 
per revolution for your particular tachometer in the Ticks/Rev field. This allows the 
application to calibrate to the characteristics of your tachometer.

Max RPM

When you select RPM as the engineering unit for the tachometer, enter the maximum number 
of revolutions per minute for your particular tachometer in the Max RPM field.

This allows the application to calibrate to the characteristics of your tachometer. 
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RPM Multiplier

When you select RPM as the engineering unit for the tachometer, you can enter a value in the 
RPM Multiplier field to convert RPM into other units, such as Miles per Hour, Revolutions 
Per Second, or Hz. For example, to multiply by a factor of 2, enter 2 in the RPM Multiplier 
field. To divide by 2, enter a value of 0.5 in the RPM Multiplier field.

Max mSec/Hz

When you select Sec or Hz for the engineering units of the tachometer, you can enter the 
maximum value for the Y-axis in the Max mSec/Hz field.

Tach Edge

On the DT9837, the period of the tachometer input signal is not programmable; it is always 
measured from rising-to-rising edge. For other devices, select which period of the tachometer 
input signal to measure:

• Rising – Measures from the rising-to-rising edge of the tachometer input signal.

• Falling – Measures from the falling-to-falling edge of the tachometer input signal.

Note: Old tachometer values (from a previous tachometer operation) may be in the data 
stream until two tachometer edges of the specified type are detected.
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Counter Settings

This section describes the settings that you can configure for counters that are supported in 
the analog input data stream.

Note that counters may be used differently depending on the device. For example, Table 2 
describes how the counters are used the DT9837 Series devices. Refer to the documentation for 
your device for information on the counters provided by your device.

Engineering Unit (EU)

For each counter, you can choose from one of the following engineering units to plot the data:

• Sec – Choose Sec if you want to plot the data from the counter in seconds.  

• Hz – Choose Hz if you want to plot the data from the counter in Hertz.  

• Counts – Some devices provide the Counts option. Choose Counts if you want to plot the 
number of counts that were counted by the counter/timer.

Max mSec/Hz

When you select Sec or Hz for the engineering units of the counter, you can enter the 
maximum value for the Y axis in the Max mSec/Hz field.

Table 2: Use of Counter 1 and Counter 2 on Each Device 

Device Counter 1 (Tach Counter) Counter 2 (Gate Counter)

DT8837 Measure the frequency, period, or phase 
between two specified signals.

Measure the frequency, period, or phase 
between two specified signals.

DT9837 Not supported. Not supported.

DT9837A Measures the phase of the tachometer 
signal.

Not accessible on the device.

DT9837A-OEM Measures the phase of the tachometer 
signal.

Measures the pulse width of the gate 
input signal or the phase between the 
gate signal and the A/D completion signal.

DT9837B Measures the phase of the tachometer 
signal.

Measures the pulse width of the gate 
input signal or the phase between the 
gate signal and the A/D completion signal.

DT9837C Not supported. Not supported.

DT9838 Measure the frequency or period of the 
tachometer input signal.

Not supported.
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Start Edge

For each supported counter, select the signal edge that will start the measurement. You can 
choose from the following signals (note that not all options are provided by all devices):

• A/D Complete

• Tach Rising (on the DT9837 Series, this is supported by the Tach Counter only)

• Tach Falling (on the DT9837 Series, this is supported by the Tach Counter only)

• Clock Rising

• Clock Falling 

• Gate Rising (on the DT9837 Series, this is supported on the Gate Counter only)

• Gate Falling (on the DT9837 Series, this is supported by the Gate Counter only)

Stop Edge

For some devices, you can specify the stop edge of the counter, which stops the measurement. 
You can choose from the following signals:

• A/D Complete

• Tach Rising (on the DT9837 Series, this is supported by the Tach Counter only)

• Tach Falling (on the DT9837 Series, this is supported by the Tach Counter only)

• Gate Rising (on the DT9837 Series, this is supported on the Gate Counter only)

• Gate Falling (on the DT9837 Series, this is supported by the Gate Counter only)
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Quadrature Decoder Channel Settings

This section describes the settings that you can configure for quadrature decoder channels that 
are supported in the analog input data stream. 

Engineering Unit (EU)

For each counter, you can choose from one of the following engineering units to plot the data:

• Deg – Choose Deg if you want to plot the data from the quadrature decoder in degrees.  

• Counts – Choose Counts if you want to plot the number of counts that were counted by 
the quadrature decoder.

Pulses/Rev

Enter the number of pulses per revolution for your quadrature encoder. This number is 
device-specific; therefore, refer to the documentation for your quadrature encoder to 
determine this number.

Clock Prescale

Enter the pre-scale value that is used to filter the onboard clock. Using a clock pre-scale value 
can remove ringing edges and unwanted noise for more accurate data.

X4 Scaling

The scaling mode (X1 or X4 mode), determines the resolution of the quadrature encoder. If X4 
Scaling is disabled, X1 mode is used. In X1 mode, the quadrature decoder counts the edges on 
the A signal input. 

If X4 scaling mode is enabled, X4 scaling mode is used. In X4 mode, the quadrature decoder 
counts the edges on the A and B signal inputs. Therefore, if a quadrature encoder has 360 
pulses per revolution, X1 mode yields 360 counts when the quadrature encoder is rotated 360 
degrees. X4 mode yields four times the number of counts, or 1440 (360 x 4) when the 
quadrature encoder is rotated 360 degrees.

Index Mode

You can specify one of the following for the Index Mode:

• High – The Index input is enabled and the positional count is zeroed on the high edge of 
the Index signal.

• Low – The Index input is enabled and the positional count is zeroed on the low edge of 
the Index signal.

• Disabled – The Index input is disabled and the positional count is not zeroed. Note that if 
X4 Scaling is Enabled, Index Mode must be disabled.
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Applying and Saving Changes

Click Close when you are through with this dialog box to apply the changes you made to the 
hardware and to reconfigure the application, as needed. 

For information on saving and loading a configuration file, refer to page 43. For information 
about the backup configuration file, refer to page 44.
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Configuring the Settings of the Recording Tab
Before starting acquisition, configure how the data is recorded using the Recording tab of the 
Acquisition Config window.

The Recording tab is different depending on the interface mode you are using, as described 
below.

Recording Tab When Using the Data Logger Interface

If you are using the Data Logger interface, the Recording tab appears as follows:

The Recording tab of the Data Logger interface contains these settings:

• Filename generation – Specify how to create the name of the file. You can choose one of 
the following options:

− Filename – The specified filename is created when you click the Record toolbar button 
(  ). Each time you click the Record toolbar button, you will be prompted to 
overwrite the file. QuickDAQ Data.hpf is an example of a filename that was created 
using the Filename option.
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− Filename-Sequence – The specified filename is created and a starting number that you 
define is appended to the filename when you click the Record toolbar button
(  ). Each time you click the Record toolbar button, the number that is 
appended to the filename is incremented by one. QuickDAQ Data-1.hpf is an example 
of a filename that was created using the Filename-Sequence option.

− Filename-DateTime – The specified filename is created and the current date and time is 
appended to the filename when you click the Record toolbar button (  ). 
Each time you click the Record toolbar button, the filename with the current date and 
time is created. QuickDAQ Data-2012-11-15_02-15-31-PM.hpf is an example of a 
filename that was created using the Filename-DateTime option.

• Filename base – Specify the name of the High Performance binary file (.hpf) in which to 
store the data that is recorded when you click the Record toolbar button (  ). 
The default path is shown. You can change this path, if desired. The application saves the 
data file path and is uses this path by default.

• Enable Continuous Acquisition – Determines how data acquisition and processing stops.

Check this checkbox to enable continuous acquisition. In this mode, you must click the 
Stop button or hold down the Shift key and press the F5 key to stop 
acquisition/processing.

If the Enable Continuous Acquisition checkbox is unchecked, you must specify how long 
to acquire data using the Acquisition Duration.

Note: Continuous acquisition is supported by DT8824, DT8837, and MEASURpoint 
devices when using the Data Logger interface. 

If a device is acquiring data continuously and unread data in the hardware circular 
memory buffer starts to be overwritten, acquisition is stopped and an overrun error is 
reported.

• Acquisition Duration – (Available only if the Enable Continuous Acquisition checkbox 
is unchecked). You can either enter a value that specifies the number of days (dd), number 
of hours (hh), minutes (mm), and seconds (ss) that you want to acquire data from the 
device, or select one of the following predefined values from the combo box:

− 10 Seconds

− 1 Minute

− 5 Minutes

− 10 Minutes

− 30 Minutes

− 1 Hour

− 5 Hours

− 12 Hours

− 1 Day

− 2 Days
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If the Enable Continuous Acquisition checkbox is unchecked, acquisition stops 
automatically when the specified duration elapses. 

• X Axis Span – You can either enter a value that specifies the number of days (dd), number 
of hours (hh), minutes (mm), and seconds (ss) that you want to use for the span of the 
x-axis of the plots on the Channel Plot window, or select the default value from the combo 
box.

Note: If you specify a value for the x-axis span that is less than the acquisition duration, 
the x-axis scrolls using the span you specified.

• Notes – Use this field to add any notes as desired. If you choose to export the data to 
ASCII, this information is also exported.

Based on the information that you enter for the Recording tab and the Acquisition tab (for the 
Data Logger interface), or Freq tab (for the FFT Analyzer interface), the software configures 
the hardware and displays the following configuration settings used by the device:

• The actual sample rate used by the device.

• The actual sample interval used by the device.

• The actual number of scans to acquire.
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Recording Tab When Using the FFT Analyzer Interface

If you are using the FFT Analyzer interface, the Recording tab appears as follows:
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The Recording tab of the FFT Analyzer interface contains these settings:

• Filename generation – Specify how to create the name of the file. You can choose one of 
the following options:

− Filename – The specified filename is created when you click the Record toolbar button 
(  ). Each time you click the Record toolbar button, you will be prompted to 
overwrite the file. QuickDAQ Data.hpf is an example of a filename that was created 
using the Filename option.

− Filename-Sequence – The specified filename is created and a starting number that you 
define is appended to the filename when you click the Record toolbar button
(  ). Each time you click the Record toolbar button, the number that is 
appended to the filename is incremented by one. QuickDAQ Data-1.hpf is an example 
of a filename that was created using the Filename-Sequence option.

− Filename-DateTime – The specified filename is created and the current date and time is 
appended to the filename when you click the Record toolbar button (  ). 
Each time you click the Record toolbar button, the filename with the current date and 
time is created. QuickDAQ Data-2012-06-25_02-39-59-PM.hpf is an example of a 
filename that was created using the Filename-DateTime option.

• Filename base– Specify the name of the High Performance binary file (.hpf) in which to 
store the data that is recorded when you click the Record toolbar button (  ). 
The default path is shown. You can change this path, if desired. The application saves the 
data file path and is uses this path by default.

• Enable Continuous Acquisition – Determines how data acquisition and processing stops.

Check this checkbox (available on USB modules only) to enable continuous acquisition. In 
this mode, you must click the Stop button or hold down the Shift key and press the F5 
key to stop acquisition/processing.

If the Enable Continuous Acquisition checkbox is unchecked, specify the number of 
averages that the application will compute before stopping acquisition/processing.

Note: When using the FFT Analyzer interface, continuous acquisition is not supported 
by DT8824 and DT8837 devices due to FFT data block size requirements and the 
possibility of network traffic preventing continuous streaming. Continuous acquisition is 
supported by MEASURpoint devices, however, due to their slow sampling rates. 

If you need continuous acquisition on a DT8824 or DT8837 device, use the Data Logger 
interface.

If a device is acquiring data continuously and unread data in the hardware circular 
memory buffer starts to be overwritten, acquisition is stopped and an overrun error is 
reported.
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• Number of Averages – (Available only if the Enable Continuous Acquisition checkbox is 
unchecked). Specify the number of records to acquire, process, and average. 

When the Enable Continuous Acquisition checkbox is unchecked, acquisition stops 
automatically when the specified number of averages has been reached. The software 
displays the total length of time for the specified number of records to be acquired, 
processed, and averaged), in seconds. 

How acquisition starts depends on the trigger settings, described on page 131. 

• Notes – Use this field to add any notes as desired. If you choose to export the data to 
ASCII, this information is also exported.

Based on the settings of the Acquisition Config window, the available disk space is displayed 
and is updated as the recording progresses.
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Configuring the Settings of the Acquisition Tab (Data 
Logger Interface Only)

If you are using the Data Logger interface, use the Acquisition tab of the Acquisition Config 
window to set up parameters that apply to the A/D subsystem of the device, including the 
sampling frequency, trigger source, filter type, temperature units, channel configuration, 
and/or input voltage range.

Sampling Frequency

Enter the sampling frequency per channel for the device. For simultaneous devices, the total 
throughput is the same as the per channel sampling frequency, since all channels are acquired 
at the same time.

For multiplexed devices, multiply the per channel sampling frequency by the number of 
enabled channels to determine the total throughput. For example, if five analog input 
channels are enabled on the multiplexed device and the per channel sampling frequency is 
200 Hz, the total throughput is 1000 Hz (200 Hz x 5). 

Refer to the user’s manual for your device for information on the supported sampling 
frequencies.
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Trigger Source

Specify the trigger source that starts acquisition on the device. Examples of trigger sources 
that may be supported for starting acquisition on the device include the following:

• Software – The device starts acquiring scans when you click the Record button or press 
the F5 key. Once acquisition starts, all triggers are ignored. Acquisition stops when the 
conditions defined in the Recording tab, described on page 119, are met.

• External TTL Pos Edge – The device starts acquisition when it detects a rising-edge 
voltage on the external trigger line. Once triggered, the state of external trigger line is 
ignored. The process continues until the conditions defined in the Recording tab, 
described on page 119, are met. 

• External TTL Neg Edge – The device starts acquisition when it detects a negative-edge 
voltage on the external trigger line. Once triggered, the state of external trigger line is 
ignored. The process continues until the conditions defined in the Recording tab, 
described on page 119, are met. 

• Analog Threshold Pos Edge – The device starts acquisition when it detects a positive 
edge, analog threshold trigger event. You can specify the threshold value on which to 
trigger and the channel to use for the analog threshold trigger.

You cannot use this trigger source if the following condition are true on the Output tab: 
the analog output channel is enabled and the start method is On Acquisition Start.

• Analog Threshold Neg Edge – The device starts acquisition when it detects a negative 
edge, analog threshold trigger event. You can specify the threshold value on which to 
trigger and the channel to use for the analog threshold trigger.

You cannot use this trigger source if the following condition are true on the Output tab: 
the analog output channel is enabled and the start method is On Acquisition Start.

For example, assume that you specified the trigger source as External TTL Pos Edge, set the 
Acquisition Duration field on the Recording tab to 5 Seconds, and clicked the Record toolbar 
button (  ) or pressed the F5 key. In this example, the device waits until it detects a 
rising-edge TTL pulse on external trigger line before acquiring data. When five seconds of 
data are acquired, acquisition stops.

Refer to the user’s manual for your device for information on the supported trigger sources.

Filter Type

If supported by your device, you can configure one of the following filter types:

• Moving average – (The default filter setting.) This filter type removes unwanted noise 
from your measurements and provides a compromise of filter functionality and response 
time. This filter can be used in any application.

This low-pass filter takes the previous 16 samples, adds them together, and divides by 16.

• None – No filter. Provides fast response times, but the data may be difficult to interpret. 
Use when you want to filter the data yourself.
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The data is represented exactly as is when it comes out of the Delta-Sigma A/D 
converters. Note that Delta-Sigma converters provide substantial digital filtering above 
the Nyquist frequency.

Generally, the only time it is desirable to use the None filter setting is if you are using fast 
responding thermocouples, sampling them at higher speeds (> 1 Hz), and need as much 
response speed as possible.

Temperature Units

For thermocouple, RTD, and thermistor measurements, you can select the temperature units 
(Celsius, Fahrenheit, and Kelvin) into which the voltage data is converted. This setting is 
applied to all the temperature channels of the device.

You can see which temperature unit will be displayed for each channel in the Configure 
Devices dialog box, described on page 90.

Single-Ended or Differential Channel Configuration

If your device supports it, you can select the following channel configuration for the A/D 
subsystem:

• Single-ended – Choose this configuration when you want to measure high-level signals, 
noise is not significant, the source of the input is close to the device, and all the input 
signals are referred to the same common ground. Refer to the user’s manual for your 
device for wiring information. Refer to the user’s manual for your device for wiring 
information.

• Differential – Choose this configuration when you want to measure thermocouple or 
low-level signals, you are using an A/D converter with high resolution, noise is a 
significant part of the signal, or common-mode voltage exists. Refer to the user’s manual 
for your device for wiring information. Refer to the user’s manual for your device for 
wiring information.

Input Voltage Range

If your device supports multiple input ranges per channel, you configure the input range 
using the Configure Devices dialog, described on page 88.

If your device supports multiple input voltage ranges and/or gains that apply to the entire 
subsystem, you can select which effective input range to use for the A/D subsystem using the 
Input Voltage Range drop-down box. For example, if your device supports and input range 
of ±10 V with gains of 1 and 2, two effective input ranges are supported: ±10 V (±10 V divided 
by a gain of 1) and ±5 V (±10 V divided by a gain of 2).

Refer to the user’s manual for your device for specific information on the input voltage ranges 
and gains that are supported.
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Configuring the Settings of the Freq Tab (FFT Analyzer 
Interface Only)

If you are using the FFT Analyzer interface, configure the settings of the Freq tab of the 
Acquisition Config window before starting acquisition; these settings are used to program the 
data acquisition device:

The settings of the Freq tab are described in the following subsections. Based on the 
information that you enter for the Recording tab and the Freq tab, the software configures the 
hardware and displays the following configuration settings used by the device:

• The actual sample rate used by the device.

• The actual sample interval used by the device.

• The actual number of scans to acquire.

• The actual number of averages to perform.

Maximum Frequency to Analyze

Specify the bandwidth or span of the input signals that you want to analyze. Internally, the 
software multiplies this value by 2 to set the sampling rate of the device.
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FFT Size

Specify how many data points to use when generating the FFTs for the analog input channels. 

The number of spectral lines and the frequency resolution are calculated and displayed when 
the maximum frequency to analyze and the FFT size are changed.

Single-Ended or Differential Channel Configuration

If your device supports it, you can select the following channel configuration for the A/D 
subsystem:

• Single-ended – Choose this configuration when you want to measure high-level signals, 
noise is not significant, the source of the input is close to the device, and all the input 
signals are referred to the same common ground. 

• Differential – Choose this configuration when you want to measure thermocouple or 
low-level signals, you are using an A/D converter with high resolution, noise is a 
significant part of the signal, or common-mode voltage exists.

Input Voltage Range

If your device supports multiple input ranges per channel, you configure the input range 
using the Configure Devices dialog, described on page 88.

If your device supports multiple input voltage ranges and/or gains that apply to the entire 
subsystem, you can select which effective input range to use for the A/D subsystem using the 
Input Voltage Range drop-down box. For example, if your device supports and input range 
of ±10 V with gains of 1 and 2, two effective input ranges are supported: ±10 V (±10 V divided 
by a gain of 1) and ±5 V (±10 V divided by a gain of 2).

Refer to the user’s manual for your device for specific information on the input voltage ranges 
and gains that are supported.

Temperature Units

For thermocouple, RTD, and thermistor measurements, you can select the temperature units 
(Celsius, Fahrenheit, and Kelvin) into which the voltage data is converted. This setting is 
applied to all the temperature channels of the device.

You can see which temperature unit will be displayed for each channel in the Configure 
Devices dialog box, described on page 90.
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Filter Type

If supported by your device, you can configure one of the following filter types:

• Moving average – (The default filter setting.) This filter type removes unwanted noise 
from your measurements and provides a compromise of filter functionality and response 
time. This filter can be used in any application.

This low-pass filter takes the previous 16 samples, adds them together, and divides by 16.

• None – No filter. Provides fast response times, but the data may be difficult to interpret. 
Use when you want to filter the data yourself.

The data is represented exactly as is when it comes out of the Delta-Sigma A/D 
converters. Note that Delta-Sigma converters provide substantial digital filtering above 
the Nyquist frequency.

Generally, the only time it is desirable to use the None filter setting is if you are using fast 
responding thermocouples, sampling them at higher speeds (> 1 Hz), and need as much 
response speed as possible.
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Configuring the Settings of the Trigger Tab (FFT 
Analyzer Interface Only)

If you are using the FFT Analyzer interface, use the Trigger tab of the Acquisition Config 
window to set up the trigger source that starts acquisition on the device and the trigger mode. 
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Trigger Source

The following trigger sources are supported for starting acquisition on the device:

Note: In multiple device configurations, the trigger source is the trigger that starts 
acquisition on the master device.

• Free Run – The device starts acquiring contiguous, gap-free, records when you click the 
Record button or press the F5 key. 

If the Enable Continuous Acquisition checkbox on the Recording tab, described on page 
119, is checked, you must click the Stop button or hold down the Shift key and press the 
F5 key to stop acquisition/processing.

If the Enable Continuous Acquisition checkbox on the Recording tab is unchecked, 
acquisition stops automatically when the specified number of records have been 
averaged. 

• External TTL Pos Edge – The device acquires one record each time it detects a rising-edge 
transition on the external digital (TTL) signal connected to the Trigger In input. The 
process continues until the conditions defined in the Recording tab, described on page 
119, are met. 

This trigger provides a threshold voltage of 2 V with 0.5 V of hysteresis.

• Analog Threshold Pos Edge – The device acquires one record each time it detects a 
positive edge, analog threshold trigger event. Refer to page 133 or the threshold trigger 
options.

You cannot use this trigger source if the following condition are true on the Output tab: 
the analog output channel is enabled and the start method is On Acquisition Start.

• Analog Threshold Neg Edge – The device acquires one record each time it detects a 
negative edge, analog threshold trigger event. Refer to page 133 or the threshold trigger 
options.

You cannot use this trigger source if the following condition are true on the Output tab: 
the analog output channel is enabled and the start method is On Acquisition Start.

• LXI0 to LXI5 – Supported on DT8837 devices only, the device acquires one record each 
time it detects the specified LXI trigger on the Trigger Bus. (This trigger source applies to 
the master device only.)

• LAN0 to LAN7 – Supported on DT8837 devices only, the device acquires one record each 
time it detects the specified LAN trigger event.

• Software Triggered – The device starts acquiring records based on an internal software 
trigger. If Auto Retrigger as the trigger mode, you can also specify a delay, in seconds, to 
wait before the next software triggered record/frame is acquired. By default, the delay is 
0 s, which is equivalent to no delay. Refer to page 134 for more information on Auto 
Retrigger mode.
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This mode is typically used in conjunction with the Output tab when you want to use an 
analog output signal to generate burst random and burst chirp operations; in these 
applications, the full output frequency range and duration is contained within the time of 
a single analysis frame or record.

Note: When you use the software triggered option, the horizontal axis of the Channel 
Plot shows relative time within the average, not absolute time, as some overhead is 
required to start each acquisition when the trigger occurs.

If the Enable Continuous Acquisition checkbox on the Recording tab, described on page 
122, is checked, you must click the Stop button or hold down the Shift key and press the 
F5 key to stop acquisition/processing.

If the Enable Continuous Acquisition checkbox on the Recording tab is unchecked, 
acquisition stops automatically when the specified number of records have been 
averaged. 

Threshold Trigger Options

If you selected the analog threshold trigger as the trigger source, the following options are 
available for configuring the threshold trigger:

• Threshold Value  – Enter the user-specified threshold value in the units of the threshold 
channel that you select. (QuickDAQ supports a threshold voltage between 0.8 V and 9.8 V 
for the DT8837, and –9.8 V to +9.8 V for the DT9837 Series modules.)

• Channel – Specify the channel to use for the analog threshold trigger. For the DT8837, this 
is analog input channel 0. For the DT9837 Series modules, this can be any enabled analog 
input channel.
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• Pre Trigger Data Percent – Specify the percentage of data (0 to 100) that you want to 
acquire prior to the start of the threshold trigger event. This allows you to acquire the 
entire pulse and get a reliable trigger. If you specify 0% as the pre-trigger data, only the 
data after the trigger is captured. 

Note that an entire record of data is always captured when the threshold trigger event 
occurs; however, the percentage of pre-trigger data that you requested is not guaranteed, 
as the trigger event may occur earlier than expected.

• Show trigger markers in plot – Select this checkbox if you want to see when the trigger 
occurred in the trace for the stimulus (reference) signal. The trigger marker is shown in 
red if you do not get all the pre-trigger data that you specified. If you get all the 
pre-trigger data that you specified, the trigger marker is displayed in the same color as the 
trace color.

Note: Ensure that the trace color is not red if you want to use the color of trigger marker to 
indicate whether or not you captured all the pre-trigger data. 

Trigger Mode

If the trigger source is not Free Run, you can specify how you want to accept each average by 
choosing one of the following trigger modes:

• Auto Retrigger – Select this trigger mode if you want the application to accept the data 
after each average automatically.

• User Accept-Reject – Select this trigger mode if you want to determine whether to keep 
the data after each average. 

Once you start recording when using this trigger mode, you must click the Accept button 
(to keep the data) or click the Reject button (if you do not want to keep the data) after each 
average. The Accept and Reject buttons are located in the Acquisition Status window 
under the Channel Plot and Channel Display windows.

Note: Once a record has been acquired and the software is waiting for you to click the 
Accept or Reject button, the Channel Plot window controls are enabled. This allows you 
to review the data in detail before you accept or reject it.

To start the next average, ensure that you provide the appropriate trigger.
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Configuring the Settings of the Window Tab (FFT 
Analyzer Interface Only)

If you are using the FFT Analyzer interface, specify the windowing function to apply to the 
FFT channels to reduce spectral leakage errors using the Window tab of the Acquisition 
Config window. The contents of the Window tab are different for the FFT Analysis and 
Advanced FFT Analysis options.

Window Tab for the FFT Analysis Option

If you are using the FFT Analysis option, the Window tab appears as follows: 

The following windowing types are available when generating FFTs; this is a global setting 
that is applied to all FFT channels: 

• Rectangular – No window. Recommended for use when your signal content contains 
random noise (white noise) or closely spaced sine waves.

• Hamming – Bell-shaped cosine window optimized to minimize the maximum (nearest) 
side lobe. Recommended for use when your signal content consists of closely spaced sine 
waves.

• Hanning – Bell-shaped cosine window typically used to analyze continuous signals. 
Recommended for use when your signal content contains sine waves, a combination of 
sine waves, vibration data consisting of narrowband random signals, or unknown 
content.

• Bartlett – Triangular window. 

• Blackman – Similar to the Hanning and Hamming windows, this window has slightly 
wider central lobes and less sideband leakage.

• BlackmanHarris – Similar to Hanning window, this window has a slightly wider main 
lobe but much better dynamic range. It is optimized to provide the minimum side lobe 
level.  
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• FlatTop – Optimized for measuring peak amplitudes of discrete spectral components that 
are separated by several spectral lines. Recommended for use when your signal content 
consists of sine waves and amplitude accuracy is important.

Window Tab for the Advanced FFT Analysis Option

If you are using the Advanced FFT Analysis option, the Window tab appears as follows:

The following windowing types are available when generating FFTs for channels that were 
configured as response channels; this is a global setting that is applied to the FFTs of all 
enabled response channels: 

• Rectangular – No window. Recommended for use when your signal content contains 
random noise (white noise) or closely spaced sine waves.

• Hamming – Bell-shaped cosine window optimized to minimize the maximum (nearest) 
side lobe. Recommended for use when your signal content consists of closely spaced sine 
waves.

• Hanning – Bell-shaped cosine window typically used to analyze continuous signals. 
Recommended for use when your signal content contains sine waves, a combination of 
sine waves, vibration data consisting of narrowband random signals, or unknown 
content.

• Bartlett – Triangular window. 

• Blackman – Similar to the Hanning and Hamming windows, this window has slightly 
wider central lobes and less sideband leakage.

• BlackmanHarris – Similar to Hanning window, this window has a slightly wider main 
lobe but much better dynamic range. It is optimized to provide the minimum side lobe 
level.  

• FlatTop – Optimized for measuring peak amplitudes of discrete spectral components that 
are separated by several spectral lines. Recommended for use when your signal content 
consists of sine waves and amplitude accuracy is important.
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• Exponential – This window is equal to 1.0 at the beginning of the record and decays 
exponentially to a smaller value at the end of the record. You can specify a value between 
0 and 1 as the Exp Factor. This value indicates how much to decay the signal, allowing you 
to tailor the resultant FFT to the relevant data in the record.

These windowing types are available when generating FFTs for channels that were configured 
as reference channels; this is a global setting that is applied to the FFTs of all reference 
channels: 

• Same as Response – Applies the same windowing function that was selected for the 
response channels to the FFTs for the reference channels.

• Force – This window allows you to specify the percentage of the signal period to which 
the rectangular window is applied. Data outside the selected percentage is forced to zero. 

In the Start % field, enter the percentage of the period at which the rectangular window 
starts. In the End % field, enter the percentage of the signal period at which the 
rectangular window stops. 

By applying this window to the output of a transducer, you can avoid collecting 
extraneous signals, such as forces from the retraction of a hammer, that are not important 
to the measurement. 

• Cosine Taper – This window allows you to specify the percentage of the period to allow 
the signal to come through unaltered before smoothing the signal ends to zero.
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Configuring the Settings of the Output Tab
If your device support analog output channels, you can configure the analog output signal of 
your device to provide a stimulus to a system under test using the Output tab of the 
Acquisition Config window.

Figure 14 shows the appearance of the Output tab when using the Data Logger interface.

Figure 14: Output Tab When Using the Data Logger Interface
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Figure 15 shows the appearance of the Output tab when using the FFT Analyzer interface.

Figure 15: Output Tab When Using the FFT Analyzer Interface
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Enabling Channels

If you want to output an analog signal, enable the analog output channel on the module by 
clicking the checkbox under the Enable column of the Output tab. 

Note: Only one analog output channel can be enabled at a time.

Note that if you are using multiple devices in a Master/Slave arrangement, only the analog 
output channel on the master device is available to be enabled.

Channel Name

The name of the channel is displayed under the Channel Name column of the Output tab. It 
cannot be changed.

Peak Voltage

Enter the voltage of the largest peak to output, measured from 0 V. The output will be ± the 
peak voltage.

Offset

If desired, enter a value to offset the output signal from the default baseline of 0 V. The default, 
is 0 V. Choosing a positive value, moves the signal up (above 0 V). Choosing a negative value, 
moves the signal down (under 0 V).

Waveform Type

You can choose one of the following waveform types to output:

• Fixed – A known output pattern with a fixed frequency.

• Sweep – A sine wave whose frequency changes over time.

• Noise – A variable waveform that carries a range of frequency components.

Specific parameters are configurable based on the waveform type that you choose. The 
waveform types and their configurable parameters are described in detail in the following 
sections.
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Fixed Waveforms

A fixed waveform has a known pattern with a fixed frequency. When you choose a fixed 
waveform type, the following options are available:

Note: You can change these parameters when the analog output operation is running to 
change the output signal in real-time.

Signal Type

Specify the pattern of the waveform to output by choosing one of the following signal types:

• Sine – A sinusoidal, periodic waveform.

• Square – A non-sinusoidal waveform that is shaped like a square, alternating between 
two levels. (Note that due to the nature of Sigma-Delta converters used on the supported 
data acquisition devices, you may see variations of the signal at each level.)

• Ramp – A non-sinusoidal waveform that ramps up and then drops sharply. This is 
sometimes called a sawtooth waveform.

• Triangle – A non-sinusoidal waveform that is shaped like a triangle.

Output Frequency

Specify the frequency at which to output the waveform. For fixed waveforms, this frequency 
is constant for the duration of the waveform.
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Output Mode

You can choose one of the following output modes:

• Continuous – In continuous mode, the waveform is output repetitively until acquisition 
stops if the Start/Stop method is With Acquisition or until you stop it with the Stop 
button.

• Burst – In burst mode, the waveform is output for a specified amount of time. If the 
Repeat Burst checkbox is unchecked, the waveform is output once. If the Repeat Burst 
checkbox is checked, the burst waveform is output repetitively.

You specify how long the signal is on by specifying the Burst On Time. You specify how 
long the signal is off (signal is at 0 V) by specifying the Burst Off Time.

If you are using the Data Logger interface and the Lock to acquisition time checkbox is 
checked, the waveform is output in the time that it takes to acquire the data (specified in 
the Recording tab). 

If you are using the FFT Analyzer interface and the Lock to acquisition time checkbox is 
checked, the waveform is output in the time that it takes to do all the averages (an 
acquisition of all the records specified in the Recording tab). 

If you are using the FFT Analyzer interface and the Lock to analysis frame time checkbox 
is checked, the waveform is output in the time that it takes to do one average (an 
acquisition of one record). This option is useful in applications where repeatability is 
required, such as outputting a repeatable chirp signal.

Notes: If you are using the FFT Analyzer interface, the Lock to acquisition time checkbox 
is checked, and the Start Method on the Output tab is With Acquisition, the analog input 
trigger source should be Freerun or you will be prompted to change it to this setting. This 
is to guarantee that the analog output data is correlated properly with the analog input 
data for each record when many averages are performed.

If the Lock to analysis frame time checkbox is checked and the Start Method on the 
Output tab is With Acquisition, the analog input trigger source should be Software 
Triggered or you will be prompted to change it to this setting. This is to guarantee that the 
analog output data is correlated properly with the analog input data for each record when 
many averages are performed.

If you make any changes to the parameters on the Recording tab, Acquisition tab, or Freq tab, 
the values are automatically updated on the Output tab.

Ramp Up Time and Ramp Down Time

If desired, you can determine how long it takes for the signal to ramp up at the start of the 
waveform to the specified peak voltage by specifying the Ramp Up Time.

If the output mode is Burst, you can also specify how long it takes for the signal to ramp down 
to 0 V at the end of the waveform by specifying the Ramp Down Time. 
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Example

Figure 16 shows a sine wave with a fixed frequency of 10 Hz, a peak voltage of 3 V, an offset of 
0 V, a Burst On Time of 3 seconds, a Ramp Up time of 1.0 second and a Ramp Down time of 1.0 
second:

Figure 16: Fixed Sine Wave with Modified Burst On Time and Ramp Up/Ramp Down Time
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Sweep Waveforms

A sweep waveform is a sine wave whose frequency changes over time. Swept sine waves 
allow you to test a device over a wide frequency range to determine if any resonances occur. 

If you are using the Data Logger interface, the following options are available when you 
choose the Sweep waveform type:

Figure 17: Sweep Waveform Options for the Data Logger Interface

If you are using the FFT Analyzer interface, the following options are available when you 
choose the Sweep waveform type:
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Figure 18: Sweep Waveform Options for the FFT Analyzer Interface

Note: You can change these parameters when the analog output operation is running to 
change the output signal in real-time.

Sweep Mode

Specify one of the following sweep modes:

• Loop – In loop mode, the swept sine wave repeats continuously.

• Single – In single mode, the swept sine wave is output once.

Frequency Change

Specify how you want the frequency of the waveform to change over time by selecting one of 
the following values for the Freq Change combo box:

• Linear – The frequency increases at a fixed rate of frequency per time (Hz/s).

• Log – In this mode, the frequency increases at a fixed rate of octave change per time 
(Octave/s). This is also called an exponential sweep. 
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Start and End Frequencies

In the Start Frequency field, specify the frequency of the waveform when it starts.

In the End Frequency field, specify the frequency of the waveform when it ends.

If you want a swept sine wave that increases in frequency over time, ensure that the ending 
frequency is greater than the starting frequency; this is sometimes called a chirp. If you want a 
swept sine wave that decreases in frequency over time, ensure that the ending frequency is 
less than the starting frequency.

Sweep On Time and Sweep Off Time

You specify how long the signal is on by specifying the Sweep On Time. You specify how long 
the signal is off (signal is at 0 V) by specifying the Sweep Off Time.

If you are using the Data Logger interface and the Lock to acquisition time checkbox is 
checked, the waveform is output in the time that it takes to acquire the data (specified in the 
Recording tab). 

If you are using the FFT Analyzer interface and the Lock to acquisition time checkbox is 
checked, the waveform is output in the time that it takes to do all the averages (an acquisition 
of all the records specified in the Recording tab). 

If you are using the FFT Analyzer interface and the Lock to analysis frame time checkbox is 
checked, the waveform is output in the time that it takes to do one average (an acquisition of 
one record). This option is useful in applications where repeatability is required, such as 
outputting a repeatable chirp signal.

Notes: If you are using the FFT Analyzer interface, the Lock to acquisition time checkbox is 
checked, and the Start Method on the Output tab is With Acquisition, the analog input 
trigger source should be Freerun or you will be prompted to change it to this setting. This is 
to guarantee that the analog output data is correlated properly with the analog input data for 
each record when many averages are performed.

If the Lock to analysis frame time checkbox is checked and the Start Method on the Output 
tab is With Acquisition, the analog input trigger source should be Software Triggered or you 
will be prompted to change it to this setting. This is to guarantee that the analog output data 
is correlated properly with the analog input data for each record when many averages are 
performed.

If you make any changes to the parameters on the Recording tab, Acquisition tab, or Freq tab, 
the values are automatically updated on the Output tab.
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Ramp Up Time and Ramp Down Time

If desired, you can determine how long it takes for the signal to ramp up at the start of the 
waveform to the specified peak voltage by specifying the Ramp Up Time.

You can also specify how long it takes for the signal to ramp down to 0 V at the end of the 
waveform by specifying the Ramp Down Time. 

Examples

Figure 19 shows a linear swept sine wave from 1 to 30 Hz. 

Figure 19: Linear Swept Sine Wave from 1 to 30 Hz

Figure 20 shows a logarithmic swept sine wave from 1 to 30 Hz.
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Figure 20: Logarithmic Swept Sine Wave from 1 to 30 Hz

Figure 21 shows a logarithmic swept sine wave from 1 to 100 Hz with a Sweep On time of 3.0 
s, a Sweep Off time of 2.0 s, a Ramp Up time of 1.0 s, and a Ramp Down time of 2.0 s.
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Figure 21: Logarithmic Swept Sine Wave from 1 to 100 Hz with Modified Sweep On/Off Times and 
Ramp Up/Down Times
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Noise Waveforms

A noise waveform is a variable waveform that carries a range of frequency components, 
allowing you to uncover resonances at a variety of frequencies. 

If you are using the Data Logger interface and choose a noise waveform type, the following 
options are available:

Figure 22: Noise Waveform Options Using the Data Logger Interface

If you are using the FFT Analyzer interface and choose a noise waveform type, the following 
options are available:
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Figure 23: Noise Waveform Options Using the FFT Analyzer Interface

Note: You can change these parameters when the analog output operation is running to 
change the output signal in real-time.

Noise Type

Specify the type of noise waveform to output by choosing one of the following signal types:

• Random – A noise signal with a power spectral density that remains constant over the 
entire noise bandwidth and an amplitude histogram that exhibits a constant distribution.

Figure 24 shows a random noise signal (from 0 Hz to 200 Hz) in the time domain.
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Figure 24: Random Noise Signal

Figure 25 shows a histogram of the random noise in the time domain. As you can see, the 
amplitudes in the time domain form a flat histogram.
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Figure 25: Histogram of Random Noise in the Time Domain Shows a Flat Distribution

• Random Normal – A noise signal with a power spectral density that remains constant 
over the entire noise bandwidth and an amplitude histogram that exhibits a Gaussian 
distribution.

The software creates random normal noise by implementing the Box-Muller transform. 

Figure 26 shows a random normal noise signal (from 0 Hz to 200 Hz) in the time domain.
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Figure 26: Random Normal Noise Signal 

Figure 27 shows a histogram of the random normal noise in the time domain. As you can 
see, the amplitudes in the time domain form a Gaussian histogram.
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Figure 27: Histogram of Random Normal Noise in the Time Domain Shows a Gaussian Distribution

• Pink (1/f Noise) – A noise signal with a power spectral density that is inversely 
proportional to the frequency. Each octave contains an equal amount of noise power.

Figure 28 shows a pink noise signal (from 0 Hz to 10 kHz) in the time domain.
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Figure 28: Pink Noise Signal

Figure 29 shows a histogram of the pink noise in the time domain. 
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Figure 29: Histogram of Pink Noise in the Time Domain

Output Mode

You can choose one of the following output modes for noise waveforms:

• Continuous – In continuous mode, the waveform is output repetitively until acquisition 
stops if the Start/Stop method is With Acquisition or until you stop it with the Stop 
button.

• Burst – In burst mode, the waveform is output for a specified amount of time. If the 
Repeat Burst checkbox is unchecked, the waveform is output once. If the Repeat Burst 
checkbox is checked, the burst waveform is output repetitively.

You specify how long the signal is on by specifying the Burst On Time. You specify how 
long the signal is off (signal is at 0 V) by specifying the Burst Off Time.

If you are using the Data Logger interface and the Lock to acquisition time checkbox is 
checked, the waveform is output in the time that it takes to acquire the data (specified in 
the Recording tab). 

If you are using the FFT Analyzer interface and the Lock to acquisition time checkbox is 
checked, the waveform is output in the time that it takes to do all the averages (an 
acquisition of all the records specified in the Recording tab). 

If you are using the FFT Analyzer interface and the Lock to analysis frame time checkbox 
is checked, the waveform is output in the time that it takes to do one average (an 
acquisition of one record). This option is useful in applications where repeatability is 
required, such as outputting a repeatable chirp signal.
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Notes: If you are using the FFT Analyzer interface, the Lock to acquisition time checkbox 
is checked, and the Start Method on the Output tab is With Acquisition, the analog input 
trigger source should be Freerun or you will be prompted to change it to this setting. This 
is to guarantee that the analog output data is correlated properly with the analog input 
data for each record when many averages are performed.

If the Lock to analysis frame time checkbox is checked and the Start Method on the 
Output tab is With Acquisition, the analog input trigger source should be Software 
Triggered or you will be prompted to change it to this setting. This is to guarantee that the 
analog output data is correlated properly with the analog input data for each record when 
many averages are performed.

If you make any changes to the parameters on the Recording tab, Acquisition tab, or Freq tab, 
the values are automatically updated on the Output tab.

Ramp Up Time and Ramp Down Time

If desired, you can determine how long it takes for the signal to ramp up at the start of the 
waveform to the specified peak voltage by specifying the Ramp Up Time.

If the output mode is Burst, you can also specify how long it takes for the signal to ramp down 
to 0 V at the end of the waveform by specifying the Ramp Down Time. 

Output Frequency

If you check the Lock to analysis freq checkbox, the maximum frequency of the noise 
waveform is locked to the maximum frequency to analyze (specified in the Acquisition tab 
for the Data Logger interface or the Freq tab for the FFT Analyzer interface).

If the Lock to analysis freq checkbox is unchecked, you can specify the starting frequency 
component and the ending frequency component in the generated signal.

Repeat Method

You can choose one of the following repeat methods for noise waveforms:

• True Random – Generates a new noise signal of the specified waveform pattern (Random, 
Random Normal, or Pink) for each burst period.

A true random signal is always nonperiodic during the total acquisition time. Therefore, a 
time domain window, such as a Hanning window, must be used with this repeat mode to 
minimize leakage.

• Pseudo Random – Repeats the last output signal for the specified noise waveform type 
(Random, Random Normal, or Pink).

A pseudo random signal does not excite nonlinearities differently between spectrum 
averages; therefore, spectrum averaging will not remove nonlinearities from FRF 
measurements.

However, the excitation signal is completely contained in the total acquisition time, and is 
therefore, periodic during the total acquisition time and without leakage. 
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Start/Stop Methods

To start the waveform generation operation, you can choose one of the following options:

• With Acquisition – Choose this option if you want the device to output the specified 
waveform when acquisition starts.

Note: If you choose With Acquisition and the analog output channel is enabled, ensure 
that you select an analog input trigger source other than a threshold trigger, or you will be 
prompted to change the analog input trigger source.

If you are using the FFT Analyzer interface and you choose With Acquisition when the 
Lock to acquisition time checkbox is selected, the analog input trigger source should be 
Freerun or you will be prompted to change it to this setting. This is to guarantee that the 
analog output data is correlated properly with the analog input data for each record when 
many averages are performed.

If you are using the FFT Analyzer interface and you choose With Acquisition when the 
Lock to analysis frame time checkbox is checked, the analog input trigger source should 
be Software Triggered or you will be prompted to change it to this setting. This is to 
guarantee that the analog output data is correlated properly with the analog input data 
for each record when many averages are performed.

• Manual – Choose this option if you want the device to output the specified waveform 
when one of the following trigger conditions is detected:

− Software – The operation starts immediately when the Start button  on the 
Output tab is clicked.

− Ext TTL Pos Edge – After the Start button  on the Output tab is clicked, the 
operation starts when the device detects a positive edge on the external digital trigger 
line.

You can stop the waveform output operation by stopping acquisition or by clicking the Stop 
button  on the Output tab. When the waveform is stopped, the specified offset value 
is output.
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Muting and Unmuting the Output Signal

If your device supports it, you can mute the output in hardware by clicking the Unmute 
button . This forces the output to 0 V, as shown in Figure 30.

Note: The number of samples it takes for the mute process to complete is hardware 
dependent. Refer to the user’s manual for your device for more information.

Figure 30: Muting the Output Signal

Note: Mute is also activated if you click the Stop button on the main interface or on the 
Output tab, causing the analog output operation to stop.

To unmute the output, click the Mute button . The output pattern that you selected 
resumes at the current level, as shown in Figure 31.
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Figure 31: Unmuting the Output Signal
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Configuring Digital Filters

Notes: To configure digital filters, you must have purchased the FFT Analysis Option or the 
Advanced FFT Analysis Option of QuickDAQ.

Choose the Digital Filter Configuration toolbar button (  ) or the Digital Filter 
Configuration option from the Configuration menu to configure IIR (infinite impulse 
response) filters for the analog input channels. The Digital Filter Configuration dialog 
appears. Figure 32 shows an example of the Digital Filter Configuration dialog.

Figure 32: Digital Filter Configuration Dialog
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Note: The settings used by the Digital Filter Configuration dialog depend on the sampling 
or analysis frequency. Therefore, it is recommended that you set up the sampling/analysis 
frequency before using the Digital Filter Configuration dialog.

If you later change the sampling/analysis frequency, the application may notify you that one 
or more filters have been invalidated. If this occurs, it is recommended that you change your 
filter settings based on the new sampling/analysis frequency.

If you are using the Data Logger interface, refer to page 125 for more information on setting 
the sampling frequency. If you are using the FFT Analyzer interface, refer to page 128 for 
more information on setting the analysis frequency.

Channels and Filter Status Indicators

All the analog input channels that are supported by your device, whether they are enabled or 
not in the Configure Devices dialog, are shown in the Digital Filter Configuration dialog.

By default, the status indicator for each channel is shown as Stable .

As you choose various filter settings for the channel (before you click the Apply button), the 
indicator changes to In Process .

Once you apply the changes, the status indicator either indicates that the filter is Stable , or 
Unstable .

A stable filter assures that every limited input signal produces a limited filter response. An 
unstable filter cannot be qualified, and in some situations may prove useless or even harmful. 
Therefore, it is important that you choose the settings for your filters carefully to avoid 
instability.

Filter Types

You can select one of the following filter types to apply to each analog input channel:

• None – No digital filter.

• Bessel – A linear filter with a maximally flat group delay (maximally linear phase 
response). Bessel filters are often used in audio applications. Bessel filters are 
characterized by almost constant group delay across the entire passband, thus preserving 
the wave shape of filtered signals in the passband.

• Butterworth – A maximally flat magnitude filter, with no ripples in the passband or 
stopband.

• Chebyshev – This filter type minimizes the error between the idealized and the actual 
filter characteristic over the range of the filter, but with ripples in the passband. It has a 
steeper roll-off and more passband ripple or stopband ripple than Butterworth filters. 
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If you want to set the same filter type for all channels at once, select the Multi-channel 
Actions button (  ), choose Set all Filter Types, and select the filter type (None, 
Bessel, Butterworth, or Chebyshev) that you want to use.

Filter Category and Cutoff Frequency

You can further refine the type of filter to apply by selecting one of the following filter 
categories:

• LowPass – A low-pass filter is used to eliminate unwanted high-frequency signals by 
passing low-frequency signals and attenuating (reducing the amplitude of) signals with 
frequencies higher than the cutoff frequency. The actual amount of attenuation for each 
frequency varies depending on the specific filter type. 

When you select LowPass, enter the cutoff frequency above which signals will be 
attenuated.

• HighPass – A high-pass filter is used to eliminate any unwanted low frequency 
components by passing high-frequency signals and attenuating signals with frequencies 
lower than the cutoff frequency. The actual amount of attenuation for each frequency 
varies depending on the specific filter type.

When you select HighPass, enter the cutoff frequency below which signals will be 
attenuated.

• BandPass – A band-pass filter is a combination of a low-pass and a high-pass filter. It 
passes frequencies within a certain range and rejects (attenuates) frequencies outside of 
that range.

When you select BandPass, enter the cutoff frequency below which (Cutoff Freq 1) and 
above which (Cutoff Freq 2) signals will be attenuated.

• BandStop – A band-stop filter passes most frequencies unaltered, but attenuates those in 
a specific range to very low levels. It is the opposite of a band-pass filter. A very narrow 
band-stop filter is known as a notch filter.

When you select BandStop, enter the cutoff frequency below which (Cutoff Freq 1) and 
above which (Cutoff Freq 2) signals will be attenuated. 

If you want to set the same filter category for all channels at once, select the Multi-channel 
Actions button (  ), choose Set all Filter Categories, and select the filter 
category (LowPass, HighPass, BandPass, or BandStop) that you want to use.

Filter Order

The filter order (also known as the number of poles) determines the rejection characteristics of 
the filter. The greater the filter order, the greater the rejection, yielding a steeper rolloff. You 
can select a number from 1 to 10 for the filter order.

If you want to set the filter order for all channels at once, select the Multi-channel Actions 
button (  ), choose Set all Filter Orders, and select the filter order (1 to 10) that 
you want to use.



Configuring Channels, Acquisition Settings, and Digital Filters
dB Ripple

For Chebyshev filters, specify the ripple, in dB, that you want in the passband.

Frequency Response Graph

The frequency response graph shows the output of the specified filter as a function of 
frequency. When you select a channel, you can see the frequency response graph based on the 
specified filter settings, where dB is plotted on the y-axis and frequency is plotted on the 
x-axis.

Using your mouse, you can use the left-click button to move along the frequency response 
graph to see the frequency and dB values.

Impulse Response Graph

The impulse response graph shows the reaction of the specified filter as a function of time. 
When you select a channel, you can see the impulse response graph based on the specified 
filter settings, where voltage is plotted on the y-axis and time, in seconds, is plotted on the 
x-axis.
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Using your mouse, you can use the left-click button to move along the impulse response 
graph to see the time and voltage values.

Step Response Graph

The step response graph shows the time behavior of the filter when its inputs change from 
zero to one in a very short time. When you select a channel, you can see the step response 
graph based on the specified filter settings, where voltage is plotted on the y-axis and time, in 
seconds, is plotted on the x-axis.

Using your mouse, you can use the left-click button to move along the step response graph to 
see the time and voltage values.
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Introduction
This chapter describes how to configure the display when using the Data Logger interface. If 
you are using the FFT Analyzer interface, refer to Chapter 6 starting on page 189.



Configuring the Display of the Data Logger Interface
Configuring the Appearance of the Channel Plot 
Window

This section describes the following aspects related to the appearance of the Channel Plot 
window when using the Data Logger interface:

• Displaying channels in the Channel Plot window, described on this page

• Displaying data cursors in the Channel Plot window, described on page 171

• Specifying the columns of the Channel Plot window, described on page 172

• Grouping signals in bands on the Channel Plot window, described on page 174

• Specifying the trace color on the Channel Plot window, described on page 176

• Controlling how data is plotted the Channel Plot window, described on page 177

• Specifying the style of the plots in the Channel Plot window, described on page 179

Displaying Channels in the Channel Plot Window

You can determine which channels are displayed in the Channel Plot window by using the 
following controls in the Plot and Data Config window:

You can see the names of all enabled channels under the Channel Name column in the Plot 
and Data Config window. Only data from the list of enabled channels is acquired. 

Channel Name
Column

Visible Column 
for Channel Plot 

Window

Hide/show columns

Multi-channel Actions
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Note: If desired, you can change the name of a channel using the Input Channel 
Configuration menu option, described on page 84.

For each enabled channel listed under the Channel Name column, you can control which 
channels are displayed in the Channel Plot window using the Visible Plot checkbox. If a box 
is checked under the Visible Plot column, a plot for the associated channel is displayed in the 
Channel Plot window. If a box under the Visible Plot column is unchecked, the plot for the 
associated channel is not displayed in the Channel Plot window. 

Note: Data for all enabled channels is recorded regardless of whether the channel is visible.

Making All Selected Channels Visible or Hidden in the Channel Plot Window 
at Once

If you want to make all selected channels visible in the Channel Plot window at once, select 
the Multi-channel Actions button (  ), and choose Selected channels visible 
in Channel Plot.  

If you want to hide all selected channels in the Channel Plot window at once, select the 
Multi-channel Actions button (  ), and choose Selected channels hidden in 
Channel Plot. 

Showing or Hiding the Visible Plot Column

If you wish, you can change whether the Visible Plot column is shown or hidden by selecting 
the Hide/show columns (  ) button, and selecting Visible Plot. A checkmark means the 
column is shown; no checkmark means the column is hidden.

Moving the Visible Plot Column

If you wish, you can move the position of the Visible Plot column by clicking the left-mouse 
button to select it, dragging it to the right or left, and letting go of the left-mouse button.
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Displaying Data Cursors in the Channel Plot Window

You can determine whether data cursors are displayed in the Channel Plot window by using 
the following controls in the Plot and Data Config window:

For each of the enabled channels, you can choose to display a data cursor in the Channel Plot 
window using the Show Cursor column in the Plot and Data Config window. 

If a box is checked under the Show Cursor column, a data cursor for the associated channel is 
displayed in the Channel Plot window. If a box under the Show Cursor column is unchecked, 
a data cursor for the associated channel is not displayed in the Channel Plot window.

You can enable the capability of moving the data cursor using the data-cursor control (  ), 
described on page 74. Various options are available for changing the cursor style, line style, 
and cursor color. 

Making All Selected Data Cursors Visible or Hidden at Once

If you want to make all selected data cursors visible in the Channel Plot window at once, 
select the Multi-channel Actions button (  ), and choose Selected data cursors 
visible.

If you want to hide all selected data cursors in the Channel Plot window at once, select the 
Multi-channel Actions button (  ), and choose Selected data cursors hidden. 

Hide/show columns

Multi-channel Actions

Show Cursor
Column
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Showing or Hiding the Show Cursor Column

If you wish, you can change whether the Show Cursor column is shown or hidden by 
selecting the Hide/show columns (  ) button, and selecting Show Cursor. A checkmark 
means the column is shown; no checkmark means the column is hidden.

Moving the Show Cursor Column

If you wish, you can move the position of the Show Cursor column by clicking the left-mouse 
button to select it, dragging it to the right or left, and letting go of the left-mouse button.

Specifying the Columns of the Channel Plot Window

You can determine how many columns are displayed in the Channel Plot window by using 
the following controls in the Plot and Data Config window:

You can specify up to six columns to view in the Channel Plot window. 

Under Plot Column, select the column (1 to 6) in which to display the selected channel. The 
following example shows a display of two plot columns, where the thermocouple channels 
are displayed in column 1 and voltage channels are displayed in column 2:
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Changing the Plot Column for All Selected Channels at Once

If you want to change the plot column for all selected channels at once, do the following:

1. Highlight the channels in the Plot and Data Config window that you want to change.

2. Select the Multi-channel Actions button (  ).

3. Choose Selected channels Plot Column.

4. Enter the number of plot columns to use.
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Showing or Hiding the Plot Column

If you wish, you can change whether the Plot Column is shown or hidden by selecting the 
Hide/show columns (  ) button, and selecting Plot Column. A checkmark means the 
column is shown; no checkmark means the column is hidden.

Moving the Plot Column

If you wish, you can move the position of the Plot Column by clicking the left-mouse button 
to select it, dragging it to the right or left, and letting go of the left-mouse button.

Grouping Signals in Bands on the Channel Plot Window

You can group signals in bands in the Channel Plot window by using the following controls in 
the Plot and Data Config window:

You can choose to display multiple signals in the same band by assigning the same Signal 
Group letter to them. You can specify a value of A through T for the Signal Group. 

For example, to see the data from analog input signals 1 and 2 in the same band, you could set 
the Signal Group for both channels to A.

If two analog input channels have a different plot data type (for example, one is temperature 
and the other is voltage), two Y-axes are displayed for the band, as shown in the following 
example:
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Changing the Signal Group for All Selected Channels at Once

If you want to change the value of the signal group for all selected channels at once, do the 
following:

1. Highlight the channels in the Plot and Data Config window that you want to change.

2. Select the Multi-channel Actions button (  ).

3. Choose Selected channels Signal Group.

4. Enter the value of the signal band to use.

Showing or Hiding the Signal Group Column

If you wish, you can change whether the Signal Group column is shown or hidden by 
selecting the Hide/show columns (  ) button, and selecting Signal Group. A checkmark 
means the column is shown; no checkmark means the column is hidden.

Moving the Signal Group Column

If you wish, you can move the position of the Signal Group column by clicking the left-mouse 
button to select it, dragging it to the right or left, and letting go of the left-mouse button.
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Specifying the Trace Color on the Channel Plot Window

You can specify the color of the trace on the Channel Plot window by using the following 
controls in the Plot and Data Config window:

For each channel, select the Color column, and then select the color that you want to display 
for the trace in the Channel Plot window.  

Showing or Hiding the Color Column

If you wish, you can change whether the Color column is shown or hidden by selecting the 
Hide/show columns (  ) button, and selecting Color. A checkmark means the column is 
shown; no checkmark means the column is hidden.

Moving the Color Column

If you wish, you can move the position of the Color column by clicking the left-mouse button 
to select it, dragging it to the right or left, and letting go of the left-mouse button.
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Column

Hide/show columns



Configuring the Display of the Data Logger Interface
Controlling How Data is Plotted in the Channel Plot Window

Using the Channel Plot Control tab in the Plot and Data Config window, you can control how 
data is plotted in the Channel Plot window. 

You can configure the following settings:

• Plot update rate, – Enter a value between 1 and 50 to indicate how often you want the 
display to be refreshed per second.

• Smooth scrolling – You can adjust how the plot scrolls to the left using the Smooth 
scrolling checkbox. If Smooth scrolling is checked, the plot attempts to scroll after each 
data point is added. However, scrolling is limited by the actual update rate. For example, 
if the Plot update rate is set to 50, and 100 points are added per second (determined by the 
Recording settings), the plot scrolls to the left by 2 samples, 50 times per second.

If the Smooth scrolling checkbox is unchecked, the plot does not attempt to scroll after 
every point is added; instead, it scrolls after each buffer is plotted. The buffer size is set to 
the FFT size.

• Disable plotting during acquisition – This checkbox is provided for fast data acquisition 
boards, such as the DT9832, which acquire data faster than the application can display it. 

If the Disable plotting during acquisition checkbox is checked, no data is displayed in 
the Channel Plot window during acquisition. When acquisition is finished, the data is 
displayed in the Channel Plot window. 

If the Disable plotting during acquisition checkbox is unchecked, the data is displayed in 
the Channel Plot window as the data is acquired.
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• Under Time domain X axis units, select the units for the x-axis as one of the following:

− Sample number – The units for the x-axis are represented as the number of samples (0 
to the maximum number of samples acquired).

− Relative time – The units for the x-axis are represented as the recording time from 0 to 
the total recording time.

− Absolute time – The units for the x-axis are represented as the actual time of 
acquisition based on the system clock. If you select absolute time, you can select 
whether to represent the time in 24-hour (military) format or 12-hour format.

• Display Day – If Absolute Time is selected and you check the Display Day checkbox, the 
x-axis shows dd:hh:mm:ss, where dd is the day of the month, hh is hours, mm is minutes, 
and ss is seconds. If Relative Time is selected, the value for day starts at 0 and increments 
by one for each subsequent day. You can also set the value for day in the x-axis options if 
the Display Day checkbox is selected.

Note: You can change the resolution or precision of the x-axis, as described on page 69.

• Use the Plot height slider bar, to determine the relative height of each plot in the Channel 
Plot window. Slide the control to the right to increase the height; slide the control to the 
left to decrease the height. Note that the entire screen is always filled, so, typically, this 
setting is useful when you want to view many plots at once.
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Specifying the Style of the Plots in the Channel Plot Window

The Channel Plot Style tab allows you to specify the style of the plots that are displayed in the 
Channel Plot window.

You can configure the following settings:

• Use the Background Color box to choose a different color for the background of the 
Channel Plot window.

• Use the Axis color box to choose a different color for the axes of the Channel Plot window.

• Use the Grid line color box to choose a different color for the grid lines of the Channel 
Plot window.

• In the Trace thickness box, enter the value between 1 and 5 to set the thickness of the line 
used by the trace on the Channel Plot window, where 1 is the thinnest line and 5 is the 
thickest line.

• Under Plot Header, click the Visible checkbox if you want a header displayed for the data 
on the plot, and then enter the text for the header. By default, the header is called Test Data. 
You can also select the color for the header and the font in which to display the header.

• Under X-Axis Label, you can select the color for the label of the x-axis and the font in 
which to display the x-axis label.

• Under Y-Axis Label, you can select the color for the label of the y-axis and the font in 
which to display the y-axis label.
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Configuring the Appearance of the Channel Display 
Window

This section describes the how to configure the appearance of the Channel Display window, 
when using the Data Logger interface, and includes the following topics:

• Displaying channels in the Channel Display window, described on this page

• Controlling how data is displayed in the Channel Display window, described on page 182

• Specifying the style of the Channel Display window, described on page 184

Displaying Channels in the Channel Display Window

You can determine which channels are displayed in the Channel Display window by using the 
following controls in the Plot and Data Config window:

You can see the names of all enabled channels under the Channel Name column in the Plot 
and Data Config window. Only data from the list of enabled channels is acquired. 

Note: If desired, you can change the name of a channel using the Input Channel 
Configuration menu option, described on page 84.
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For each enabled channel, you can control which channels are displayed in the Channel 
Display window using the Visible Display checkbox. If a box is checked under the Visible 
Display column, the data for the associated channel is displayed in the Channel Display 
window. If a box under the Visible Display column is unchecked, the data for the associated 
channel is not displayed in the Channel Display window. 

Note: Data for all enabled channels is recorded regardless of whether the channel is visible.

Making All Selected Channels Visible or Hidden in the Channel Display 
Window at Once

If you want to make all selected channels visible in the Channel Display window at once, 
select the Multi-channel Actions button (  ), and choose Selected channels 
visible in Channel Display.  

If you want to hide all selected channels in the Channel Display window at once, select the 
Multi-channel Actions button (  ), and choose Selected channels hidden in 
Channel Display. 

Showing or Hiding the Visible Display Column

If you wish, you can change whether the Visible Display column is shown or hidden by 
selecting the Hide/show columns (  ) button, and selecting Visible Display. A checkmark 
means the column is shown; no checkmark means the column is hidden.

Moving the Visible Display Column

If you wish, you can move the position of the Visible Display column by clicking the 
left-mouse button to select it, dragging it to the right or left, and letting go of the left-mouse 
button.
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Controlling How Data is Displayed in the Channel Display Window

Using the Channel Display - Control tab in the Plot and Data Config window, you can control 
how data is displayed in the Channel Display window. 

You can configure the following settings:

• Hide Unused Channels – By default, the Channel Display window resembles the front 
panel of the device and shows up to 48 channels. However, if you want your display to 
show only the enabled channels rather than all the channels, check the Hide Unused 
Channels box. The following example illustrates how the display looks when three 
channels are enabled and the Hide Unused Channels box is checked.

• Precision – You can select the number of significant digits after the decimal point to 
display; values range from 1 to 8 (2 is the default).
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• Columns – You can specify how many columns to use when displaying the channels; 
values range from 1 to 16 (8 is the default). For example, by choosing 1, shown below, you 
can display each channel, one on top of the other (note that the lowest numbered channel 
is always at the bottom of the display and the highest numbered channel is at the top of 
the display):

• Display Update Rate – You can choose how fast you want the display of the Channel 
Display window to be updated. Slide the bar to the left for faster update rates, or slide the 
bar to the right for slower update rates.

• Data Reduction Method – You can choose which value to display in the Channel Display 
window:

− First Value – The first value in the most recent buffer is displayed for each channel.

− Average – The average value in the most recent buffer is displayed for each channel.

− Min – The minimum value in the most recent buffer is displayed for each channel.

− Max – The maximum value in the most recent buffer is displayed for each channel.
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Specifying the Style of the Channel Display Window

Using the Channel Display Style tab, you can specify the style of the Channel Display 
window.

You can configure the following parameters:

• Background color – Allows you to choose a specific color for the background of the 
Channel Display window. You can select from a number of predefined colors or you can 
define your own color for the background.

• Foreground color – Allows you to choose a specific color for the foreground of the 
Channel Display window. You can select from a number of predefined colors or you can 
define your own color for the foreground.

• Label color – Allows you to choose a specific color for the label used on the Channel 
Display window. You can select from a number of predefined colors or you can define 
your own color for the label.
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• Indicator style – Allows you to specify how the numbers and letters that represent the 
data appear. The following choices are available:

− 7 Segment – The numbers and letters that represent the data are composed of 
7-segment lines.

− 16 Segment – The numbers and letters that represent the data are composed of 
16-segment lines.

− Mechanical – The numbers and letters that represent the data appear to be formed by a 
contiguous line.
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Configuring the Appearance of the Statistics Window
You can determine whether statistics are displayed in the Statistics window by using the 
following controls in the Plot and Data Config window:

For each enabled channel listed under the Channel Name column, you can control whether 
statistics are displayed in the Statistics window using the Visible Statistics checkbox. If a box 
is checked under the Visible Statistics column, the statistics for the associated channel are 
listed in the Statistics window. If a box under the Visible Statistics column is unchecked, the 
statistics for the associated channel are not displayed in the Statistics window. 

Making Statistics for All Selected Channels Visible or Hidden in the 
Statistics Window at Once

If you want to make statistics for all selected channels visible in the Statistics window at once, 
select the Multi-channel Actions button (  ), and choose Selected channels 
visible in Statistics Display.  

If you want to hide statistics for all selected channels in the Statistics window at once, select 
the Multi-channel Actions button (  ), and choose Selected channels hidden 
in Statistics Display. 
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Showing or Hiding the Visible Statistics Column

If you wish, you can change whether the Visible Statistics column is shown or hidden by 
selecting the Hide/show columns (  ) button, and selecting Visible Statistics. A 
checkmark means the column is shown; no checkmark means the column is hidden.

Moving the Visible Statistics Column

If you wish, you can move the position of the Visible Statistics column by clicking the 
left-mouse button to select it, dragging it to the right or left, and letting go of the left-mouse 
button.
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Introduction
This chapter describes how to configure the display when using the FFT Analyzer interface. If 
you are using the Data Logger interface, refer to Chapter 5 starting on page 167.
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Configuring the Appearance of the Channel Plot 
Window

This section describes the following aspects related to the appearance of the Channel Plot 
window when using the FFT Analyzer interface:

• Displaying channels in the Channel Plot window, described on this page

• Displaying data cursors in the Channel Plot window, described on page 193

• Specifying the columns of the Channel Plot window, described on page 194

• Grouping signals in bands on the Channel Plot window, described on page 196

• Specifying the trace color on the Channel Plot window, described on page 198

• Controlling how data is plotted the Channel Plot window, described on page 199

• Controlling the style of the plots in the Channel Plot window, described on page 200

Displaying Channels in the Channel Plot Window

You can determine which channels are displayed in the Channel Plot window by using the 
following controls in the Plot and Data Config window:

You can see the names of all enabled channels under the Channel Name column in the Plot 
and Data Config window. Only data from the list of enabled channels is acquired. 
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Note: If desired, you can change the name of a channel using the Input Channel 
Configuration menu option or toolbar button, described on page 88.

For each enabled channel listed under the Channel Name column, you can control which 
channels are displayed in the Channel Plot window using the Visible Plot checkbox. If a box 
is checked under the Visible Plot column, a plot for the associated channel is displayed in the 
Channel Plot window. If a box under the Visible Plot column is unchecked, the plot for the 
associated channel is not displayed in the Channel Plot window. 

Note: Data for all enabled channels is recorded regardless of whether the channel is visible.

Making All Selected Channels Visible or Hidden in the Channel Plot Window 
at Once

If you want to make all selected channels visible in the Channel Plot window at once, select 
the Multi-channel Actions button (  ), and choose Selected channels visible in 
Channel Plot. 

If you want to hide all selected channels in the Channel Plot window at once, select the 
Multi-channel Actions button (  ), and choose Selected channels hidden in 
Channel Plot. 

Showing or Hiding the Visible Plot Column

If you wish, you can change whether the Visible Plot column is shown or hidden by selecting 
the Hide/show columns (  ) button, and selecting Visible Plot. A checkmark means the 
column is shown; no checkmark means the column is hidden.

Moving the Visible Plot Column

If you wish, you can move the position of the Visible Plot column by clicking the left-mouse 
button to select it, dragging it to the right or left, and letting go of the left-mouse button.
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Displaying Data Cursors in the Channel Plot Window

You can determine whether data cursors are displayed in the Channel Plot window by using 
the following controls in the Plot and Data Config window:

For each of the enabled channels, you can choose to display a data cursor in the Channel Plot 
window using the Show Cursor column in the Plot and Data Config window. 

If a box is checked under the Show Cursor column, a data cursor for the associated channel is 
displayed in the Channel Plot window. If a box under the Show Cursor column is unchecked, 
a data cursor for the associated channel is not displayed in the Channel Plot window.

You can enable the capability of moving the data cursor using the data-cursor control (  ), 
described on page 74. Various options are available for changing the cursor style, line style, 
and cursor color. 

Making All Selected Data Cursors Visible or Hidden at Once

If you want to make all selected data cursors visible in the Channel Plot window at once, 
select the Multi-channel Actions button (  ), and choose Selected data cursors 
visible.

If you want to hide all selected data cursors in the Channel Plot window at once, select the 
Multi-channel Actions button (  ), and choose Selected data cursors hidden. 
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Showing or Hiding the Show Cursor Column

If you wish, you can change whether the Show Cursor column is shown or hidden by 
selecting the Hide/show columns (  ) button, and selecting Show Cursor. A checkmark 
means the column is shown; no checkmark means the column is hidden.

Moving the Show Cursor Column

If you wish, you can move the position of the Show Cursor column by clicking the left-mouse 
button to select it, dragging it to the right or left, and letting go of the left-mouse button.

Specifying the Plot Columns of the Channel Plot Window

You can determine how many columns are displayed in the Channel Plot window by using 
the following controls in the Plot and Data Config window:

You can specify up to six columns to view in the Channel Plot window. 

Under Plot Column, select the column (1 to 6) in which to display the selected channel. The 
following example shows a display of two plot columns, where the time domain channels are 
displayed in column 1 and the FFT channels are displayed in column 2:   
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Changing the Plot Column for All Selected Channels at Once

If you want to change the plot column for all selected channels at once, do the following:

1. Highlight the channels in the Plot and Data Config window that you want to change.

2. Select the Multi-channel Actions button (  ).

3. Choose Selected channels Plot Column.

4. Enter the number of the plot column to use.

Showing or Hiding the Plot Column

If you wish, you can change whether the Plot Column is shown or hidden by selecting the 
Hide/show columns (  ) button, and selecting Plot Column. A checkmark means the 
column is shown; no checkmark means the column is hidden.

Moving the Plot Column

If you wish, you can move the position of the Plot Column by clicking the left-mouse button 
to select it, dragging it to the right or left, and letting go of the left-mouse button.
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Grouping Signals in Bands on the Channel Plot Window

You can group signals in bands in the Channel Plot window by using the following controls in 
the Plot and Data Config window:

You can choose to display multiple signals in the same band by assigning the same Signal 
Group letter to them. You can specify a value of A through T for the Signal Group. 

For example, to see the data from analog input signals 1 and 2 (in the time domain) in the 
same band, you could set the Signal Group for both channels to A.

If two analog input channels have a different plot data type (for example, one is voltage and 
the other is a sensor), two Y-axes are displayed for the band, as shown in the following 
example:
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Likewise, if two FFT channels have different parameters, two y-axis are displayed for the 
band.

Note that the Signal Group letter is shown in the legend beneath the x-axis.

Changing the Signal Group for All Selected Channels at Once

If you want to change the value of the signal group for all selected channels at once, do the 
following:

1. Highlight the channels in the Plot and Data Config window that you want to change.

2. Select the Multi-channel Actions button (  ).

3. Choose Selected channels Signal Group.

4. Enter the value of the signal band to use.

Showing or Hiding the Signal Group Column

If you wish, you can change whether the Signal Group column is shown or hidden by 
selecting the Hide/show columns (  ) button, and selecting Signal Group. A checkmark 
means the column is shown; no checkmark means the column is hidden.
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Moving the Signal Group Column

If you wish, you can move the position of the Signal Group column by clicking the left-mouse 
button to select it, dragging it to the right or left, and letting go of the left-mouse button.

Specifying the Trace Color on the Channel Plot Window

You can specify the color of the trace on the Channel Plot window by using the following 
controls in the Plot and Data Config window:

For each channel, select the Color column, and then select the color that you want to display 
for the trace in the Channel Plot window.  

Showing or Hiding the Color Column

If you wish, you can change whether the Color column is shown or hidden by selecting the 
Hide/show columns (  ) button, and selecting Color. A checkmark means the column is 
shown; no checkmark means the column is hidden.

Moving the Color Column

If you wish, you can move the position of the Color column by clicking the left-mouse button 
to select it, dragging it to the right or left, and letting go of the left-mouse button.
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Controlling How Data is Plotted in the Channel Plot Window

Using the Channel Plot Control tab in the Plot and Data Config window, you can control how 
data is plotted in the Channel Plot window. 

You can configure the following settings:

• Plot update rate, – Enter a value between 1 and 50 to indicate how often you want the 
display to be refreshed per second.

• Smooth scrolling – You can adjust how the plot scrolls to the left using the Smooth 
scrolling checkbox. If Smooth scrolling is checked, the plot attempts to scroll after each 
data point is added. However, scrolling is limited by the actual update rate. For example, 
if the Plot update rate is set to 50, and 100 points are added per second (determined by the 
Recording settings), the plot scrolls to the left by 2 samples, 50 times per second.

If the Smooth scrolling checkbox is unchecked, the plot does not attempt to scroll after 
every point is added; instead, it scrolls after each buffer is plotted. The buffer size is set to 
the FFT size.

• Disable plotting during acquisition, – You can determine whether the Channel Plot 
display updates during acquisition using the Disable plotting during acquisition 
checkbox. When checked, the Channel Plot display is updated only after acquisition has 
stopped. When unchecked, the Channel Plot display during acquisition.

• Under Time domain X axis units, select the units for the x-axis as either the number of 
samples (0 to the maximum number of samples acquired) or the relative time (0 to the 
total recording time).
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• Use the Plot height slider bar, to determine the relative height of each plot in the view. 
Slide the control to the right to increase the height; slide the control to the left to decrease 
the height. Note that the entire screen is always filled, so, typically, this setting is useful 
when you want to view many plots at once.

Specifying the Style of the Plots in the Channel Plot Window

The Channel Plot Style tab allows you to specify the style of the plots that are displayed in the 
Channel Plot window.

You can configure the following settings:

• Use the Background Color box to choose a different color for the background of the 
Channel Plot window.

• Use the Axis color box to choose a different color for the axes of the Channel Plot window.

• Use the Grid line color box to choose a different color for the grid lines of the Channel 
Plot window.

• In the Trace thickness box, enter the value between 1 and 5 to set the thickness of the line 
used by the trace on the Channel Plot window, where 1 is the thinnest line and 5 is the 
thickest line.

• Under Plot Header, click the Visible checkbox if you want a header displayed for the data 
on the plot, and then enter the text for the header. By default, the header is called Test Data. 
You can also select the color for the header and the font in which to display the header.
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• Under X-Axis Label, you can select the color for the label of the x-axis and the font in 
which to display the x-axis label.

• Under Y-Axis Label, you can select the color for the label of the y-axis and the font in 
which to display the y-axis label.
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Adding Channels to the Plot and Data Config Window
If you are using the FFT Analyzer interface, buttons are provided under the channel selection 
area of the Plot and Data Config window to add channels to the Plot and Data Config window.

If you are using the FFT Analysis option of QuickDAQ, you can add a single FFT channel, a 
windowed time domain channel, or a time domain channel to the Plot and Data Config 
window, as shown in Figure 33.

Figure 33: Buttons for Adding Channels in the FFT Analysis Option

If you are using the Advanced FFT Analysis option of QuickDAQ, you can add a single FFT 
channel, a two-channel FFT function, a windowed time domain channel, or a time domain 
channel to the Plot and Data Config window, as shown in Figure 34.

dd a single channel FFT function

Add a windowed time domain 
function

Add a time domain function
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Figure 34: Buttons for Adding Channels in the Advanced FFT Analysis Option

The following subsections describe how to add channel to the Plot and Data Config window.

Adding a Single Channel FFT Function to the Channel List

If you want to add a single channel FFT function to the list of channels shown under Channel 
Name, click the Add single channel FFT function (  ) button. Then, choose the analog 
input channel for which to generate the FFT.

Refer to page 207 for information on configuring the FFT channel once it is added.

dd a single channel FFT function

Add a 2 channel FFT function

Add a windowed time domain function

Add a time domain function
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Adding a Two-Channel FFT Function to the Channel List

If you are using the Advanced FFT Analysis option of QuickDAQ, you can add two-channel 
FFT functions to the channel list. Two-channel FFT functions are particularly useful when you 
want to apply a stimulus to a device and compare the response of the device to a known 
signal. 

Before you can add a two-channel FFT function, you must configure one analog input channel 
as a response channel (the channel to which the stimulus is applied), and another analog input 
channel as the reference channel (the channel to which the response channel is compared). 
Refer to page 84 for more information about configuring channels.

To add a two-channel FFT function to the list of channels shown under Channel Name, click 
the Add 2 channel FFT function (  ) button. The following options are available:

• FRF – Choose this option to add a frequency response function (FRF) channel. A FRF 
channel represents the complex ratio between the output (response) signal and the input 
(reference) signal as a function of frequency. 

When you select FRF, you must choose an enabled response channel to compare to the 
reference channel; the resultant FRF channel is created and listed in the channel list.

Refer to page 213 for information on configuring a FRF channel once you have added it.

• Cross Spectrum – Choose this option if you want to add a Cross Spectrum channel. A 
cross spectrum channel contains a building block that is used in FRF and other more 
advanced functions. 

When you select Cross Spectrum, you must choose an enabled response channel to 
compare to the reference channel; the resultant Cross Spectrum channel is created and 
listed in the channel list.

Refer to page 218 for information on configuring a Cross Spectrum channel once you have 
added it.

• Coherence – Choose this option if you want to add a coherence channel. A Coherence 
function evaluates the linearity between the input (reference) signal and the output 
(response) signal at each frequency, and generates a value between 0.0 and 1.0, where 0 is 
consistently not linear and 1.0 is consistently linear.

When you select Coherence, you must choose an enabled response channel to compare to 
the reference channel; the resultant Coherence channel is created and listed in the channel 
list.

Refer to page 222 for information on configuring a Coherence channel once you have 
added it.

Adding a Windowed Time Domain Channel to the List

If you want to see the effect of a window on a time domain channel before doing any FFT 
processing on the data, click the Add windowed time domain channel (  ) button. Then, 
select the time domain channel to which to apply the window function and from the list of 
enabled channels. The resulting channel is added to the list of channels shown under Channel 
Name.
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You select the window to apply to the channel using the Window tab of the Acquisition 
Config window, described on page 135.

No additional configuration is required for a windowed time domain channel. Therefore, all 
the options under the Data tab are grayed out for windowed time domain channels.

Adding a Time Domain Channel to the List

If you want to add a time domain channel to the list of channels shown under Channel Name, 
click the Add time domain channel (  ) button. Then, select a time domain channel to add 
from the list of enabled channels. The resulting channel is added to the list of channels shown 
under Channel Name.

No additional configuration is required for a time domain channel. Therefore, all the options 
under the Data tab are grayed out for time domain channels.
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Removing Channels from the Plot and Data Config 
Window

If you are using the FFT Analyzer interface, a button is provided under the channel selection 
area of the Plot and Data Config window to remove a channel from the Plot and Data Config 
window:

To remove a channel from the list of channels shown under Channel Name, click the Remove 
selected plot channel  (  ) button, and then click OK.

Alternatively, you can select the channel from the list of channels shown under Channel 
Name, click the Delete key, and then click OK to remove the channel from the Plot and Data 
Config window.

Remove selected plot channel
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Configuring Parameters for a Single FFT Channel
If you are using the FFT Analyzer interface, you can add an FFT channel, if desired, as 
described on page 203. Once you have selected an FFT channel under the Channel Name 
column, you can configure the parameters of the FFT channel using the Data tab options:

This section describes the options that appear under the Data tab if you select a single channel 
FFT channel in the Plot and Data Config window. 

Note: Once you have acquired data, you can change the parameters under the Data tab and 
see the effect of your changes immediately by checking the Auto-reprocess on parameter 
change checkbox. Or, if this checkbox is not checked, click the Apply settings to current data 
button to see the results.

Function Tab

The Function tab provides the following selections: Spectrum Function, Integration Type, 
and Display Function. These options are described in the following subsections.
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Spectrum Function

Under Spectrum Function, choose one of the following settings:

• Spectrum – Plots the magnitude of a periodic frequency component at a discrete 
frequency. It is computed as the square root of the average auto spectrum. For an 
accelerometer, for example, the units for Spectrum are represented as g. Typically, 
Spectrum is best for narrowband, deterministic signals. 

• Auto Spectrum – Plots the power of a periodic frequency component at a discrete 
frequency. For an accelerometer, for example, the units for Auto Spectrum are 
represented as g2. Typically, Auto Spectrum is best for narrowband, deterministic signals. 

• PSD – (Power Spectral Density) Plots the power of random vibration intensity as 
“mean-square acceleration per frequency unit.” The spectrum is computed by squaring 
the magnitude of each frequency component in the FFT, and dividing this number by the 
change in frequency multiplied by the equivalent noise bandwidth of the windowing 
function. For an accelerometer, for example, the units for PSD are represented as g2/Hz.   
Typically, PSD is best for wideband, continuous signals.

Integration Type

Primarily used for accelerometer sensor types, choose one of the following integration types:

• None – No integration; acceleration data is represented as acceleration.

• Single – Data is integrated once; acceleration data is represented as velocity.

• Double – Data is integrated twice; acceleration data is represented as displacement. 

Display Function

If you are using the FFT Analysis option, the following settings are available for Display 
Function:

• Amplitude – Plots the length of the frequency response.

• Phase – Plots the frequency response phase shift (angle).

If you are using the Advanced FFT Analysis option of QuickDAQ, the following settings are 
available for Display Function:

• Amplitude – Plots the length of the frequency response.

• Phase – Plots the frequency response phase shift (angle).

• Real – Plots the real component of the complex resultant data on the y-axis against 
frequency on the x-axis. 

• Imaginary – Plots the imaginary component of the complex resultant data on the y-axis 
against frequency on the x-axis.

• Nyquist – Plots the complex resultant data with the real components on the x-axis and 
imaginary components on the y-axis; the consecutive points are joined by line segments.
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Scaling Tab

The Scaling tab allows you specify how you want to scale the data for the FFT channel when it 
is plotted.

Note: This tab is not used if you select the Real, Imaginary, or Nyquist display function.

• dB or Linear – Select dB for decibels or Linear for the engineering units of the sensor, such 
as g for an accelerometer.

Note: If you select Linear scaling for the FFT channel, you can right-click on the axis of 
the plot, and select Y Axis Setup (for the y-axis) or X Axis Setup (for the x-axis) to change 
the scaling of the axis to Linear or Log10. If you select dB scaling for the channel, the 
Y-axis is set to Linear automatically.

If a channel is configured for a strain gage or bridge-based sensor, you cannot choose dB 
scaling for the corresponding FFT channel.
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• dB  Reference – If you select dB, you can select one of the following dB reference values to 
use when computing dB: Sensor full-scale (the full-scale range of the sensor that you 
defined is used), Acceleration (1e-3), Velocity (1e-6), Displacement (1e-9), or a 
User-Defined value. If you select User-Defined, change the default reference value to the 
value that you desire; this value must be greater than 0.

• RMS, Peak, or Pk-Pk – Allows you to scale the FFT data using RMS (the square root of 
the average of the square of the value of the function taken throughout one period, as 
shown in Figure 35), Peak (zero to Peak, as shown in Figure 36), or PeakPeak (the 
absolute value of the data from the negative peak to the positive peak, as shown in Figure 
37).

Figure 35: RMS (Square Root of the Average of the Squares)

Figure 36: Peak (Zero to Peak)
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Figure 37: PeakPeak (Negative Peak to Positive Peak)

Averaging Tab

The Averaging tab allows you specify how you want to average the data for the FFT channel.
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• Enable Averaging – Enable averaging by selecting this checkbox, or disable averaging by 
unchecking this checkbox.

When this box is checked, the FFT plot shows the accumulated average result of the data 
at the completion of each acquired record.

• Averaging Type – If you want to average FFTs rather than showing an FFT for each 
individual record, choose one of the following spectral averaging types: 

− Linear – Data from each FFT is averaged with the data from the other FFTs; all data 
contributes equally to the average.

− Exponential – New FFT data is weighted differently than older FFT data. You specify 
the weighting factor to apply, which either increases or decreases the effect of the new 
FFT data on the average. This is a continuous averaging type.

• Weighting Factor – If you choose Exponential as the spectral averaging type, enter the 
weighting factor to apply. The weighting factor either increases or decreases the effect of 
new FFT data on the resultant average using on the following formula:

Result = ((New FFT Data) * Weighting Factor) + (Old Average * (1- Weighting Factor))

• Averaging Mode – Choose one of the following averaging mode to use: 

− RMS – RMS (root mean squared) averaging averages the power of the signal in real 
numbers directly. For single channel measurements, this results in zero phase. RMS 
averaging reduces signal fluctuations but not the noise floor. 

− Vector – Vector (angle) averaging computes the average of complex numbers directly. 
The real part of the number is averaged separately from the imaginary part of the 
number, reducing the noise floor for random signals. A trigger is usually required for 
this averaging mode. 

− PeakHold – With PeakHold averaging, the averaged data is a collection of points that 
represent the peak amplitude for each point in the FFT. With each new FFT, the current 
data is compared with the new data on a point by point basis. The highest amplitude 
for each point in the FFT is retained.
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Configuring Parameters for a Two-Channel FRF 
Function

This section applies to the Advanced FFT Analysis option of QuickDAQ.

If you have added a two-channel FRF (Frequency Response Function) channel, as described 
on page 204, and selected it under the Channel Name column, you can configure the 
parameters of the FRF channel using the Data tab options:

This section describes the options that appear under the Data tab if you select a two-channel 
FRF channel in the Plot and Data Config window.

Note: Once you have acquired data, you can change the parameters under the Data tab and 
see the effect of your changes immediately by checking the Auto-reprocess on parameter 
change checkbox. Or, if this checkbox is not checked, click the Apply settings to current data 
button to see the results.
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Function Tab

The Function tab provides the following selections: FRF Estimator, Reference Channel, 
Display Function, and FRF Mode. 

FRF Estimator

The FRF Estimator determines how the frequency response function is calculated. Choose one 
of the following settings for FRF Estimator:

• H1 – Reduces noise on the response channel. It is calculated as follows:

H1 = Sxf/Sff

where, 

Sxf represents the average cross power spectrum between the response and the reference 
signals.

Sff represents the average auto power spectrum of the reference signal.

• H2 – Reduces noise on the reference channel. It is calculated as follows:

H2 = Sxx/Sfx

where, 

Sxx represents the average auto spectrum of the response signal.

Sfx represents the average cross power spectrum between the response and the reference 
signals.

• H3 – Reduces noise on both the reference and response channels. H3 is computed as 
follows:

H3 = (H1 + H2)/2

Reference Channel

From the list of reference channels that you configured using the Input Channel 
Configuration menu option, described on page 84, select the reference channel that you want 
to compare with the selected response channel. 

Display Function

Under Display Function, choose one of these settings:

• Amplitude – Plots the magnitude of the frequency response gain.

• Phase – Plots the frequency response phase shift (angle).

• Real – Plots the real component of the complex resultant data on the y-axis against 
frequency on the x-axis. 

• Imaginary – Plots the imaginary component of the complex resultant data on the y-axis 
against frequency on the x-axis.

• Nyquist – Plots the complex resultant data with the real components on the x-axis and 
imaginary components on the y-axis; the consecutive points are joined by line segments.
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FRF Mode

Choose one of the following FRF modes; based on the mode selected, the application sets the 
integration type for the response channel accordingly:

• Inertance – Calculated as Acceleration of Response Channel/Force of Reference Channel.

• Mobility – Calculated as Velocity of Response Channel/Force of Reference Channel.

• Compliance – Calculated as Displacement of Response Channel/Force of Reference 
Channel.

• Apparent Mass – Calculated as Force of the Reference Channel/Acceleration of Response 
Channel.

• Impedance – Calculated as Force of Reference Channel/Velocity of the Response 
Channel.

• Dynamic Stiffness – Calculated as Force of Reference Channel/Displacement of 
Response Channel

• Custom – When you select this option, you can enter a integration type for the response 
channel and an integration type for the reference channel, if desired. The following 
selections are available:

− None – No integration; acceleration data is represented as acceleration.

− Single – Data is integrated once; acceleration data is represented as velocity.

− Double – Data is integrated twice; acceleration data is represented as displacement. 
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Scaling Tab

The Scaling tab allows you specify how you want to scale the data of the FRF channel when it 
is plotted.

Note: The Scaling tab is not used if you select the Real, Imaginary, or Nyquist display 
function.

Select Linear for the engineering units of the sensor, such as g for an accelerometer, or dB for 
decibels.

Note: If you select Linear scaling for the channel, you can right-click on the axis of the plot, 
and select Y Axis Setup (for the y-axis) or X Axis Setup (for the x-axis) to change the scaling 
of the axis to Linear or Log10. If you select dB scaling for the channel, the Y-axis is set to 
Linear automatically.

If you select dB, User-Defined is selected by default for dB Reference.You can change the 
default reference value to a value that you desire; this value must be greater than 0.
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Averaging Tab

The Averaging tab allows you specify how you want to average the data for the FRF channel.

• Enable Averaging – Enable averaging by selecting this checkbox, or disable averaging by 
unchecking this checkbox.

When this box is checked, the FRF plot shows the accumulated average result of the data 
at the completion of each acquired record.

• Averaging Type – If you want to average FFTs rather than showing an FFT for each 
individual record, choose one of the following spectral averaging types: 

− Linear – Data from each FFT is averaged with the data from the other FFTs; all data 
contributes equally to the average.

− Exponential – New FFT data is weighted differently than older FFT data. You specify 
the weighting factor to apply, which either increases or decreases the effect of the new 
FFT data on the average. This is a continuous averaging type.

• Weighting Factor – If you choose Exponential as the spectral averaging type, enter the 
weighting factor to apply. The weighting factor either increases or decreases the effect of 
new FFT data on the resultant average using on the following formula:

Result = ((New FFT Data) * Weighting Factor) + (Old Average * (1- Weighting Factor))
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Configuring Parameters for a Two-Channel Cross 
Spectrum Function

This section applies to the Advanced FFT Analysis option of QuickDAQ.

Once you have added a two-channel Cross Spectrum channel, as described on page 204, and 
selected it under the Channel Name column, you can configure the parameters of the Cross 
Spectrum channel using the Data tab options:

This section describes the options that appear under the Data tab if you select a two-channel 
Cross Spectrum channel in the Plot and Data Config window.

Note: Once you have acquired data, you can change the parameters under the Data tab and 
see the effect of your changes immediately by checking the Auto-reprocess on parameter 
change checkbox. Or, if this checkbox is not checked, click the Apply settings to current data 
button to see the results.

Function Tab

The Function tab provides the following selections: Cross Function, Reference Channel, and 
Resp Integration, Ref Integration, and Display Function. 
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Cross Function

Under Cross Function, choose one of the following settings:

• Cross Spectrum – A building block used in FRF and other more advanced functions. The 
cross-spectrum is defined as the product of the complex Fourier spectrum of the response 
channel multiplied by the complex conjugate of the Fourier spectrum of the reference 
channel.

• Cross PSD – (Cross Power Spectral Density) The distribution of power per unit frequency.

Reference Channel

From the list of reference channels that you configured using the Input Channel 
Configuration menu option, described on page 84, select the reference channel that you want 
to compare with the selected response channel. 

Resp Integration

For the selected response channel, choose one of the following integration types:

• None – No integration; acceleration data is represented as acceleration.

• Single – Data is integrated once; acceleration data is represented as velocity.

• Double – Data is integrated twice; acceleration data is represented as displacement. 

Ref Integration

For the selected reference channel, choose one of the following integration types:

• None – No integration; acceleration data is represented as acceleration.

• Single – Data is integrated once; acceleration data is represented as velocity.

• Double – Data is integrated twice; acceleration data is represented as displacement. 

Display Function

Under Display Function, choose one of these settings:

• Amplitude – Plots the magnitude of the frequency response gain.

• Phase – Plots the frequency response phase shift (angle).

• Real – Plots the real component of the complex resultant data on the y-axis against 
frequency on the x-axis. 

• Imaginary – Plots the imaginary component of the complex resultant data on the y-axis 
against frequency on the x-axis.

• Nyquist – Plots the complex resultant data with the real components on the x-axis and 
imaginary components on the y-axis; the consecutive points are joined by line segments.
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Scaling Tab

The Scaling tab allows you specify how you want to scale the data when it is plotted.

Note: The Scaling tab is not used if you specify the Real, Imaginary, or Nyquist display 
function.

• dB or Linear – Select dB for decibels or Linear for the engineering units of the sensor, such 
as g for an accelerometer.

Note: If you select Linear scaling for the FFT channel, you can right-click on the axis of 
the plot, and select Y Axis Setup (for the y-axis) or X Axis Setup (for the x-axis) to change 
the scaling of axis to Linear or Log10. If you select dB scaling for the channel, the Y-axis is 
set to Linear automatically.

• dB  Reference – If you select dB, User-Defined is selected by default. You can change the 
default reference value to a value that you desire; this value must be greater than 0.

• RMS, Peak, or Pk-Pk – Allows you to scale the FFT data using RMS (the square root of 
the average of the square of the value of the function taken throughout one period, as 
shown in Figure 35 on page 210), Peak (zero to Peak, as shown in Figure 36 on page 210), 
or PeakPeak (the absolute value of the data from the negative peak to the positive peak, as 
shown in Figure 37 on page 211).
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Averaging Tab

The Averaging tab allows you specify how you want to average the data.

• Enable Averaging – Enable averaging by selecting this checkbox, or disable averaging by 
unchecking this checkbox.

When this box is checked, the Cross Spectrum plot shows the accumulated average result 
of the data at the completion of each acquired record.

• Averaging Type – If you want to average FFTs rather than showing an FFT for each 
individual record, choose one of the following spectral averaging types: 

− Linear – Data from each FFT is averaged with the data from the other FFTs; all data 
contributes equally to the average.

− Exponential – New FFT data is weighted differently than older FFT data. You specify 
the weighting factor to apply, which either increases or decreases the effect of the new 
FFT data on the average. This is a continuous averaging mode.

• Weighting Factor – If you choose Exponential as the spectral averaging type, enter the 
weighting factor to apply. The weighting factor either increases or decreases the effect of 
new FFT data on the resultant average using on the following formula:

Result = ((New FFT Data) * Weighting Factor) + (Old Average * (1- Weighting Factor))
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Configuring Parameters for a Two-Channel Coherence 
Function

This section applies to the Advanced FFT Analysis option of QuickDAQ.

Once you have added a two-channel Coherence channel, as described on page 204, and 
selected it under the Channel Name column, you can configure the parameters of the 
Coherence channel using the Data tab options:

This section describes the options that appear under the Data tab if you select a two-channel 
Coherence channel in the Plot and Data Config window.

Note: Once you have acquired data, you can change the parameters under the Data tab and 
see the effect of your changes immediately by checking the Auto-reprocess on parameter 
change checkbox. Or, if this checkbox is not checked, click the Apply settings to current data 
button to see the results.

Function Tab

The Function tab provides the following selections: Coherence Function and Reference 
Channel. These options are described in the following subsections.
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Coherence Function

Under Coherence Function, choose one of the following settings:

• Coherence – Evaluates the linearity between the reference signal and the response signal 
at each frequency, and generates a value between 0.0 and 1.0, where 0 is consistently not 
linear and 1.0 is consistently linear.

• COP – (Coherent Output Power) The COP function is the power of the response channel 
multiplied, at each frequency, by the coherence between the reference and the response 
channels.

Reference Channel

From the list of reference channels that you configured using the Input Channel 
Configuration menu option, described on page 84, select the reference channel that you want 
to compare with the selected response channel. 

Scaling Tab

For Coherence channels, Linear scaling is automatically selected for the Scaling tab; therefore, 
all choices for this tab are disabled. 

Note: You can right-click on the axis of the plot, and select Y Axis Setup (for the y-axis) or X 
Axis Setup (for the x-axis) to change the scaling of axis to Linear or Log10.
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Averaging Tab

The Averaging tab allows you specify how you want to average the data for the Coherence 
channel.

• Enable Averaging – Averaging is always enabled for Coherence channels; therefore, this 
checkbox is disabled.

The Coherence plot shows the accumulated average result of the data at the completion of 
each acquired record.

• Averaging Type – If you want to average FFTs rather than showing an FFT for each 
individual record, choose one of the following spectral averaging modes: 

− Linear – Data from each FFT is averaged with the data from the other FFTs; all data 
contributes equally to the average.

− Exponential – New FFT data is weighted differently than older FFT data. You specify 
the weighting factor to apply, which either increases or decreases the effect of the new 
FFT data on the average. This is a continuous averaging mode.

• Weighting Factor – If you choose Exponential as the spectral averaging type, enter the 
weighting factor to apply. The weighting factor either increases or decreases the effect of 
new FFT data on the resultant average using on the following formula:

Result = ((New FFT Data) * Weighting Factor) + (Old Average * (1- Weighting Factor))
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Configuring Statistics for FFT Plots Using the Stats 
Tab

If you are using the FFT Analyzer interface, the Stats tab allows you to set up statistics for FFT 
and time-domain channels. This section describes how to set up statistics for FFT plots. Refer 
to page 235 for more information on configuring statistics for the Statistics window.

If you select Show FFT Peaks, a graphic similar to the following appears next to each FFT 
plot:

The peaks are ordered by height, and the frequency and values for the detected peaks are 
displayed.
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You can configuring the following attributes for FFT peak detection:

• Max peaks – Select the number of peaks (1 to 10) that you want the application to detect 
and display in the FFT plot.

• Absolute amplitude priority – Determine whether the application detects the peak by 
Absolute amplitude or by Peak height.

• Edge sensitivity – Determine the sensitivity (high to low) with which the application 
detects the peak by adjusting the Edge sensitivity slider bar.
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Scrolling through FFTs for an Analog Input Channel
If you are using the FFT Analyzer interface and averaging is disabled for an FFT channel, you 
can use the Record Number box in the Acquisition Status window to scroll through the 
records that were acquired for the corresponding analog input channel once data is acquired.

For example, if 10 records were acquired for the analog input channels (0 to 9), and you are 
interested in looking at record number 3, set the Record Number to 3 and the plot for that FFT 
is displayed in the Channel Plot window.

If you want to see the actual analog input data that corresponds to a particular Record 
Number, click the Link Time Series Data checkbox. The data plot for the corresponding 
analog input channels is then displayed for the selected record number.
227



Chapter 6

228
Configuring the Appearance of the Channel Display 
Window

This section describes the how to configure the appearance of the Channel Display window 
when using the FFT Analyzer interface, and includes the following topics:

• Displaying channels in the Channel Display window, described on this page

• Controlling how data is displayed in the Channel Display window, described on page 230

• Specifying the style of the Channel Display window, described on page 232

Displaying Channels in the Channel Display Window

You can determine which channels are displayed in the Channel Display window by using the 
following controls in the Plot and Data Config window:

You can see the names of all enabled channels under the Channel Name column in the Plot 
and Data Config window. Only data from the list of enabled channels is acquired. 

Note: If desired, you can change the name of a channel using the Input Channel 
Configuration menu option or toolbar button, described on page 84.

Channel Name
Column

Visible Column 
for Channel 

Display Window

Hide/show columns

Multi-channel Actions
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For each enabled time-domain channel, you can control which channels are displayed in the 
Channel Display window using the Visible Display checkbox. If a box is checked under the 
Visible Display column, the data for the associated channel is displayed in the Channel 
Display window. If a box under the Visible Display column is unchecked, the data for the 
associated channel is not displayed in the Channel Display window. 

Note: FFT channels cannot be displayed in the Channel Display window.

Data for all enabled time-domain channels is recorded regardless of whether the channel is 
visible.

Making All Selected Channels Visible or Hidden in the Channel Display 
Window at Once

If you want to make all selected channels visible in the Channel Display window at once, 
select the Multi-channel Actions button (  ) button, and choose Selected channels 
visible in Channel Display.  

If you want to hide all selected channels in the Channel Display window at once, select the 
Multi-channel Actions (  ) button, and choose Selected channels hidden in 
Channel Display. 

Showing or Hiding the Visible Display Column

If you wish, you can change whether the Visible Display column is shown or hidden by 
selecting the Hide/show columns (  ) button, and selecting Visible Display. A checkmark 
means the column is shown; no checkmark means the column is hidden.

Moving the Visible Display Column

If you wish, you can move the position of the Visible Display column by clicking the 
left-mouse button to select it, dragging it to the right or left, and letting go of the left-mouse 
button.
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Controlling How Data is Displayed in the Channel Display Window

Using the Channel Display - Control tab in the Plot and Data Config window, you can control 
how data is displayed in the Channel Display window. 

You can configure the following settings:

• Hide Unused Channels – The Channel Display window shows the channels on the 
device. By default, the Hide Unused Channels checkbox is checked; therefore, only the 
enabled channels are shown. If you want your display to show all the channels rather than 
just the enabled channels, uncheck the Hide Unused Channels box. The following 
example illustrates how the display looks when the Hide Unused Channels box is 
unchecked to show all the channels.
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• Precision – You can select the number of significant digits after the decimal point to 
display; values range from 1 to 8 (2 is the default).

• Columns – You can specify how many columns to use when displaying the channels; 
values range from 1 to 16 (8 is the default). For example, by choosing 1, shown below, you 
can display each channel, one on top of the other (note that the lowest numbered channel 
is always at the top of the display and the highest numbered channel is at the bottom of 
the display):

• Display Update Rate – You can choose how fast you want the display of the Channel 
Display window to be updated. Slide the bar to the left for faster update rates, or slide the 
bar to the right for slower update rates.
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• Data Reduction Method – You can choose which value to display in the Channel Display 
window:

− First Value – The first value in the most recent record is displayed for each channel.

− Average – The average value in the most recent record is displayed for each channel.

− Min – The minimum value in the most recent record is displayed for each channel.

− Max – The maximum value in the most recent record is displayed for each channel.

Specifying the Style of the Channel Display Window

Using the Channel Display - Style tab, you can specify the style of the Channel Display 
window.

You can configure the following parameters:

• Background color – Allows you to choose a specific color for the background of the 
Channel Display window. You can select from a number of predefined colors or you can 
define your own color for the background.

• Foreground color – Allows you to choose a specific color for the foreground of the 
Channel Display window. You can select from a number of predefined colors or you can 
define your own color for the foreground.

• Label color – Allows you to choose a specific color for the label used on the Channel 
Display window. You can select from a number of predefined colors or you can define 
your own color for the label.
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• Indicator style – Allows you to specify how the numbers and letters that represent the 
data appear. The following choices are available:

− 7 Segment – The numbers and letters that represent the data are composed of 
7-segment lines.

− 16 Segment – The numbers and letters that represent the data are composed of 
16-segment lines.

− Mechanical – The numbers and letters that represent the data appear to be formed by a 
contiguous line.
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Configuring the Appearance of the Statistics Window
This section describes the how to configure the appearance of the Statistics window when 
using the FFT Analyzer interface, and includes the following topics:

• Displaying channels in the Statistics window, described on this page

• Controlling how data is displayed in the Statistics window, described on page 235

Displaying Channels in the Statistics Window

You can determine which channels are displayed in the Statistics window by using the 
following controls in the Plot and Data Config window:

You can see the names of all enabled channels under the Channel Name column in the Plot 
and Data Config window. Only data from the list of enabled channels is acquired. 

Note: If desired, you can change the name of a channel using the Input Channel 
Configuration menu option or toolbar button, described on page 84.

Channel Name
Column

Visible Column for 
Statistics Window

Hide/show columns

Multi-channel Actions
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For each enabled time-domain channel, you can control which channels are displayed in the 
Statistics window using the Visible Statistics checkbox. If a box is checked under the Visible 
Statistics column, the data for the associated channel is displayed in the Statistics window. If a 
box under the Visible Statistics column is unchecked, the data for the associated channel is 
not displayed in the Statistics window. 

Note: Statistics are not created for FFT channels; therefore, statistics for FFT channels are not 
displayed in the Statistics window.

Making All Selected Channels Visible or Hidden in the Statistics Window at 
Once

If you want to make all selected channels visible in the Statistics window at once, select the 
Multi-channel Actions button (  ) button, and choose Selected channels visible in 
Statistics Display.  

If you want to hide all selected channels in the Channel Display window at once, select the 
Multi-channel Actions (  ) button, and choose Selected channels hidden in 
Statistics Display. 

Showing or Hiding the Visible Statistics Column

If you wish, you can change whether the Visible Statistics column is shown or hidden by 
selecting the Hide/show columns (  ) button, and selecting Visible Statistics. A 
checkmark means the column is shown; no checkmark means the column is hidden.

Moving the Visible Statistics Column

If you wish, you can move the position of the Visible Statistics column by clicking the 
left-mouse button to select it, dragging it to the right or left, and letting go of the left-mouse 
button.

Controlling How Data is Displayed in the Statistics Window

Using the Stats tab in the Plot and Data Config window, you can control how data is 
displayed in the Statistics window. 

Note: Refer to page 225 for information on using the Stats tab to configure statistics for FFT 
plots. Statistics for FFT plots are displayed in the Channel Plot window for the FFT channel.
235



Chapter 6

236
Showing Dynamic Performance Statistics

By selecting Show Dynamic Performance Stats, you can quantify the analog characteristics of 
the data that is acquired through the A/D converter on the device.

When the Show Dynamic Performance Stats option is selected, an FFT is performed on the 
data for the selected time-domain channels (but you do not see the FFT plot.) The returned 
FFT data contains the DC amplitude, main signal amplitude, harmonic amplitude, and noise 
amplitude of the signal at specific frequencies. You can select one of the following averaging 
types to compute the FFT components:

• RMS – (Root Mean Squared) – Averages the power of the signal in real numbers directly. 
For single channel measurements, this results in zero phase. RMS averaging reduces 
signal fluctuations but not the noise floor. 

• Vector – (Angle) – Averaging computes the average of complex numbers directly. The real 
part of the number is averaged separately from the imaginary part of the number, 
reducing the noise floor for random signals. 

Note that to use this type of averaging, the trigger source (specified on the Trigger tab), 
must be either an external TTL trigger, threshold trigger, or software trigger (if you are 
also using the analog output channel as the input source). It cannot be a Free Run trigger.

Once the FFT is performed, additional mathematical operations are done on the data to 
compute the following statistics:

• IBF – Input Below Full-Scale

• THD – Total Harmonic Distortion
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• SFDR – Spurious Free Dynamic Range

• SINAD – Signal-to-Noise And Distortion

• SNR – Signal-to-Noise Ratio 

• ENOB – Effective Number of Bits 

The following sections describe the dynamic performance statistics in detail.

Note: The FFT Analysis and Advanced FFT Analysis options of QuickDAQ always use a 
Blackman Harris window to compute dynamic performance statistics due to its steep side 
lobe roll-off characteristics. The user-selected FFT window is still applied to FFT plots and 
time-domain window plots, but is not used to compute dynamic signal statistics.

IBF – Input Below Full-Scale

The IBF value, returned in dB, represents the level of the main signal component relative to 
the full-scale voltage, as shown in Figure 38.

Figure 38: IBF (Input Below Full-Scale)
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IBF is computed using the following equation:

where Vs is the main signal component and Vf is the full-scale voltage.

For example, if a ±1 V sine wave is applied to an analog input channel that is configured for a 
±10 V range, IBF is computed as follows:

THD – Total Harmonic Distortion

The THD value, returned in dB and %, represents the level of the harmonic distortion of the 
first five harmonics relative to the main signal component, as shown in Figure 39.

Figure 39: THD (Total Harmonic Distortion)
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THD is computed using the following equation:

dB:

%:

For example, if a 7.07 VRMS sine wave is applied to an analog input channel that is configured 
for a ±10 V range and the distortion (first five harmonics) is 14 μVRMS, THD is computed as 
follows:
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SFDR – Spurious Free Dynamic Range

The SFDR value, returned in dB, represents the level of the full-scale range to the greatest 
noise or distortion component, as shown in Figure 40.

Figure 40: SFDR (Spurious Free Dynamic Range)

SFDR is computed using the following equation:

where Vf is the full-scale range and Va is the greatest noise component.
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For example, if the analog input channel is configured for a ±10 V range, and the greatest 
noise or distortion component is 7.07 VRMS, SFDR is computed as follows:

SINAD – Signal-to-Noise and Distortion Ratio

The SINAD value, returned in dB, represents the level of the main signal component relative 
to the total noise, VRMS, including harmonics, as shown in Figure 41.

Figure 41: SINAD (Signal-to-Noise And Distortion) Statistic
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SINAD is computed using the following equation:

where Vs is the main signal component and Vn+d is the total noise plus distortion.

For example, if a 7.07 VRMS sine wave is applied to an analog input channel that is configured 
for a ±10 V range and the total noise and harmonics (distortion) is 14.14 μVRMS, SINAD is 
computed as follows:

SINAD 20 10
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log⋅=
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SNR – Signal-to-Noise Ratio

The SNR value, returned in dB, represents the level of the main signal component relative to 
the total noise, VRMS, as shown in Figure 42. Note that harmonics are not included in the 
noise.

Figure 42: SNR (Signal-to-Noise Ratio) Statistic

SNR is computed using the following equation:

where Vs is the main signal component and Vn is the total noise.
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For example, if a 7.07 VRMS sine wave is applied to an analog input channel that is configured 
for a ±10 V range and the total noise is 7.07 μVRMS, SNR is computed as follows:

ENOB – Effective Number of Bits

The ENOB value, returned in bits, represents the quality of a digitized signal. The input signal 
is typically sinusoidal and should be near full-scale to properly characterize the A/D 
converter and/or system. 

ENOB is computed using the following equation:

For example, if a ±9 V sine wave is applied to an analog input channel that is configured for a 
±10 V range and the average noise floor plus distortion (harmonics) is 30 μV peak, the ENOB 
is computed as follows:

Showing Min/Max/Mean Statistics

If you select Show Min/Max/Mean Stats, you can view the following statistics for the selected 
time-domain channels:

• Min – The minimum value in the engineering units for that channel.

• Max – The maximum value in the engineering units for that channel.

• Delta – The difference between the minimum and maximum value in the engineering 
units for that channel.

• Mean – The average value for the channel in the engineering units for that channel.

• Std Dev – The standard deviation for the channel.
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Example of Measuring Temperature and Voltage
In this example, the Data Logger interface of QuickDAQ is used to configure, measure, and 
display temperature and voltage data from a data acquisition device. For this example, the 
following sensors are connected to a MEASURpoint instrument:

• T thermocouple connected to analog input channel 0

• 4-wire, Euro PT1000 RTD connected to analog input channel 8

• ±10 V input signal connected to analog input channel 16

Configure the Channels

Configure the channels as follows:

1. Configure each analog input channel by clicking the Configuration menu, and clicking 
Input Channel Configuration, or by clicking the Input Channel Configuration toolbar 
button (  ).

2. Enable analog input channels 0, 8, and 16 by clicking the checkbox under the Enable 
column.
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3. Under the Channel Name column, enter a meaningful name for each channel. For this 
example, enter the following names:

− For analog input channel 0, enter T Therm as the channel name.

− For analog input channel 8, enter PT1000 RTD as the channel name.

− For analog input channel 16, enter Voltage In as the channel name.

4. Under the Sensor column, select the following sensor types for the analog input channels:

− For analog input channel 0, select Type T as the thermocouple type.

− For analog input channel 8, select Euro PT1000 as the RTD type.

− For analog input channel 16, select +/-10V as the input voltage range.

5. Under the Engineering Units column, Deg C is selected by default. If you want to change 
this setting, change the temperature units under the Acquisition tab.
In this example, Deg C is used.

6. If you know the offset for your calibrated thermocouple and RTD, enter it under the EU 
Offset column. For this example, leave 0 as the EU offset for the thermocouple and RTD 
channels and 1000 as the EU offset for the voltage input channel.

7. Leave the test point values for each channel unchanged. 

8. Click Close to close the Channel Configuration dialog box.
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Configure the Parameters of the Acquisition Config Window

For this example, set the Acquisition Config parameters as follows:

1. Click the Recording tab.

2. For Filename generation, select Filename.

3. Enter a meaningful name for the data file. 
In this example, QuickDAQ Data.hpf is used.

4. Leave the Enable Continuous Acquisition checkbox unchecked.

5. For Acquisition Duration, select 1 minute as the time to acquire the measurement data.
The amount of available disk space is shown; in addition, the number of scans in the Acquisition 
Info area is updated based on the acquisition duration that is selected.

6. For X Axis Span, enter 5 seconds as the span for the x-axis.

7. Click the Acquisition tab.
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8. For this example, ensure that the following default settings are used:

− Sampling Frequency: 10 Hz

− Trigger Source: Software

− Temperature Unit: Celsius

− Filter Type: Moving Average

9. If desired, hide the Acquisition Config window by clicking the Auto-Hide pin (  ) in 
the top, right corner of the window.
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Configure the Appearance of the Channel Display Window

Configure the appearance of the Channel Display window as follows:

1. Ensure that the Visible Display column in the Plot and Data Config window is checked 
for all three enabled channels.

2. Click the Channel Display - Style tab, and select the color scheme that you want for the 
Channel Display window.
In this example, black is used for the background color, green is used for the foreground color, and 
white is used for the label color.

3. Leave the indicator style as 7 segment.
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Configure the Appearance of the Channel Plot Window

Configure the appearance of the Channel Plot window as follows:

1. In the Plot and Data Config window, set up the following parameters:

a. Ensure that the Visible Plot column is checked for all three enabled channels.

b. Leave the Show Cursor column unchecked for all three enabled channels.

c. Under Plot Column, use the default plot column setting of 1 for all three enabled 
channels.

d. Under the Signal Group column, select A for the thermocouple and RTD channels, 
and select B for the voltage input channel.

e. Under the Color column, assign a unique color to each trace.

2. Click the Channel Plot - Control tab, and slide the Plot height bar to the left until you can 
see both plots on the screen at once.
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3. Leave the following settings unchanged:

− Plot update rate: 1

− Smooth scrolling: unchecked

− Disable during acquisition: unchecked

− Time domain X axis units: Relative time

− Display Days: unchecked

4. In the display area, click the tab for the Channel Plot window.

5. Click the Show Legend control (  ) on the toolbar.

6. For the top plot in this window, change the text for the label on the x-axis, by doing the 
following:

a. Right-click on the label.

b. Select Edit Label.

c. Enter the following text: Thermocouple and RTD Channels

7. For the bottom plot in this window, change the text for the label on the x-axis, by doing 
the following:

a. Right-click on the label.

b. Select Edit Label.

c. Enter the following text: Voltage Channels
The Channel Plot window should appear as follows:
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Configure the Appearance of the Statistics Window

Configure the appearance of the Statistics window as follows:

1. Ensure that the Visible Statistics column in the Plot and Data Config window is checked 
for all three enabled channels:

2. If desired, hide the Plot and Data Config window by clicking the Auto-Hide pin (  ) in 
the top, right corner of the window.

Position the Windows

If you want see the data that is displayed in the Channel Display, Channel Plot, and Statistics 
windows at once, you need to move the windows to different locations in the display area.

In the following example, the Channel Display window is located at the top of the display 
area, the Channel Plot window is located in the middle of the display area, and the Statistics 
window is located at the bottom of the display area:
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Perform the following steps to position the Channel Display window at the top of the display 
area, the Channel Plot window in the middle of the display area, and the Statistics window at 
the bottom of the display area:

1. Click the tab for the Statistics window, drag the window toward the middle of the display 
area, move the mouse over the guide on the bottom of the guide diamond, and then 
release the mouse button.
The Statistics window is now placed at the bottom of the display area.

2. Click the tab for the Channel Plot window, drag the window toward the middle of the 
display area, move the mouse over the guide on the bottom of the guide diamond, and 
then release the mouse button.
The Channel Plot window is now placed in the middle of the display area, revealing the Channel 
Display window at the top of the display area.

3. Resize each window, as desired.
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Start the Measurement

Once you have configured the channels and the display area, start acquisition and log data to 
disk by clicking the Record toolbar button ( ). 
Results similar to the following are displayed in the display area.

If desired, you can view the data in Excel by clicking the Open Current Data in Excel toolbar 
button (  ).
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Example of Monitoring an Analog Output Signal
The following steps describe how to use the Data Logger interface of QuickDAQ to monitor 
the output of an analog output signal of a device using one of its analog input channels.

In this example, a 3 V sine wave is output on analog output channel 0 of a DT9837C module. 
The analog output channel is connected to analog input channel 0 on the DT9837C module.

Configure the Analog Output Settings

For this example, configure the analog output channel as follows:

1. Click the Output tab of the Acquisition Config window.
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2. Select the Enable checkbox to enable the analog output channel on the module.

3. For the Waveform type, select Fixed.

4. For Peak Voltage, enter 3 to output a ±3 V signal.
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5. For Offset, enter 0.

6. For Signal Type, select Sine to output a sine wave.

7. For Output Mode, select Continuous to output a waveform that repeats continuously.

8. For Frequency, select 100 Hz; this is the frequency of the output waveform. 

9. For Ramp Up Time, enter 0.

10. For the Start/Stop Method, select With Acquisition.
The analog output operation will start when you start acquisition.

11. If desired, hide the Acquisition Config window by clicking the Auto-Hide pin (  ) in 
the top, right corner of the window.

Configure the Analog Input Channel

Configure the analog input channel as follows:

1. Ensure that the output from analog output channel 0 is connected to the input of analog 
input channel 0.

2. Configure the analog input channel by clicking the Input Channel Configuration toolbar 
button (  ) or by clicking the Configuration menu and clicking Input Channel 
Configuration.

3. Enable analog input channel 0 by clicking the Enable checkbox next to the channel.

4. Under the Channel Name column, leave the default channel name as Ain 0. 

5. Under the Range column, select the input range for analog input channel. 
In this example, ±10 V is used.

6. Under the Coupling column, select the coupling type (AC or DC) for your sensor. 
Since this example is monitoring a voltage input, DC is used.
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7. Under the Current Source column, select whether to enable or disable use of the current 
source on the data acquisition device. 
Since this example is monitoring a voltage input, the Current Source checkbox is not checked 
(disabled) for the analog input channel.

8. Under the Engineering Units column, select the engineering units for the input.
In this example, V is used.

9. Enter the number of mV per engineering unit in the mV/EU field.
In this example, 1000 is used.

10. If an offset is specified for the input, enter the value in the EU Offset field.
In this example, no offset (0) is specified.

11. If desired, enter a test point value for the channel. 
In this example, 0 is used.

12. If desired, enter a sensor direction for each channel. 
In this example, Scalar is used.

13. Click Close to close the Configure Devices dialog box.



Examples Using the Data Logger Interface
Configure the Recording Settings

For this example, configure the recording settings as follows:

1. Click the Recording tab of the Acquisition Config window.
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2. For Filename generation, use the Filename option.

3. For Filename, use the default name for the data file.

4. Leave the Enable Continuous Acquisition checkbox unchecked.

5. For Acquisition Duration, select 10 Seconds as the time to acquire data.

Configure the Acquisition Settings

For this example, configure the acquisition settings as follows:

1. Click the Acquisition tab of the Acquisition Config window.

2. In the Maximum frequency to analyze text box, enter 2000 as the bandwidth or span, in 
Hz, of the input signals that you want to analyze 
Internally, the sampling rate of the data acquisition device is set to twice the bandwidth, or 4000 
Hz in this example.

3. For the Trigger Source, select Software to ensure that the measurement starts as soon as 
the Record button is clicked.

4. If desired, hide the Acquisition Config window by clicking the Auto-Hide pin (  ) in 
the top, right corner of the window.
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Configure the Appearance of the Display

In the Plot and Data Config window, ensure that the Visible Plot checkbox is checked.
263



Chapter 7

264
Start the Operation

Once you have configured the channels and the application parameters, click the Record 
toolbar button (  ) or press the F5 key to start the operation.

Results similar to the following are displayed in the Channel Plot window, showing the 
output of analog output channel 0 as measured by analog input channel 0.
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Acceleration Measurement Example
If you are using the FFT Analysis option or Advanced FFT Analysis option of QuickDAQ, you 
can use the following steps to perform an acceleration measurement.

This example uses a triaxial accelerometer connected to a DT9837C module to measure the 
vibration of a fan with an unbalanced blade. The FFT Analyzer interface of QuickDAQ is 
used.

Configure the Channels

Configure the channels as follows:

1. Ensure that the accelerometer is connected to your data acquisition device. For a triaxial 
accelerometer, each axis should be connected to a unique analog input channel. 
In this example, the x-axis connector is attached to analog input channel 0, the y-axis connector is 
attached to analog input channel 1, and the z-axis connector is attached to analog input channel 2 
of a DT9837C module.

2. Configure each analog input channel by clicking the Input Channel Configuration 
toolbar button (  ) or by clicking the Configuration menu and clicking Input 
Channel Configuration.

3. Enable analog input channels 0, 1, and 2 at once by highlighting these analog input 
channels, clicking the multi-channel Actions button (  ), and clicking 
Enable all Selected Channels. Alternatively, you can enable the channels by clicking the 
Enable checkbox for each of these channels.
In this example, analog input channels 0, 1, and 2 are enabled.

4. Under the Channel Name column, enter the following names for the analog input 
channels:

− For analog input channel 0, enter X-Axis.

− For analog input channel 1, enter Y-Axis.

− For analog input channel 2, enter Z-Axis.

5. Under the Ref/Resp column, select Response for the analog input channe1s. 
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6. Under the Range column, select the best effective input range (±10 V or ±1 V) for each 
signal. For example, if your accelerometer measures 100 mV/g and your signal of interest 
is less than 100 g, choose the ±1 V range; similarly, if your signal of interest is greater than 
100 g, choose the ±10 V range. 
In this example, ±1 V is used.

7. Under the Coupling column, select the coupling type (AC or DC) for your sensor. For 
most IEPE accelerometers, you will want to choose AC coupling to remove any DC offset 
from your measurement. Choose DC coupling only if the signal source has no offset 
voltage or if the DC content of the acquired signal is important. 
In this example, AC is used.

8. Under the Current Source column, select whether to enable or disable use of the 4 mA 
current source on the data acquisition device. Since most IEPE accelerometers require a 
current source of 4 mA and a compliance voltage of at least 18 V to drive their internal 
circuitry, in most cases, you will want to enable use of the current source for each analog 
input channel. 
In this example, the Current Source checkbox is checked (enabled) for all three analog input 
channels.

Note: If you enable the use of the internal 4 mA excitation current source, it is 
recommended that you choose AC coupling. 

9. Under the Engineering Units column, select the engineering units for the accelerometer.
In this example, g is used.

10. Using the calibration certificate that was supplied with your accelerometer, enter the 
calibrated sensitivity for the axis that is connected to the selected analog input channel in 
the mV/EU field. In this example, the following values are used:

− Analog input channel 0 (X-Axis) = 102.2 mV/g

− Analog input channel 1 (Y-Axis) = 99.1 mV/g

− Analog input channel 2 (Z-Axis) = 99.4 mV/g

11. If an offset is specified for the accelerometer, enter the value in the EU Offset field.
In this example, no offset (0) is specified.

12. If desired, enter a test point value for each channel. In this example, the following values 
are used:

− Analog input channel 0 (X-Axis) = 1

− Analog input channel 1 (Y-Axis) = 2

− Analog input channel 2 (Z-Axis) = 3

13. If desired, enter a sensor direction for each channel. In this example, the following values 
are used:

− Analog input channel 0 (X-Axis) = X+

− Analog input channel 1 (Y-Axis) = Y+

− Analog input channel 2 (Z-Axis) = Z+

14. Click Close to close the Configure Devices dialog box.
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Configure the Recording Settings

For this example, configure the recording settings as follows:

1. Click the Recording tab of the Acquisition Config window.

2. For Filename generation, use the Filename option.

3. For Filename, use the default name for the data file.

4. Leave the Enable Continuous Acquisition checkbox unchecked.

5. For Number of Averages, enter 5 as the number of records to acquired, process, and 
average before acquisition stops.
The number of seconds for the total run and the amount of available disk space are shown.
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Configure the Frequency Settings

Configure the frequency settings as follows:

1. Click the Freq tab of the Acquisition Config window.

2. In the Maximum frequency to analyze text box, enter 200 as the bandwidth or span, in 
Hz, of the input signals that you want to analyze 
Internally, the sampling rate of the data acquisition device is set to twice the bandwidth, or 400 Hz 
in this example.

3. In the FFT Size text box, select 1024 from the drop-down combo box as the number of 
data points to use for the FFT calculation.
The number of spectral lines and the frequency resolution are displayed.
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Configure the Trigger Settings

For this example, configure the trigger settings as follows:

1. Click the Trigger tab of the Acquisition Config window.

2. For the Trigger Source, select Free Run to ensure that the measurement starts as soon as 
the Record button is clicked.
In this mode, the Trigger Mode is not used.
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Configure the Windowing Function

For this example, configure the windowing function as follows:

1. Click the Window tab of the Acquisition and Config window.
The Window tab for the Advanced FFT Analysis option of QuickDAQ is shown. Note that the FFT 
Analysis option of QuickDAQ does not use response and reference terms, and does not provide the 
reference window selections.

2. For the Response Window Type (Advanced FFT Analysis option) or Window Type (FFT 
Analysis option), select Hamming.
This is a setting is applied to the FFTs for all enabled analog input channels.

3. If you are using the Advanced FFT Analysis option, leave the setting for the Reference 
Window Type as Same As Response.
This example does not use reference channels.

4. If desired, hide the Acquisition Config window by clicking the Auto-Hide pin (  ) in 
the top, right corner of the window.
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Add FFTs Channel to the Channel Plot Window

The following steps show how to use the FFT Analyzer interface of QuickDAQ to add an FFT 
channel for each enabled analog input channel to the Channel Plot window:

1. Click the Add single channel FFT function (  ) button, and select the channel named 
DT9837-C(00).X-Axis.

2. Click the Add single channel FFT function (  ) button, and select the channel named 
DT9837-C(00s).Y-Axis.

3. Click the Add single channel FFT function (  ) button, and select the channel named 
DT9837-C(00).Z-Axis.

By default, these channels are visible in the Channel Plot window.

Configure FFT Parameters to Analyze Acceleration Data

The following steps show how to use the FFT Analyzer interface of QuickDAQ to configure 
the parameters used to generate the FFTs for each analog input channel:

1. Under the Channel Name column in the Plot and Data Config window, hold down the 
Ctrl key and select the three FFT channels (DT9837-C(00).X-Axis-FFT, 
DT9837-C(00).Y-Axis-FFT, and DT9837-C(00).Z-Axis-FFT) to configure the settings the 
same way for all three channels.

2. Click the Data tab, and then click the Function tab.
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3. For this example, configure the settings of this tab as follows:

a. For Spectrum Function, select PSD (Power Spectral Density).

b. For Integration Type, select None for acceleration data.

c. For Display Function, select Amplitude.

4. Click the Scaling tab.

5. For this example, configure the settings of this tab as follows:

a. For dB/Linear, select Linear.

b. For RMS/Peak/PkPk, select RMS.

6. Click the Averaging tab.
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7. For this example, configure the settings of this tab as follows:

a. Check the Enable Averaging checkbox.

b. For Averaging Type, select Linear.

c. For Averaging Mode, select RMS.

Configure the Appearance of the Channel Plot Window

Because, in this example, we want to look at data from three analog input channels, as well as 
their corresponding FFTs, in one view without scrolling, perform the following steps to 
configure the appearance of the Channel Plot window:

1. Under the Plot Column heading, assign the analog input channels to plot column 1, and 
assign the FFT channels to plot column 2, as follows:

a. Leave the analog input channels unchanged with the default plot column setting of 1.

b. Hold down the Ctrl key and select all the FFT channels.

c. Click the Multi-channel Actions button (  ).

d. Click Select channels Plot Column.

e. Select 2 as the column number to change the plot column for all FFT channels at once.
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2. Assign a unique color to each trace, if desired.

3. Click the Channel Plot - Control tab.

4. Slide the Plot height bar to the left until you can see all 6 plots on the screen at once.
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Configure Statistics to Analyze Acceleration Data

The following steps show how to use the FFT Analyzer interface of QuickDAQ to configure 
FFT statistics that are useful when analyzing acceleration data:

1. Click the Stats tab.

2. For this example, check the Show FFT Peaks checkbox to show a graphic similar to the 
following next to each FFT plot:

3. For Max peaks to detect, select 1. 

4. For Priority, select Absolute amplitude.

5. For Edge sensitivity, slide the bar to the left for the most edge sensitivity (this will help 
ensure that the most peaks are detected). 

6. If desired, hide the Plot and Data Config window by clicking the Auto-Hide pin (  ) in 
the top, right corner of the window.
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Start the Acceleration Measurement

Once you have configured the channels and the parameters for the Channel Plot window, start 
acquisition and log data to disk by clicking the Record toolbar button ( ). 
Results similar to the following are displayed in the Channel Plot window.
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Perform Further Analysis of the Data

Once you have logged data to disk, you can modify the parameters of the Plot and Data 
Config window to perform further data analysis. An example follows:

1. If you hid the Plot and Data Config window previously, show the window by hovering 
over the Plot and Data Config tab with the mouse and then clicking the Auto-Hide pin 
(  ) in the top, right corner of the window.

2. Ensure that the Auto-reprocess on parameter change checkbox is checked.

3. Click the Stats tab, and uncheck the Show FFT Peaks checkbox. 
Notice the change to the Channel Plot window takes effect immediately.

4. Under the Channel Name column, click the FFT channel to modify (for example, 
DT9837-C(00).X-Axis-FFT).

5. Click the Data tab, and then click the Function tab.

6. For this example, configure the settings of this tab as follows:

a. For Spectrum Function, select Spectrum.

b. For Integration Type, select Single for velocity data.

c. For Display Function, leave Amplitude selected.
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7. Click the Scaling tab.

8. For this example, configure the settings of this tab as follows:

a. For dB/Linear, select db.

b. For RMS/Peak/PkPk, select Peak.

c. Leave the other settings unchanged.
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9. Add a data-cursor to the plot, as follows:

a. Under the Show Cursor column, click the checkbox next to the FFT channel for 
analog input channel 0 (in this example, DT9837-C(00).X-Axis-FFT).
A data cursor appears on the FFT plot for that channel. (Note that you can remove the data 
cursor later, if desired, by unchecking this checkbox.)

b. Click the data-cursor control (  ) at the top of the Channel Plot window.

c. Right-click on the data cursor on the Channel Plot window, select Color, and change 
the color of the data cursor to red.

d. Move the position of a data-cursor on the plot by holding down the left mouse button 
and dragging the mouse.
The values of the selected points are shown; an example follows:

Notice that, in this example, the velocity is 0.0023 m/s for the highlighted peak.

10. If desired, modify the other parameters of the Plot and Data Config window as you wish, 
and view the results.
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Impact Testing Example
If you are using the Advanced FFT Analysis option of QuickDAQ, you can use the following 
steps to perform an impact test.

This example uses a hammer connected to analog input channel 0 of the DT9837B module and 
an accelerometer connected to analog input channel 1 of the DT9837B module to measure the 
impact of hitting a hammer against a table. The FFT Analyzer interface of QuickDAQ is used.

Configure the Channels

Configure the channels as follows:

1. Ensure that a hammer and an accelerometer are connected to your data acquisition 
device. 
In this example, connect the hammer to analog input channel 0 and connect the accelerometer to 
analog input channel 1 of a DT9837B module.

2. Configure each analog input channel by clicking the Configuration menu, and clicking 
Input Channel Configuration.

Enable analog input channels 0 and 1 by clicking the checkbox under the Enable column:
In this example, analog input channels 0 and 1 are enabled.

3. Under the Channel Name column, enter the following names for the analog input 
channels:

− For analog input channel 0, enter Hammer.

− For analog input channel 1, enter Acc-X.

4. Under the Ref/Resp column, select Reference for analog input channe1 0 (Hammer) and 
Response for analog input channel 1 (Acc-X). 

5. Under the Range column, select the best effective input range (±10 V or ±1 V) for each 
signal. For example, if your hammer and accelerometer measure 100 mV/g and your 
signal of interest is less than 100 g, choose the ±1 V range; similarly, if your signal of 
interest is greater than 100 g, choose the ±10 V range. 
In this example, ±1 V is used.
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6. Under the Coupling column, select the coupling type (AC or DC) for your sensor. For 
most IEPE accelerometers, you will want to choose AC coupling to remove any DC offset 
from your measurement. Choose DC coupling only if the signal source has no offset 
voltage or if the DC content of the acquired signal is important. 
In this example, AC is used.

7. Under the Current Source column, select whether to enable or disable use of the 4 mA 
current source on the data acquisition device. Since most IEPE accelerometers require a 
current source of 4 mA and a compliance voltage of at least 18 V to drive their internal 
circuitry, in most cases, you will want to enable use of the current source for each analog 
input channel.
In this example, the Current Source checkbox is checked (enabled) for both analog input channels.

Note: If you enable the use of the internal 4 mA excitation current source, it is 
recommended that you choose AC coupling. 

8. Under the Engineering Units column, select the engineering units for the hammer and 
the accelerometer.
In this example, lbf is used for the hammer and g is used for the accelerometer.

9. Using the calibration certificate that was supplied with your hammer and accelerometer, 
enter the calibrated sensitivity for the axis that is connected to the selected analog input 
channel in the mV/EU field. In this example, the following values are used:

− Analog input channel 0 (Hammer) = 10 mV/lbf

− Analog input channel 1 (Accelerometer) = 100 mV/g

10. If an offset is specified for the hammer and/or accelerometer, enter the value in the EU 
Offset field.
In this example, no offset (0) is specified.

11. If desired, enter a test point value for each channel. In this example, the following values 
are used:

− Analog input channel 0 (Hammer) = 1

− Analog input channel 1 (Acc-X) = 2

12. If desired, enter a sensor direction for each channel. In this example, the following values 
are used:

− Analog input channel 0 (Hammer) = Scalar

− Analog input channel 1 (Acc-X) = Scalar

13. Click Close to close the Channel Configuration dialog box.
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Configure the Recording Settings

For this example, configure the recording settings as follows:

1. Click the Recording tab of the Acquisition Config window.

2. For Filename generation, use the Filename option.

3. For Filename, use the default name for the data file.

4. Leave the Enable Continuous Acquisition checkbox unchecked.

5. For Number of Averages, enter 3 as the number of records to acquire, process, and 
average before acquisition stops.
The number of seconds for the entire run and the amount of available disk space are shown.
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Configure the Frequency Settings

For this example, configure the frequency settings as follows:

1. Click the Freq tab of the Acquisition Config window.

2. In the Maximum frequency to analyze text box, enter 10000 as the bandwidth or span, in 
Hz, of the input signals that you want to analyze 
Internally, the sampling rate of the data acquisition device is set to twice the bandwidth, or 
20000 Hz in this example.

3. In the FFT Size text box, select 1024 from the drop-down combo box as the number of 
data points to use for the FFT calculation.
The number of spectral lines and the frequency resolution are displayed.
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Configure the Trigger Settings

For this example, configure the trigger settings as follows:

1. Click the Trigger tab of the Acquisition Config window.

2. For the Trigger Source, select Analog Threshold Pos Edge.

3. For the Threshold value, enter 20.00 lbf. 
This ensures that the measurement starts when the hammer hits the table and at least 20 lbf is 
detected.

4. Select Analog input channel 0 (Hammer) as the channel for the threshold trigger.

5. For the Pre Trigger Data Percent, enter 10%.

6. Select the Show trigger markers in plot checkbox.

7. For the Trigger Mode, select User Accept-Reject.
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Configure the Windowing Function

For this example, configure the windowing function as follows:

1. Click the Window tab of the Acquisition and Config window.

2. For the Response Window Type, select Hanning.
This is a global setting that is applied to the FFTs for all enabled analog input channels that are 
configured as response channels.

3. For the Reference Window Type, select Force, and enter 8 for Start% and 12 for End%.

4. If desired, hide the Acquisition Config window by clicking the Auto-Hide pin (  ) in 
the top, right corner of the window.
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Add an FFT Channel to the Plot and Data Config Window

The following steps show how to use the FFT Analyzer interface of QuickDAQ to add an FFT 
channel to the Plot and Data Config window:

1. Click the Add single channel FFT function (  ) button to add an FFT channel to the 
Plot and Data Config window.

2. Select Acc-X as the FFT channel to add.
The Acc-X-FFT channel is added to the Plot and Data Config window.

Configure the FFT Channel

The following steps show how to use the FFT Analyzer interface of QuickDAQ to configure 
the parameters used for the FFT channel:

1. Select the Acc-X-FFT channel in the channel list.

2. Click the Data tab, and then click the Function tab.

3. For this example, configure the settings of this tab as follows:

a. For Spectrum Function, select AutoSpectrum.

b. For IntegrationType, select None.

c. For Display Function, select Amplitude.
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4. Click the Scaling tab, and configure the settings of this tab as follows:

a. For dB/Linear, select dB.

b. For RMS/Peak/PkPk, select RMS.

c. For dB Reference, select Sensor full scale.

5. Click the Averaging tab, and configure the settings of this tab as follows:
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a. Select the Enable Averaging checkbox.

b. For Averaging Type, select Linear.

c. For Averaging Mode, select RMS.
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Add an FRF Channel to the Plot and Data Config Window

The following steps show how to use the FFT Analyzer interface of QuickDAQ to add an FRF 
channel to the Plot and Data Config window to calculate the frequency response of analog 
input channel 0 (Hammer) and analog input channel 1 (Acc-X).

1. Click the Add 2 channel FFT function (  ) button, and select FRF to add an FRF 
channel to the Plot and Data Config window.

2. Select Acc-X as the response channel to add.
The Acc-X-FRF channel is added to the Plot and Data Config window.

Configure the FRF Channel

The following steps show how to use the FFT Analyzer interface of QuickDAQ to configure 
the parameters used to generate the FRF channels for the analog input channels:

1. Select the Acc-X-FRF channel in the channel list.

2. Click the Data tab, and then click the Function tab.

3. For the Acc-X-FRF channel, configure the settings of this tab as follows:

a. For FRF Estimator, select H1 (reduces noise on the response channel).

b. For Reference Channel, select Hammer (analog input channel 0).

c. For Display Function, select Amplitude.

d. For FRF Mode, select Inertance (Acceleration/Force).
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4. Click the Scaling tab, and select Linear for dB/Linear:

5. Click the Averaging tab, select the Enable Averaging checkbox, and select Linear for 
Averaging Type:
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Add a Coherence Channel to the Plot and Data Config Window

The following steps show how to use the FFT Analyzer interface of QuickDAQ to add a 
Coherence channel to the Plot and Data Config window:

1. Click the Add 2 channel FFT function (  ) button, and select Coherence to add a 
Coherence channel to the Plot and Data Config window.

2. Select Acc-X as the response channel to add.
The Acc-X-Coherence channel is added to the Plot and Data Config window.

Configure the Coherence Channel

The following steps show how to use the FFT Analyzer interface of QuickDAQ to configure 
the parameters used to generate the Coherence channel for the analog input channels:

1. Select the Acc-X-Coherence channel in the channel list.

2. Click the Data tab, and then click the Function tab.

3. For this example, configure the settings of this tab as follows:

a. For Coherence Function, select Coherence.

b. For Reference Channel, select Hammer (analog input channel 0).
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Note: Linear scaling is selected automatically for Coherence channels under the Scaling 
tab.

4. Click the Averaging tab, and select Linear for Averaging Type:

Configure the Appearance of the Channel Plot Window

Perform the following steps to configure the appearance of the Channel Plot window:

1. Select the Visible Plot checkbox for the Hammer, Acc-X, Acc-X-Coherence, Acc-X-FRF, 
and Acc-X-FFT channels.
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2. Under Plot Column, select plot column 1 for the Hammer, Acc-X, and Acc-X-FFT 
channels, and select plot column 2 for the Acc-X-Coherence and Acc-X-FRF channels.

3. Assign a unique color to each trace for the visible channels.

4. Click the Channel Plot - Control tab.

5. Slide the Plot height bar to the left until you can see all 5 plots on the Channel Plot 
window at once.

6. Click the Channel Plot - Style tab, and change the Text field to Impact Data.
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Start the Impact Test

Once you have configured the channels and the parameters for the Channel Plot window, do 
the following to conduct the impact test:

1. Click the Record toolbar button (  ) or press the F5 key, and strike the hammer 
on the table.

2. Click Accept if the data appears correct or Reject if the data reflects a bad hammer strike.

3. Strike the hammer on the table and repeat steps 2 and 3 until three acquisitions have been 
accepted.
Results similar to the following are displayed in the Channel Plot window.

In this example, you can see by the trigger marker for the Hammer trace, which is in the same 
color as the Hammer trace color, that all the pre-trigger data (10% of the data) was acquired. 
The result of the hammer strike is measured by the Accelerometer (Acc-X). In addition, you 
can see the FFT, Coherence, and FRF of the accelerometer data.
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Add Another FRF Channel to the Plot and Data Config Window

The following steps show how to use the FFT Analyzer interface of QuickDAQ to add another 
FRF channel to the Plot and Data Config window for calculating the frequency response and 
phase information.

1. Click the Add 2 channel FFT function (  ) button, and select FRF to add an FRF 
channel to the Plot and Data Config window.

2. Select Acc-X as the response channel to add.
The Acc-X-FRF1 channel is added to the Plot and Data Config window.

3. Select this channel and enter the following text to rename it: Acc-X-FRF-Phase.

Configure the FRF Channel for Phase

The following steps show how to use the FFT Analyzer interface of QuickDAQ to configure 
the parameters used to generate the FRF channel:

1. Select the Acc-X-FRF-Phase channel in the channel list.

2. Click the Data tab, and then click the Function tab.
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3. For the Acc-X-FRF-Phase channel, configure the settings of this tab as follows:

a. For FRF Estimator, select H1 (reduces noise on the response channel).

b. For Reference Channel, select Hammer (analog input channel 0).

c. For Display Function, select Phase.

d. For FRF Mode, select Inertance (Acceleration/Force).

Note: Linear scaling is automatically selected for the Scaling tab.

4. Click the Averaging tab, select the Enable Averaging checkbox, and select Linear for 
Averaging Type:
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Configure the Appearance of the Channel Plot Window

Perform the following steps to configure the appearance of the Channel Plot window:

1. Select the Visible Plot checkbox for the Hammer, Acc-X, Acc-X-FRF-Phase, Acc-X-FRF, 
and Acc-X-FFT channels.

2. Under Plot Column, select plot column 1 for the Hammer, Acc-X, and Acc-X-FFT 
channels, and plot column 2 for the Acc-X-FRF-Phase and Acc-X-FRF channels.

3. Assign a unique color to each trace for the visible channels, if desired.
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Restart the Impact Test

Once you have added and configured the Acc-X-Phase channel and configured the 
parameters for the Channel Plot window, do the following to restart the impact test:

1. Click the Record toolbar button (  ) or press the F5 key, and strike the hammer 
on the table.

2. Click Accept if the data appears correct or Reject if the data reflects a bad hammer strike.

3. Strike the hammer on the table and repeat steps 2 and 3 until three acquisitions have been 
accepted.
Results similar to the following are displayed in the Channel Plot window.

In this example, you can see by the trigger marker for the Hammer trace, which is in the same 
color as the Hammer trace color, that all the pre-trigger data (10% of the data) was acquired. 
The result of the hammer strike is measured by the Accelerometer (Acc-X). In addition, you 
can see the FFT, FRF-Phase, and FRF (Amplitude) of the accelerometer data.
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Strain Gage Example
If you are using the FFT Analysis or Advanced FFT Analysis option of QuickDAQ, you can 
use the following steps to perform a strain gage measurement. 

This example uses a full-bridge strain gage (full-bridge bending configuration) connected to a 
DT9838 module to measure strain. In this example, TEDS is not supported for the strain gage. 
The FFT Analyzer interface is used.

Configure the Channels

Configure the channels as follows:

1. Ensure that the strain gage is connected to your data acquisition device. 
In this example, the strain gage is connected to analog input channel 0 of the DT9838. Refer to the 
wiring diagram for a full-bridge bending configuration in the DT9838 User’s Manual for more 
information.

2. Configure each analog input channel by clicking the Input Channel Configuration 
toolbar button (  ) or by clicking the Configuration menu and clicking Input 
Channel Configuration.

3. Enable analog input channel 0 by clicking the Enable checkbox for analog input channel 
0.

4. In the Channel Name column, enter Full Bridge Bending for the name of analog input 
channel 0.

5. In the Ref/Resp column, leave Response selected for this example.

6. In the Enable Shunt Resistor column, leave the checkbox unchecked; this disables the 
shunt resistor.

7. Click the Configure and Calibrate button.
The following wizard appears:
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8. Select Strain Gage, and click Next. (Note that TEDS is not supported for this sensor; 
therefore, you do not need to click the Open TEDS data file... button.)
A screen similar to the following appears:
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9. For the Bridge Type field, select the bridge configuration of your strain gage.
In this example, the Full Bridge Bending bridge configuration is used.

10. For the Excitation Voltage field, enter the excitation voltage value for your strain gage.
In this example, 5 V is used as the excitation voltage value.

11. For the Nominal Gage field, enter the nominal gage resistance, in ohms, for your strain 
gage as determined by the manufacturer.
In this example, 350 is used as the nominal gage resistance.

12. For the Gage Factor field, enter the gage factor for your strain gage as determined by the 
manufacturer.
In this example, 2 is used as the gage factor.

13. For the Using Sense Lines field, select Yes if you are using remote sense lines in your 
wiring, or No if you are not using remote sensing in your wiring.
In this example, remote sensing is not used.

14. For the Lead Wire Resistance field, enter the lead wire resistance, in ohms, for your strain 
gage.
In this example, 0.1 is used as the lead wire resistance.

15. For the Min Range field, enter the minimum value of the range for your strain gage.
In this example, –1000 is used as the minimum strain value.
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16. For the Max Range field, enter the maximum value of the range for your strain gage.
In this example, 1000 is used as the maximum strain value.

17. For the Units field, select the engineering units for the strain gage.
In this example, μStrain is used.

18. In the Poisson Ratio column, enter the Poisson ratio for your strain gage, if applicable.
In this example, the Poisson ratio is not used.

19. Click Next.
A screen similar to the following appears:

20. Select the calibration steps to perform.
In this example, Offset Nulling and Shunt Calibration are selected.

21. Click Next.
A screen similar to the following appears:
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22. Ensure that the bride is in the unstrained state, and the click the Calibrate button to 
perform offset nulling procedure.
The expected voltage is shown along with the calibrated offset voltage.
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23. Click Next.
A screen similar to the following appears:
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24. For the Select Resistor Source field, select Internal if you are using the internal shunt 
resistor provided on the DT9838 module to perform shunt calibration, or External if you 
are using your own external resistor to perform shunt calibration.
In this example, Internal is used.

25. For the Select Node to Shunt field, select the resistive node or element to which to apply 
the shunt resistor.
In this example, R2 is used.

26. Click Calibrate to perform the shunt calibration procedure.
The calculated value is displayed along with the measured value and correction coefficient.
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27. Click Finish.

28. If desired, enter a test point number under the Point # column. 
In this example, 1 is used.

29. Click Close to close the Configure Devices dialog box.



Examples Using the FFT Analyzer Interface
Configure the Recording Settings

For this example, configure the recording settings as follows:

1. Click the Recording tab of the Acquisition Config window.

2. For Filename generation, use the Filename option.

3. For Filename, use the default name for the data file.

4. Leave the Enable Continuous Acquisition checkbox unchecked.

5. For Number of Averages, enter 5 as the number of records to acquired, process, and 
average before acquisition stops.
The number of seconds for the total run and the amount of available disk space are shown.
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Configure the Frequency Settings

For this example, configure the frequency settings as follows:

1. Click the Freq tab of the Acquisition Config window.

2. In the Maximum frequency to analyze text box, enter 500 as the bandwidth or span, in 
Hz, of the input signals that you want to analyze 
Internally, the sampling rate of the data acquisition device is set to twice the bandwidth, or 
1000 Hz in this example.

3. In the FFT Size text box, select 1024 from the drop-down combo box as the number of 
data points to use for the FFT calculation.
The number of spectral lines and the frequency resolution are displayed.
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Configure the Trigger Settings

For this example, configure the trigger settings as follows:

1. Click the Trigger tab of the Acquisition Config window.

2. For the Trigger Source, select Free Run to ensure that the measurement starts as soon as 
the Record button is clicked.
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Start the Strain Measurement

Once you have configured the channels, start acquisition and log data to disk by clicking the 
Record toolbar button ( ). 
Results similar to the following are displayed in the Channel Plot window.
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Export the Data to Excel

You can export the acquired data to Microsoft Excel for further analysis by performing the 
following steps:

1. Click the Open Current Data in Excel toolbar button .

2. Click Time Series Data..
Microsoft Excel then opens and displays the data that was acquired, as shown in the following 
example.
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Bridge-Based Sensor Example
If you are using the FFT Analysis or Advanced FFT Analysis option of QuickDAQ, you can 
use the following steps to configure a bridge-based sensor to measure compression. 

This example uses a load cell (a hand gripper) connected to a DT9838 module to measure 
compression, in pounds. In this example, the load cell supports hardware TEDS. The FFT 
Analyzer interface is used.

Configure the Channels

Configure the channels as follows:

1. Ensure that the load cell is connected to your data acquisition device. 
In this example, the hand gripper load cell is connected to analog input channel 0 of the DT9838.

2. Configure each analog input channel by clicking the Input Channel Configuration 
toolbar button (  ) or by clicking the Configuration menu and clicking Input 
Channel Configuration.

3. Enable analog input channel 0 by clicking the Enable checkbox for analog input channel 
0.

4. In the Channel Name column, enter Hand Gripper for the name of analog input channel 
0.

5. In the Ref/Resp column, leave Response selected for this example.

6. In the Enable Shunt Resistor column, leave the checkbox unchecked; this disables the 
shunt resistor.

7. Click the Configure and Calibrate button.
The following wizard appears:
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8. Select Full Bridge Based Sensor.
Since TEDS is supported by the hardware, the LED turns green and the message "TEDs support 
for bridge based sensor detected" appears.

9. Click Apply TEDs Values to apply the TEDS values from the hardware to the channel 
configuration.

10. Click Next.
A screen similar to the following appears:
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The TEDS values are read from the hardware, applied to the channel configuration, and 
displayed in the fields on this screen.

11. If desired, you can modify any of the parameters for the load cell.

12. Click Next.
A screen similar to the following appears:
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13. Select the calibration steps to perform.
In this example, Offset Nulling and Shunt Calibration are selected.

14. Click Next.
A screen similar to the following appears:
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15. Ensure that the bridge is in the unstrained state, and the click the Calibrate button to 
perform offset nulling procedure.
The expected voltage is shown along with the calibrated offset voltage.
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16. Click Next.
A screen similar to the following appears:
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17. For the Calibration Type, select Shunt Resistor if you want to use a shunt resistor to 
perform the shunt calibration procedure or Physical Value if you want to enter a value to 
perform the shunt calibration procedure.
In this example, Shunt Resistor is used.

18. For the Select Resistor Source field, select Internal if you are using the internal shunt 
resistor provided on the DT9838 module to perform shunt calibration, or External if you 
are using your own external resistor to perform shunt calibration.
In this example, Internal is used.

19. For the Select Node to Shunt field, select the resistive node or element to which to apply 
the shunt resistor.
In this example, R4 is used.

20. Click Calibrate to perform the shunt calibration procedure.
The calculated value is displayed along with the measured value and correction coefficient.



Examples Using the FFT Analyzer Interface
21. Click Finish.

22. If desired, enter a test point number under the Point # column. 
In this example, 1 is used.

23. Click Close to close the Configure Devices dialog box.
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Configure the Recording Settings

For this example, configure the recording settings as follows:

1. Click the Recording tab of the Acquisition Config window.

2. For Filename generation, select Filename.

3. For Filename, use the default name for the data file.

4. Leave the Enable Continuous Acquisition checkbox unchecked.

5. For Number of Averages, enter 5 as the number of records to acquired, process, and 
average before acquisition stops.
The number of seconds for the total run and the amount of available disk space are shown.
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Configure the Frequency Settings

For this example, configure the frequency settings as follows:

1. Click the Freq tab of the Acquisition Config window.

2. In the Maximum frequency to analyze text box, enter 500 as the bandwidth or span, in 
Hz, of the input signals that you want to analyze 
Internally, the sampling rate of the data acquisition device is set to twice the bandwidth, or 
1000 Hz in this example.

3. In the FFT Size text box, select 1024 from the drop-down combo box as the number of 
data points to use for the FFT calculation.
The number of spectral lines and the frequency resolution are displayed.
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Configure the Trigger Settings

For this example, configure the trigger settings as follows:

1. Click the Trigger tab of the Acquisition Config window.

2. For the Trigger Source, select Free Run to ensure that the measurement starts as soon as 
the Record button is clicked.
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Start the Measurement

Once you have configured the channels, start acquisition and log data to disk by clicking the 
Record toolbar button ( ). 
Results similar to the following are displayed in the Channel Plot window.
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Export the Data to Excel

You can export the acquired data to Microsoft Excel for further analysis by performing the 
following steps:

1. Click the Open Current Data in Excel toolbar button .

2. Click Time Series Data..
Microsoft Excel then opens and displays the data that was acquired, as shown in the following 
example.
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Free Run Swept Sine Example
If you are using the Advanced FFT Analysis option of QuickDAQ, you can use the following 
steps to output a swept sine wave from an analog output channel while simultaneously 
acquiring data on the analog input channels in Free Run trigger mode. Both the waveform 
output and the analog input operations are continuous. 

This example uses a DT9837A and the following equipment:

• The analog output channel of the DT9837A is connected to analog input channel 0 of the 
DT9837A and to an audio speaker.

• An accelerometer is attached to the audio speaker and connected to analog input channel 
1 of the DT9837A.

• A microphone is positioned very close to the audio speaker and connected to analog input 
channel 2 of the DT9837A.

The FFT Analyzer interface is used.

Configure the Channels

Configure the channels as follows:

1. Ensure that the proper signals are attached to the analog input channels of your data 
acquisition device. 
In this example, the analog output signal is connected to analog input channel 0 and to the audio 
speaker, an accelerometer is attached to the audio speaker and connected to analog input channel 1, 
and the microphone is positioned close to the audio speaker and connected to analog input channel 
2 of a DT9837A.

2. Configure each analog input channel by clicking the Input Channel Configuration 
toolbar button (  ) or by clicking the Configuration menu and clicking Input 
Channel Configuration.

3. Enable analog input channel 0 by clicking the Enable checkbox for analog input channel 
0.
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4. Under the Channel Name column, enter the following names for the analog input 
channels:

− For analog input channel 0, enter DAC.

− For analog input channel 1, enter Acc.

− For analog input channel 2, enter MIC.

5. In the Ref/Resp column, select Reference for analog input channel 0 (DAC), and select 
Response for analog input channels 1 (Acc) and 2 (MIC).

6. Under the Range column, select the best effective input range (±10 V or ±1 V) for each 
signal. For example, if your hammer and accelerometer measure 100 mV/g and your 
signal of interest is less than 100 g, choose the ±1 V range; similarly, if your signal of 
interest is greater than 100 g, choose the ±10 V range. 
In this example, ±1 V is used for analog input channels 0 (DAC), 1 (Acc), and 2 (MIC).

7. Under the Coupling column, select the coupling type (AC or DC) for your sensor. For 
most IEPE accelerometers, you will want to choose AC coupling to remove any DC offset 
from your measurement. Choose DC coupling only if the signal source has no offset 
voltage or if the DC content of the acquired signal is important. 
In this example, AC is used for analog input channel 1 (Acc), and DC is used for analog input 
channel 0 (DAC) and analog input channel 2 (MIC).

8. Under the Current Source column, select whether to enable or disable use of the 4 mA 
current source on the data acquisition device. Since most IEPE accelerometers require a 
current source of 4 mA and a compliance voltage of at least 18 V to drive their internal 
circuitry, in most cases, you will want to enable use of the current source for each analog 
input channel.
In this example, the Current Source checkbox is checked (enabled) for analog input channel 1 
(Acc) and is unchecked (disabled) for analog input channel 0 (DAC) and analog input channel 2 
(MIC).

Note: If you enable the use of the internal 4 mA excitation current source, it is 
recommended that you choose AC coupling. 

9. Under the Engineering Units column, select the engineering units for the analog input 
channels.
In this example, V is used for analog input channel 0 (DAC) and analog input channel 2 (MIC), 
and g is used for analog input channel 2 (Acc).

10. Using the calibration certificate that was supplied with your accelerometer, enter the 
calibrated sensitivity for the axis that is connected to the selected analog input channel in 
the mV/EU field.
In this example, 1000 mV/g is selected for analog input channel 1 (Acc).

11. If an offset is specified for the accelerometer, enter the value in the EU Offset field.
In this example, no offset (0) is specified.
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12. If desired, enter a test point value for each channel. 
In this example, the following values are used:

− Analog input channel 0 (DAC) = 1

− Analog input channel 1 (Acc) = 2

− Analog input channel 2 (MIC) = 3

13. If desired, enter a sensor direction for each channel. 
In this example, the direction is not used (all analog input channels are X+).

14. Click Close to close the Channel Configuration dialog box.

Configure the Recording Settings

For this example, configure the recording settings as follows:

1. Click the Recording tab of the Acquisition Config window.

2. For Filename generation, select the Filename option.

3. For Filename, use the default name for the data file.

4. Leave the Enable Continuous Acquisition checkbox unchecked.

5. For Number of Averages, enter 20 as the number of records to acquire, process, and 
average before acquisition stops.
The number of seconds for the entire run and the amount of available disk space are shown.
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Configure the Frequency Settings

For this example, configure the frequency settings as follows:

1. Click the Freq tab of the Acquisition Config window.

2. In the Maximum frequency to analyze text box, enter 2000 as the bandwidth or span, in 
Hz, of the input signals that you want to analyze 
Internally, the sampling rate of the data acquisition device is set to twice the bandwidth, or 
4000 Hz in this example.

3. In the FFT Size text box, select 1024 from the drop-down combo box as the number of 
data points to use for the FFT calculation.
The number of spectral lines and the frequency resolution are displayed.
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Configure the Trigger Settings

For this example, configure the trigger settings as follows:

1. Click the Trigger tab of the Acquisition Config window.

2. For the Trigger Source, select Free Run.
This trigger setting ensures that the module acquires contiguous, gap-free, records when you click 
the Record button or press the F5 key. 
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Configure the Windowing Function

For this example, configure the windowing function as follows:

1. Click the Window tab of the Acquisition and Config window.

2. For the Response Window Type, select Hanning.
This is a global setting that is applied to the FFTs for all enabled analog input channels that are 
configured as response channels.

3. For the Reference Window Type, select Same as Response. 
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Configure the Analog Output Settings

For this example, configure the analog output channel as follows:

1. Click the Output tab of the Acquisition and Config window.
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2. Select the Enable checkbox to enable the analog output channel on the device.

3. For the Waveform type, select Sweep to output a swept sine wave.

4. For the Peak Voltage, enter 0.9 as the maximum peak voltage for this waveform. 
The maximum peak voltage of the output waveform will be ±0.9 V.

5. For the Offset value, enter 0.

6. For the Sweep Mode, select Single to output a single waveform.

7. For the Freq Change, select Log to output a waveform where the frequency increases at a 
fixed rate of octave change per time (Octave/s). 

8. For the Start Frequency, enter 100 Hz; for the End Frequency, enter 1500 Hz.
The output sine wave will start at 100 Hz and sweep to 1500 Hz.

9. Select the Lock to acquisition time checkbox. 
The waveform will be output in the time that it takes to do all the averages (an acquisition of all the 
records specified in the Recording tab). Note that the Sweep On Time is set to the acquisition 
time, which in this case, is 5.12 s.

10. For this example, leave the Sweep Off Time as 0 s.
In this example, the output signal will be on for 5.12 s and then stop.

11. For the Ramp Up Time, specify 0.5 s; for the Ramp Down Time, specify 0.01 s.
The signal will go up to specified peak voltage in 0.5 s and will go down to 0 V in 0.01 s.

12. For the Start/Stop Method, select With Acquisition.
The analog output operations will start when you start acquisition.

13. If desired, hide the Acquisition Config window by clicking the Auto-Hide pin (  ) in 
the top, right corner of the window.

Add FFT Channels to the Plot and Data Config Window

The following steps show how to use the FFT Analyzer interface of QuickDAQ to add three 
FFT channels to the Plot and Data Config window:

1. Click the Add single channel FFT function (  ) button and select DT9837-A(02).DAC.
The DAC-FFT channel is added to the Plot and Data Config window.

2. Click the Add single channel FFT function (  ) button and select DT9837-A(02).Acc.
The Acc-FFT channel is added to the Plot and Data Config window.

3. Click the Add single channel FFT function (  ) button and select DT9837-A(02).MIC.
The MIC-FFT channel is added to the Plot and Data Config window.
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Configure the FFT Channels

The following steps show how to use the FFT Analyzer interface of QuickDAQ to configure 
the parameters used for the FFT channel:

1. Under the Channel Name column in the Plot and Data Config window, hold down the 
Ctrl key and select the FFT channels (DAC-FFT, Acc-FFT, and MIC-FFT in this example) 
that you want to configure.

2. Click the Data tab, and then click the Function tab.

3. For this example, configure the settings of this tab as follows:

a. For Spectrum Function, select AutoSpectrum.

b. For IntegrationType, select None.

c. For Display Function, select Amplitude.
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4. Click the Scaling tab, and configure the settings of this tab as follows:

a. For dB/Linear, select Linear.

b. For RMS/Peak/PkPk, select RMS.

5. Click the Averaging tab, and configure the settings of this tab as follows:

a. Select the Enable Averaging checkbox.

b. For Averaging Type, select Linear.

c. For Averaging Mode, select RMS.
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Add FRF Channels to the Plot and Data Config Window

The following steps show how to use the FFT Analyzer interface of QuickDAQ to add two 
FRF channels to the Plot and Data Config window to calculate the frequency response of 
analog input channel 0 (DAC) and analog input channel 1 (Acc), and analog input channel 0 
(DAC) and analog input channel 2 (MIC).

1. Click the Add 2 channel FFT function (  ) button, select FRF, and select 
DT9837-A(02).Acc.
The Acc-FRF channel is added to the Plot and Data Config window.

2. Click the Add 2 channel FFT function (  ) button, select FRF, and select 
DT9837-A(02).MIC.
The MIC-FRF channel is added to the Plot and Data Config window.

Configure the FRF Channels

The following steps show how to use the FFT Analyzer interface of QuickDAQ to configure 
the parameters used to generate the FRF channels for the analog input channels:

1. Under the Channel Name column in the Plot and Data Config window, hold down the 
Ctrl key and select the FRF channels (Acc-FRF and MIC-FRF in this example) that you 
want to configure.

2. Click the Data tab, and then click the Function tab.
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3. For the Acc-FRF channel, configure the settings of this tab as follows:

a. For FRF Estimator, select H1 (reduces noise on the response channel).

b. For Reference Channel, select DAC (analog input channel 0).

c. For Display Function, select Amplitude.

d. For FRF Mode, select Inertance (Acceleration/Force).

4. Click the Scaling tab, and select Linear for dB/Linear:
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5. Click the Averaging tab, select the Enable Averaging checkbox, and select Linear for 
Averaging Type:

Add Coherence Channels to the Plot and Data Config Window

The following steps show how to use the FFT Analyzer interface of QuickDAQ to add two 
Coherence channels to the Plot and Data Config window:

1. Click the Add 2 channel FFT function (  ) button, select Coherence and select 
DT9837-A(02).Acc.
The Acc-Coherence channel is added to the Plot and Data Config window.

2. Click the Add 2 channel FFT function (  ) button, select Coherence, and select 
DT9837-A(02).MIC.
The MIC-Coherence channel is added to the Plot and Data Config window.
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Configure the Coherence Channel

The following steps show how to use the FFT Analyzer interface of QuickDAQ to configure 
the parameters used to generate the Coherence channel for the analog input channels:

1. Under the Channel Name column in the Plot and Data Config window, hold down the 
Ctrl key and select the Coherence channels (Acc-Coherence and MIC-Coherence in this 
example) that you want to configure.

2. Click the Data tab, and then click the Function tab.

3. For this example, configure the settings of this tab as follows:

a. For Coherence Function, select Coherence.

b. For Reference Channel, select DAC (analog input channel 0).

Note: Linear scaling is selected automatically for Coherence channels under the Scaling 
tab.
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4. Click the Averaging tab, and select Linear for Averaging Type:
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Configure the Appearance of the Channel Plot Window

Perform the following steps to configure the appearance of the Channel Plot window:

1. Select the Visible Plot checkbox for the DAC, DAC-FFT, MIC, MIC-Coherence, MIC-FRF, 
and MIC-FFT channels.

2. Select the Show Cursor checkbox for the MIC-FRF channel.

3. Under Plot Column, select plot column 1 for the DAC, DAC-FFT, MIC, and MIC-FFT 
channels, and select plot column 2 for the MIC-Coherence and MIC-FRF channels.

4. Under the Signal Group column, select group A for the DAC and MIC channels, and 
leave None as the signal group for the rest of the channels.

5. Assign a unique color to each trace for the visible channels.

6. Click the Channel Plot - Control tab.
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7. Slide the Plot height bar to the left until you can see all 5 plots on the Channel Plot 
window at once.
343



Chapter 8

344
Start the Simultaneous Swept Sine and Analog Input Operation

Once you have configured the channels and the parameters for the Channel Plot window, 
click the Record toolbar button (  ) or press the F5 key.

You will hear the waveform as it is output from the audio speaker as it sweeps from 100 Hz to 
1500 Hz. Results similar to the following are displayed in the Channel Plot window.

In column 1, you can see the signal that is output from the analog output channel (DAC) and 
read in as analog input channel 0, and the signal that is measured by the microphone (MIC); 
this is Group A of the first plot. You can also see the FFT of the analog output channel (DAC) 
and the FFT of the microphone (MIC).

In column 2, you can see the coherence of the microphone (MIC) and the FRF of the 
microphone (MIC). In this example, the y-axis of the FRF plot is shown in log10 format 
(right-click the y-axis, select Y-Axis Setup..., and select Log10 for Lin/Log).

Note: If desired, you can show the data for the Acc, Acc-FFT, Acc-FRF, and Acc-Coherence 
channels by selecting the Visible Plot checkbox in the Channel Plot window.
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Triggered Burst Random Example
If you are using the Advanced FFT Analysis option of QuickDAQ, you can use the following 
steps to output multiple burst random waveforms while simultaneously acquiring data on the 
analog input channels in Software trigger mode. The duration of each burst random signal 
corresponds to the duration of one analysis record. Between each burst, the analog input and 
analog output operations stop, wait the specified delay time, and then repeat the burst.

This example uses a DT9837A and the following equipment:

• The analog output channel of the DT9837A is connected to analog input channel 0 of the 
DT9837A and to an audio speaker.

• An accelerometer is attached to the audio speaker and connected to analog input channel 
1 of the DT9837A.

• A microphone is positioned very close to the audio speaker and connected to analog input 
channel 2 of the DT9837A.

The FFT Analyzer interface is used.

Configure the Channels

Configure the channels as follows:

1. Ensure that the proper signals are attached to the analog input channels of your data 
acquisition device. 
In this example, the analog output signal is connected to analog input channel 0 and to the audio 
speaker, an accelerometer is attached to the audio speaker and connected to analog input channel 1, 
and the microphone is positioned close to the audio speaker and connected to analog input channel 
2 of a DT9837A.

2. Configure each analog input channel by clicking the Input Channel Configuration 
toolbar button (  ) or by clicking the Configuration menu and clicking Input 
Channel Configuration.
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3. Enable analog input channel 0 by clicking the Enable checkbox for analog input channel 
0.

4. Under the Channel Name column, enter the following names for the analog input 
channels:

− For analog input channel 0, enter DAC.

− For analog input channel 1, enter Acc.

− For analog input channel 2, enter MIC.

5. In the Ref/Resp column, select Reference for analog input channel 0 (DAC), and select 
Response for analog input channels 1 (Acc) and 2 (MIC).

6. Under the Range column, select the best effective input range (±10 V or ±1 V) for each 
signal. For example, if your hammer and accelerometer measure 100 mV/g and your 
signal of interest is less than 100 g, choose the ±1 V range; similarly, if your signal of 
interest is greater than 100 g, choose the ±10 V range. 
In this example, ±1 V is used for analog input channels 0 (DAC), 1 (Acc), and 2 (MIC).

7. Under the Coupling column, select the coupling type (AC or DC) for your sensor. For 
most IEPE accelerometers, you will want to choose AC coupling to remove any DC offset 
from your measurement. Choose DC coupling only if the signal source has no offset 
voltage or if the DC content of the acquired signal is important. 
In this example, AC is used for analog input channel 1 (Acc), and DC is used for analog input 
channel 0 (DAC) and analog input channel 2 (MIC).

8. Under the Current Source column, select whether to enable or disable use of the 4 mA 
current source on the data acquisition device. Since most IEPE accelerometers require a 
current source of 4 mA and a compliance voltage of at least 18 V to drive their internal 
circuitry, in most cases, you will want to enable use of the current source for each analog 
input channel.
In this example, the Current Source checkbox is checked (enabled) for analog input channel 1 
(Acc) and is unchecked (disabled) for analog input channel 0 (DAC) and analog input channel 2 
(MIC).
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Note: If you enable the use of the internal 4 mA excitation current source, it is 
recommended that you choose AC coupling. 

9. Under the Engineering Units column, select the engineering units for the analog input 
channels.
In this example, V is used for analog input channel 0 (DAC) and analog input channel 2 (MIC), 
and g is used for analog input channel 2 (Acc).

10. Using the calibration certificate that was supplied with your accelerometer, enter the 
calibrated sensitivity for the axis that is connected to the selected analog input channel in 
the mV/EU field.
In this example, 1000 mV/g is selected for analog input channel 1 (Acc).

11. If an offset is specified for the accelerometer, enter the value in the EU Offset field.
In this example, no offset (0) is specified.

12. If desired, enter a test point value for each channel. 
In this example, the following values are used:

− Analog input channel 0 (DAC) = 1

− Analog input channel 1 (Acc) = 2

− Analog input channel 2 (MIC) = 3

13. If desired, enter a sensor direction for each channel. 
In this example, the direction is not used (all analog input channels are X+).

14. Click Close to close the Channel Configuration dialog box.
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Configure the Recording Settings

For this example, configure the recording settings as follows:

1. Click the Recording tab of the Acquisition Config window.

2. For Filename generation, select the Filename option.

3. For Filename, use the default name for the data file.

4. Leave the Enable Continuous Acquisition checkbox unchecked.

5. For Number of Averages, enter 3 as the number of records to acquire, process, and 
average before acquisition stops.
The number of seconds for the entire run and the amount of available disk space are shown.
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Configure the Frequency Settings

For this example, configure the frequency settings as follows:

1. Click the Freq tab of the Acquisition Config window.

2. In the Maximum frequency to analyze text box, enter 10000 as the bandwidth or span, in 
Hz, of the input signals that you want to analyze 
Internally, the sampling rate of the data acquisition device is set to twice the bandwidth, or 
20000 Hz in this example.

3. In the FFT Size text box, select 1024 from the drop-down combo box as the number of 
data points to use for the FFT calculation.
The number of spectral lines and the frequency resolution are displayed.
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Configure the Trigger Settings

For this example, configure the trigger settings as follows:

1. Click the Trigger tab of the Acquisition Config window.

2. For the Trigger Source, select Software Triggered.

3. For the Trigger Mode, select Auto Retrigger.

4. For Delay between triggers, enter 0.1 s.
With these trigger settings, once you click the Record button or press the F5 key, the module 
acquires a record based on a internal software trigger, waits 0.1 second, and then acquires the next 
record based on the internal software trigger.
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Configure the Windowing Function

For this example, configure the windowing function as follows:

1. Click the Window tab of the Acquisition and Config window.

2. For the Response Window Type, select Rectangular.
This is a global setting that is applied to the FFTs for all enabled analog input channels that are 
configured as response channels.

3. For the Reference Window Type, select Same as Response. 
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Configure the Analog Output Settings

For this example, configure the analog output channel as follows:

1. Click the Output tab of the Acquisition and Config window.
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2. Select the Enable checkbox to enable the analog output channel on the device.

3. For the Waveform type, select Noise to output a noise waveform.

Note: To output a burst chirp signal, select Sweep instead of Noise to output a swept 
sine wave rather than a noise output signal.

4. For the Peak Voltage, enter 0.9 as the maximum peak voltage for this waveform. 
The maximum peak voltage of the output waveform will be ±0.9 V.

5. For the Offset value, enter 0.

6. For the Noise Type, select Random to output white noise that is created with a software 
generator function.

7. For the Output Mode, select Burst to output the waveform for a specified time.

8. For the Start Frequency, select 0 Hz; this is the starting frequency component of the 
output waveform. 

9. For the End Frequency, select 8000 Hz; this is the ending frequency component of the 
output waveform. 

10. For the Repeat Method, select True Random to generate a new random noise signal for 
each burst period.

11. Select the Lock to analysis frame time checkbox. 
The waveform will be output in the time that it takes to do one average (an acquisition of one 
record). Note that the Noise On Time is set to the analysis frame time, which in this case, is 
0.5120 s.

12. For this example, leave the Noise Off Time as 0 s.
In this example, the output signal will be on for 0.5120 s and then stop.

13. For the Ramp Up Time, specify 0.01 s; for the Ramp Down Time, specify 0.01 s.
The signal will go up to specified peak voltage in 0.01 s and will go down to 0 V in 0.01 s.

14. For the Start/Stop Method, select With Acquisition.
The analog output operations will start when you start acquisition.

15. If desired, hide the Acquisition Config window by clicking the Auto-Hide pin (  ) in 
the top, right corner of the window.

Add FFT Channels to the Plot and Data Config Window

The following steps show how to use the FFT Analyzer interface of QuickDAQ to add three 
FFT channels to the Plot and Data Config window:

1. Click the Add single channel FFT function (  ) button and select DT9837-A(02).DAC.
The DAC-FFT channel is added to the Plot and Data Config window.

2. Click the Add single channel FFT function (  ) button and select DT9837-A(02).Acc.
The Acc-FFT channel is added to the Plot and Data Config window.

3. Click the Add single channel FFT function (  ) button and select DT9837-A(02).MIC.
The MIC-FFT channel is added to the Plot and Data Config window.
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Configure the FFT Channels

The following steps show how to use the FFT Analyzer interface of QuickDAQ to configure 
the parameters used for the FFT channel:

1. Under the Channel Name column in the Plot and Data Config window, hold down the 
Ctrl key and select the FFT channels (DAC-FFT, Acc-FFT, and MIC-FFT in this example) 
that you want to configure.

2. Click the Data tab, and then click the Function tab.

3. For this example, configure the settings of this tab as follows:

a. For Spectrum Function, select AutoSpectrum.

b. For IntegrationType, select None.

c. For Display Function, select Amplitude.

4. Click the Scaling tab, and configure the settings of this tab as follows:

a. For dB/Linear, select Linear.

b. For RMS/Peak/PkPk, select RMS.
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5. Click the Averaging tab, and configure the settings of this tab as follows:

a. Select the Enable Averaging checkbox.

b. For Averaging Type, select Linear.

c. For Averaging Mode, select RMS.
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Add FRF Channels to the Plot and Data Config Window

The following steps show how to use the FFT Analyzer interface of QuickDAQ to add two 
FRF channels to the Plot and Data Config window to calculate the frequency response of 
analog input channel 0 (DAC) and analog input channel 1 (Acc), and analog input channel 0 
(DAC) and analog input channel 2 (MIC).

1. Click the Add 2 channel FFT function (  ) button, select FRF, and then select 
DT9837-A(02).Acc.
The Acc-FRF channel is added to the Plot and Data Config window.

2. Click the Add 2 channel FFT function (  ) button, select FRF, and then select 
DT9837-A(02).MIC.
The MIC-FRF channel is added to the Plot and Data Config window.

Configure the FRF Channels

The following steps show how to use the FFT Analyzer interface of QuickDAQ to configure 
the parameters used to generate the FRF channels for the analog input channels:

1. Under the Channel Name column in the Plot and Data Config window, hold down the 
Ctrl key and select the FRF channels (Acc-FRF and MIC-FRF in this example) that you 
want to configure.

2. Click the Data tab, and then click the Function tab.



Examples Using the FFT Analyzer Interface
3. For the Acc-FRF channel, configure the settings of this tab as follows:

a. For FRF Estimator, select H1 (reduces noise on the response channel).

b. For Reference Channel, select DAC (analog input channel 0).

c. For Display Function, select Amplitude.

d. For FRF Mode, select Inertance (Acceleration/Force).

4. Click the Scaling tab, and select Linear for dB/Linear:
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5. Click the Averaging tab, select the Enable Averaging checkbox, and select Linear for 
Averaging Type:
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Add Coherence Channels to the Plot and Data Config Window

The following steps show how to use the FFT Analyzer interface of QuickDAQ to add 
Coherence channels to the Plot and Data Config window:

1. Click the Add 2 channel FFT function (  ) button, select Coherence, and select 
DT9837-A(02).Acc.
The Acc-Coherence channel is added to the Plot and Data Config window.

2. Click the Add 2 channel FFT function (  ) button, select Coherence, and select 
DT9837-A(02).MIC.
The MIC-Coherence channel is added to the Plot and Data Config window.

Configure the Coherence Channel

The following steps show how to use the FFT Analyzer interface of QuickDAQ to configure 
the parameters used to generate the Coherence channels for the analog input channels:

1. Under the Channel Name column in the Plot and Data Config window, hold down the 
Ctrl key and select the Coherence channels (Acc-Coherence and MIC-Coherence in this 
example) that you want to configure.

2. Click the Data tab, and then click the Function tab.
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3. For this example, configure the settings of this tab as follows:

a. For Coherence Function, select Coherence.

b. For Reference Channel, select DAC (analog input channel 0).

Note: Linear scaling is selected automatically for Coherence channels under the Scaling 
tab.

4. Click the Averaging tab, and select Linear for Averaging Type:
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Configure the Appearance of the Channel Plot Window

Perform the following steps to configure the appearance of the Channel Plot window:

1. Select the Visible Plot checkbox for the DAC, DAC-FFT, MIC, MIC-Coherence, MIC-FRF, 
and MIC-FFT channels.

2. Select the Show Cursor checkbox for the MIC-FRF channel.

3. Under Plot Column, select plot column 1 for the DAC, DAC-FFT, MIC, and MIC-FFT 
channels, and select plot column 2 for the MIC-Coherence and MIC-FRF channels.

4. Under the Signal Group column, select group A for the DAC and MIC channels, and 
leave None as the signal group for the rest of the channels.

5. Assign a unique color to each trace for the visible channels, if desired.

6. Click the Channel Plot - Control tab.
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7. Slide the Plot height bar to the left until you can see all 5 plots on the Channel Plot 
window at once.
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Start the Simultaneous Burst Random Output and Analog Input 
Operation

Once you have configured the channels and the parameters for the Channel Plot window, 
click the Record toolbar button (  ) or press the F5 key.

You will hear the waveform three times as it is output from the audio speaker. Results similar 
to the following are displayed in the Channel Plot window.

In column 1, you can see the signal that is output from the analog output channel (DAC) and 
read in as analog input channel 0, and the signal that is measured by the microphone (MIC); 
this is Group A of the first plot. You can also see the FFT of the analog output channel (DAC) 
and the FFT of the microphone (MIC).

In column 2, you can see the coherence of the microphone (MIC) and the FRF of the 
microphone (MIC). In this example, the y-axis of the FRF plot is shown in log10 format 
(right-click the y-axis, select Y-Axis Setup..., and select Log10 for Lin/Log).

Note: If desired, you can show the data for the Acc, Acc-FFT, Acc-FRF, and Acc-Coherence 
channels by selecting the Visible Plot checkbox in the Channel Plot window.
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Example of Monitoring an Analog Output Signal
If you are using the FFT Analysis option or Advanced FFT Analysis option of QuickDAQ, you 
can use the following steps to monitor the output of an analog output signal on the device 
using an analog input channel.

In this example, a 3 V sine wave is output on analog output channel 0 of a DT9847-1-1 module. 
The analog output channel is connected to analog input channel 0 on the DT9847-1-1 module. 
The FFT Analyzer interface is used.

Configure the Analog Output Settings

For this example, configure the analog output channel as follows:

1. Click the Output tab of the Acquisition and Config window.
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2. Select the Enable checkbox to enable the analog output channel on the module.

3. For the Waveform type, select Fixed.

4. For Peak Voltage, enter 3 to output a ±3 V signal.
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5. For Offset, enter 0.

6. For Signal Type, select Sine to output a sine wave.

7. For Output Mode, select Continuous to output a waveform that repeats continuously.

8. For Frequency, select 100 Hz; this is the frequency of the output waveform. 

9. For Ramp Up Time, enter 0.

10. For the Start/Stop Method, select With Acquisition.
The analog output operation will start when you start acquisition.

11. If desired, hide the Acquisition Config window by clicking the Auto-Hide pin (  ) in 
the top, right corner of the window.

Configure the Analog Input Channel

Configure the analog input channel as follows:

1. Ensure that the output from analog output channel 0 is connected to the input of analog 
input channel 0.

2. Configure the analog input channel by clicking the Input Channel Configuration toolbar 
button (  ) or by clicking the Configuration menu and clicking Input Channel 
Configuration.

3. Enable analog input channel 0 by clicking the Enable checkbox next to the channel.

4. Under the Channel Name column, leave the default channel name as Ain 0. 

5. Under the Ref/Resp column, select Response for the analog input channe1.

6. Under the Range column, select the input range for analog input channel. 
In this example, ±10 V is used.
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7. Under the Coupling column, select the coupling type (AC or DC) for your sensor. 
Since this example is monitoring a voltage input, DC is used.

8. Under the Current Source column, select whether to enable or disable use of the 4 mA 
current source on the data acquisition device. 
Since this example is monitoring a voltage input, the Current Source checkbox is not checked 
(disabled) for the analog input channel.

9. Under the Engineering Units column, select the engineering units for the input.
In this example, V is used.

10. Enter the number of mV per engineering unit in the mV/EU field.
In this example, 1000 is used.

11. If an offset is specified for the input, enter the value in the EU Offset field.
In this example, no offset (0) is specified.

12. If desired, enter a test point value for the channel. 
In this example, 0 is used.

13. If desired, enter a sensor direction for each channel. 
In this example, Scalar is used.

14. Click Close to close the Configure Devices dialog box.
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Configure the Recording Settings

For this example, configure the recording settings as follows:

1. Click the Recording tab of the Acquisition Config window.

2. For Filename generation, use the Filename option.

3. For Filename, use the default name for the data file.

4. Leave the Enable Continuous Acquisition checkbox unchecked.

5. For Number of Averages, enter 4 as the number of records to acquired, process, and 
average before acquisition stops.
The number of seconds for the total run and the amount of available disk space are shown.
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Configure the Frequency Settings

For this example, configure the frequency settings as follows:

1. Click the Freq tab of the Acquisition Config window.

2. In the Maximum frequency to analyze text box, enter 2000 as the bandwidth or span, in 
Hz, of the input signals that you want to analyze 
Internally, the sampling rate of the data acquisition device is set to twice the bandwidth, or 4000 
Hz in this example.

3. In the FFT Size text box, select 1024 from the drop-down combo box as the number of 
data points to use for the FFT calculation.
The number of spectral lines and the frequency resolution are displayed.
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Configure the Trigger Settings

For this example, configure the trigger settings as follows:

1. Click the Trigger tab of the Acquisition Config window.

2. For the Trigger Source, select Free Run to ensure that the measurement starts as soon as 
the Record button is clicked.
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Configure the Windowing Function

For this example, configure the windowing function as follows:

1. Click the Window tab of the Acquisition and Config window.
The Window tab for the Advanced FFT Analysis option of QuickDAQ is shown. The FFT Analysis 
option does not use the response and reference window terms and does not support the reference 
window type.

2. For the Response Window Type (Advanced FFT Analysis option) or Window Type (FFT 
Analysis option), select Rectangular.
This is a global setting that is applied to the FFTs for all enabled analog input channels.

3. If you are using the Advanced FFT Analysis option, select Same As Response for the 
Reference Window Type.
This example does not use reference channels.

4. If desired, hide the Acquisition Config window by clicking the Auto-Hide pin (  ) in 
the top, right corner of the window.
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Configure the Appearance of the Statistics Window

In this example, we want to look at the dynamic performance statistics of the analog output 
signal that is monitored by the analog input channel.

To configure the appearance of the statistics window, perform the following steps:

1. Click the Statistics tab and drag it to the lower section of the display area under the 
Channel Plot window, resizing it as desired:
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2. In the Plot and Data Config window, check the Visible Plot and Visible Statistics 
checkboxes.

3. Click the Stats tab, and configure it as follows:

a. Select the Show Dynamic Performance Stats checkbox.

b. Select the Show Min/Max/Mean Stats checkbox.
373



Chapter 8

374
Start the Operation

Once you have configured the channels and the application parameters, click the Record 
toolbar button (  ) or press the F5 key to start the operation.

Results similar to the following are displayed in the Channel Plot window, showing the 
output of analog output channel 0 as measured by analog input channel 0, and the statistics 
for the channel.
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Example of Using a Digital Filter
This example shows how to use a low-pass digital filter to eliminate unwanted 
high-frequency signals from your data. 

In this example, a function generator, which is generating a 1 kHz output signal with an 
amplitude of approximately 6 V, is attached to analog input 0 of a DT9837A module.

Configure the Input Channel

To configure the input channel, perform the following steps:

1. Click the Input Channel Configuration toolbar button (  ) or click the Configuration 
menu and click Input Channel Configuration.

2. Enable analog input channel 0 by clicking the Enable checkbox for this channel.

3. Under the Range column, select the an input range of ±10 V for the signal. 

4. Under the Engineering Unit (EU) column, select V for voltage.

5. Leave the remainder of the settings at their default values.

6. Click Close.
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Configure the Recording Settings

For this example, configure the recording settings as follows:

1. Click the Recording tab of the Acquisition Config window.

2. For Filename generation, use the Filename-Sequence option.

3. For Filename, use the default name for the data file.

4. Check the Enable Continuous Acquisition checkbox.
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Configure the Frequency Settings

Configure the frequency settings as follows:

1. Click the Freq tab of the Acquisition Config window.

2. In the Maximum frequency to analyze text box, enter 26367 as the bandwidth or span, in 
Hz, of the input signals that you want to analyze 
Internally, the sampling rate of the data acquisition device is set to twice the bandwidth, or the 
maximum rate of the module (52734 Hz) in this example.

3. In the FFT Size text box, select 1024 from the drop-down combo box as the number of 
data points to use for the FFT calculation.
The number of spectral lines and the frequency resolution are displayed.
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Configure the Trigger Settings

For this example, configure the trigger settings as follows:

1. Click the Trigger tab of the Acquisition Config window.

2. For the Trigger Source, select Free Run to ensure that the measurement starts as soon as 
the Record button is clicked.
In this mode, the Trigger Mode is not used.
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Open the Digital Filter Configuration Dialog

For this example, open the Digital Filter Configuration dialog by clicking the Digital Filter 
Configuration toolbar button (  ) or by clicking the Configuration menu and clicking 
Digital Filter Configuration.

For now, leave the default settings for analog input channel 0, so that no digital filter is 
applied.

Leave this dialog open.
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Start the Acquisition

Once you have configured analog input channel 0 and the application parameters, click the 
Record toolbar button (  ) or press the F5 key to start the operation.

Results similar to the following are displayed in the Channel Plot window, showing the 
unfiltered 1 kHz signal that is generated by the function generator. 

Let acquisition continue to run, and go to the next step.

Figure 43: Unfiltered 1 kHz Signal
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Configure the Digital Filter Configuration Dialog

While acquisition is running, change the settings in the Digital Filter Configuration dialog to 
configure a Bessel low-pass filter for analog input channel 0.

Configure the filter as follows:

1. Under the Filter Type column, select Bessel.

2. Under the Filter Category column, select LowPass.

3. Under the Filter Order column, select 4.

4. Under the Cutoff Freq 1 column, enter 500. This is the frequency above which the signals 
will be attenuated.

5. Click Apply.

The attenuated signal is displayed. In this example, a low-pass filter is used so that all 
frequencies above 500 Hz are attenuated.
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Figure 44: Attenuated 1 kHz Signal Using a Bessel Low-Pass Filter (500 Hz Cutoff Frequency)
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Troubleshooting 
If you are performing an acquisition for a long duration, you may see that acquisition stops if 
your computer’s power options are not set correctly. If this problem occurs, do the following 
to change the power options of your computer:

1. Go to the Control Panel application for your computer.

2. Select Power Options.

3. For the Put the Computer to Sleep option, select Never.

Should you experience other problems using QuickDAQ, do the following: 

1. Read all the appropriate sections of this manual, including any “Read This First” 
information.

2. Check for a README file on the CD. If present, read this file for the latest installation and 
usage information. 

3. Check that you have installed your data acquisition devices properly. For information, 
refer to the documentation supplied with your devices. 

4. Check that you have installed the latest device drivers for your data acquisition devices. 
For information, refer to the documentation supplied with your devices. 

5. Check that you have installed your software properly. For information, refer to page 26 

6. Search the Data Translation web site (www.datatranslation.com) for information about 
QuickDAQ. 

7. Search the Knowledgebase in the Support section of the Data Translation web site (at 
www.datatranslation.com) for an answer to your problem. 

If you are still having problems, Data Translation’s Technical Support Department is available 
to provide technical assistance to licensed users.
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Technical Support 
If you have any difficulty using QuickDAQ, Data Translation’s Technical Support Department 
is available to provide technical assistance.

To request technical support, go to our web site at http://www.datatranslation.com and click 
on the Support link. 

Note: Any unhandled exceptions that occur when running QuickDAQ are captured and 
displayed in a dialog box; these exceptions are also appended to a file called 
QuickDAQErrLog.log off the root directory (C:\QuickDAQErrLog.log). If you receive an 
unhandled exception, please email the QuickDAQErrLog.log file to the Data Translation 
Technical Support Department at support@datx.com.

When requesting technical support, be prepared to provide the following information:

• The version of QuickDAQ that you are using

• The serial number of your data acquisition device
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Absolute Amplitude of Peak
The largest peak measured from the reference value to the top of the peak. An example 
follows:

Accelerometer
A type of sensor that produces an output voltage that is proportional to acceleration.

Acquisition
Data from a specified list of analog input, tachometer, and/or counter channels is collected by 
a data acquisition device at a specified rate.

Amplitude Display Function
Plots the length of the frequency response.

Apparent Mass
An FRF mode that is calculated as the Force of the Reference Channel/Acceleration of the 
Response Channel. It is the recipriocal function of Inertance.

Auto Spectrum
A single-channel display function that plots the power of a periodic frequency component at a 
discrete frequency. For an accelerometer, for example, the units for Auto Spectrum are 
represented as g2. Typically, Auto Spectrum is best for narrowband, deterministic signals. 

Average
A series of measurements that are combined to create a result. The results from the last 
completed measurement are combined, point by point, with the results from the previous 
measurement. The combined results are retained and displayed as they are updated.

Bartlett Window
Triangular window. 
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Blackman Window
Similar to the Hanning and Hamming windows, this window has slightly wider central lobes 
and less sideband leakage.

Blackman Harris Window
Similar to Hanning window, this window has a slightly wider main lobe but much better 
dynamic range. It is optimized to provide the minimum side lobe level. 

dB
Decibels. The decibel scale is a transformation of the linear scale into a logarithmic scale. A 
decibel is defined as follows:

dB = 20 * log10 (Voltage/RefVolt)

where RefVolt is the dB Reference value.

dB Reference
The reference value (RefVolt) that is used when computing values into the decibel scale: 

dB = 20 *log10 (Voltage/RefVolt)

dB Reference is expressed in the selected engineering units, such a V for voltage.

Channel
In QuickDAQ, a channel is either a single input of a data acquisition device that is sampled 
periodically to generate data, the resultant FFT on the data from an input channel, or the result 
of an FRF, coherence, or cross spectrum function on the data from an input channel.

Chirp
A signal in which the frequency increases (sometimes called an up-chirp) or decreases 
(sometimes called a down-chirp) with time.

Coherence Function
A two-channel display function that evaluates the linearity between the input (reference) 
signal and the output (response) signal at each frequency, and generates a value between 0.0 
and 1.0, where 0 is consistently not linear and 1.0 is consistently linear.

Compliance
An FRF mode that is calculated as the Displacement of the Response Channel/Force of the 
Reference Channel.

Cosine Taper
This window allows you to specify the percentage of the period to allow the signal to come 
through unaltered before smoothing the signal ends to zero.

Cross Spectrum Function
A two-channel display function of the frequency domain. It contains a building block that is 
used in FRF and other more advanced functions. It is the product of the complex Fourier 
spectrum of the response channel multiplied by the complex conjugate of the Fourier 
spectrum of the reference channel.



Dynamic Stiffness
An FRF mode that is calculated as the Force of the Reference Channel/Displacement of the 
Response Channel.

Double Integration
Double integration results in displacement (the engineering units change and are denoted 
with  “~~”).

ENOB
Effective Number of Bits, returned in bits, represents the quality of a digitized signal. The 
input signal is typically sinusoidal and should be near full-scale to properly characterize the 
A/D converter and/or system. Refer to page 244 for more information.

EU
Engineering Unit.

Exponential Averaging
With exponential averaging, new FFT data is weighted differently than older FFT data.

You specify the weighting factor to apply, which either increases or decreases the effect of the 
new FFT data on the average. This is a continuous averaging mode.  

Exponential Window
Typically applied to the response channel in impact testing applications, this window is equal 
to 1.0 at the beginning of the record and decays exponentially to a smaller value at the end of 
the record. You can specify a value between 0 and 1 as the Exp Factor. This value indicates how 
much to decay the signal, allowing you to tailor the resultant FFT to the relevant data in the 
record.

FFT
Fast Fourier Transform (FFT). A technique for calculating the frequency components in a 
time-domain waveform based on digitized voltage measurements. The result is a display of 
amplitude versus frequency and phase versus frequency.  

FFT Window Type
FFT windows are frequency weighting functions that are applied to the time domain data. An 
FFT window is typically applied to reduce spectral leakage errors that are associated with 
finite-duration time signals.

By multiplying each data frame by a suitable time-domain weighting window, an FFT 
window smooths the data, creating peaks in the middle frequencies and decreasing to zero at 
the edges.

The following table provides general information about each window type to help you choose 
which to use:
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Flat Top Window
Optimized for measuring peak amplitudes of discrete spectral components that are separated 
by several spectral lines. Recommended for use when your signal content consists of sine 
waves and amplitude accuracy is important.

Force Window
Typically applied to the reference window in impact testing applications, allows you to 
specify the percentage of the signal period to which the rectangular window is applied. Data 
outside the selected percentage is forced to zero. 

You can enter the percentage of the period at which the rectangular window starts, as well as 
the percentage of the signal period at which the rectangular window stops. 

Table 3: FFT Window Types 

Window Description

Rectangular No window. Recommended for use when your signal content contains random noise (white 
noise) or closely spaced sine waves.

Hanning Bell-shaped cosine window typically used to analyze continuous signals. Recommended 
for use when your signal content contains sine waves, a combination of sine waves, 
vibration data consisting of narrowband random signals, or unknown content.

Hamming Bell-shaped cosine window optimized to minimize the maximum (nearest) side lobe. 
Recommended for use when your signal content consists of closely spaced sine waves.

Bartlett Triangular window. 

Blackman Similar to the Hanning and Hamming windows, this window has slightly wider central lobes 
and less sideband leakage.

Blackman Harris Similar to Hanning window, this window has a slightly wider main lobe but much better 
dynamic range. It is optimized to provide the minimum side lobe level.  

Flat Top Optimized for measuring peak amplitudes of discrete spectral components that are 
separated by several spectral lines. Recommended for use when your signal content 
consists of sine waves and amplitude accuracy is important.

Exponential Typically applied to the response channel in impact testing applications, this window is 
equal to 1.0 at the beginning of the record and decays exponentially to a smaller value at 
the end of the record. You can specify a value between 0 and 1 as the Exp Factor. This 
value indicates how much to decay the signal, allowing you to tailor the resultant FFT to the 
relevant data in the record.

Cosine Taper This window allows you to specify the percentage of the period to allow the signal to come 
through unaltered before smoothing the signal ends to zero.

Force Typically applied to the reference window in impact testing applications, allows you to 
specify the percentage of the signal period to which the rectangular window is applied. 
Data outside the selected percentage is forced to zero. 

You can enter the percentage of the period at which the rectangular window starts, as well 
as the percentage of the signal period at which the rectangular window stops. 

By applying this window to the output of a transducer, you can avoid collecting extraneous 
signals, such as forces from the retraction of a hammer, that are not important to the 
measurement. 



By applying this window to the output of a transducer, you can avoid collecting extraneous 
signals, such as forces from the retraction of a hammer, that are not important to the 
measurement. 

Frequency Domain
When plotted, amplitudes are graphed in relation to frequency. Also see Time Domain.

FRF (Frequency Response Function)
A two-channel function that represents the complex ratio between the output (response) 
signal and the input (reference) signal as a function of frequency. By choosing a FRF estimator, 
you can determine how the FRF is calculated.

FRF Estimator
The FRF Estimator determines how the frequency response is calculated. You can choose one 
of the following settings for FRF Estimator:

• H1 – Reduces noise on the response channel. It is calculated as follows:

H1 = Sxf/Sff

where, 

Sxf represents the average cross power spectrum between the response and the reference 
signals.

Sff represents the average auto power spectrum of the reference signal.

• H2 – Reduces noise on the reference channel. It is calculated as follows:

H2 = Sxx/Sfx

where, 

Sxx represents the average auto spectrum of the response signal.

Sfx represents the average cross power spectrum between the response and the reference 
signals.

• H3 – Reduces noise on both the reference and response channels. H3 is computed as 
follows:

H3 = (H1 + H2)/2

g
Acceleration in relation to earth’s gravity, where 1g = 980 cm/s2 or 32.2 ft/s2.

Gain
The factor by which to amplify a signal to allow greater resolution.

Hamming Window
Bell-shaped cosine window optimized to minimize the maximum (nearest) side lobe. 
Recommended for use when your signal content consists of closely spaced sine waves

Hanning Window
Bell-shaped cosine window typically used to analyze continuous signals. Recommended for 
use when your signal content contains sine waves, a combination of sine waves, vibration data 
consisting of narrowband random signals, or unknown content.
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H1
This FRF Estimator mode reduces noise on the response channel. It is calculated as follows:

It is calculated as follows:

H1 = Sxf/Sff

where, 

Sxf represents the average cross power spectrum between the response and the reference 
signals.

Sff represents the average auto power spectrum of the reference signal.

H2 
This FRF Estimator mode reduces noise on the reference channel. It is calculated as follows:

H2 = Sxx/Sfx

where, 

Sxx represents the average auto spectrum of the response signal.

Sfx represents the average cross power spectrum between the response and the reference 
signals.

H3 
This FRF Estimator mode reduces noise on both the reference and response channels. H3 is 
computed as follows:

H3 = (H1 + H2)/2

IBF
Input below full-scale, in dB, represents the level of the main signal component relative to the 
full-scale voltage. Refer to page 237 for more information.

Inertance
An FRF mode that is calculated as the Acceleration of the Response Channel/Force of the 
Reference Channel.

Impedance
An FRF mode that is calculated as the Force of the Reference Channel/Velocity of the 
Response Channel.

Integration
Integration is calculated by dividing each element of the function by (jw)^n, where j is the 
square root of -1; w is the product of 2 pi times the frequency of the block element; and n is an 
integer from +2 to -2.

If you specify an accelerometer as the sensor type, single integration results in velocity (the 
engineering units change and are denoted with  “~”), and double integration results in 
displacement (the engineering units change and are denoted with  “~~”).



Linear
Data in the FFT is plotted in the engineering units of the specified signal, such as V for voltage 
or g for acceleration.

Linear Averaging
Data from each FFT is averaged with the data from the other FFTs; all data contributes equally 
to the average.

Magnitude
The FFT of a real signal is a complex number, having a real and an imaginary part. The 
magnitude is the square root of the sum of the squares of the real and imaginary parts.

Mobility
An FRF mode that is calculated as the Velocity of the Response Channel/Force of the 
Reference Channel.

Nyquist Display Function
This display function plots the resultant data in complex form, with real components on the 
x-axis and imaginary components on the y-axis. It used to assess the stability and performance 
of a closed loop system by analyzing the contour of the frequency response function on the 
complex plane.

Peak Height
The largest peak measured from the bottom of the peak to the top of the peak:
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Peak Scaling
The absolute value of the data from zero to the peak.

For example, the FFT plot for the above signal, appears as follows, where the peak height is 
just over 5 V:

Peak Hold Averaging
Each new FFT data point is compared with the current FFT data point, and the highest 
amplitude (peaks) from each FFT are retained. This is a continuous operation that combines 
the results of several measurements into a final FFT measurement.

Phase Display Function
Plots the frequency response phase shift (angle).

Pink Noise
Pink noise is sometimes referred to as 1/f or flicker noise. In the frequency domain, the 
response is not flat. The power spectral density is inversely proportional to the frequency. 
Therefore, as the frequency increases, the power density decreases.



Pk-Pk Scaling
The absolute value of the data from the negative peak to the positive peak.

Power
The power in each frequency component represented by the FFT is calculated by squaring the 
magnitude of the frequency component.  

Power Spectral Density (PSD)
The power of random vibration intensity as “mean-square acceleration per frequency unit.” 
The spectrum is computed by squaring the magnitude of each frequency component in the 
FFT, and dividing this number by the change in frequency multiplied by the equivalent noise 
bandwidth of the windowing function (ENBW). For an accelerometer, for example, the units 
for PSD are represented as g2/Hz.   Typically, PSD is best for wideband, continuous signals.

Ramp Waveform
A non-sinusoidal waveform that ramps up and then drops sharply. This is sometimes called a 
sawtooth waveform.

Random Noise
White noise that is created with a software generator function. With white noise, the signal has 
a flat response in the frequency domain; it has an equal power in any band of a given 
bandwidth (power spectral density). In the time domain, the amplitudes of the signal form a 
flat histogram since all amplitude values are equally probable.

Random Normal Noise
White noise whose amplitude in the time domain has a Gaussian or normal distribution. The 
frequency content is the same as the Random noise type, having a flat response in the 
frequency domain. 

Record
A block of data whose length is equal to the size of the FFT. 

Rectangular Window
No window. Recommended for use when your signal content contains random noise (white 
noise) or closely spaced sine waves.
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RMS
Root Mean Square. The square root of the average of the square of the value of the function 
taken throughout one period.

SFDR
Spurious free dynamic range, returned in dB, represents the level of the full-scale range to the 
greatest noise or distortion component. Refer to page 240 for more information.

SINAD
Signal-to-noise and distortion ratio, returned in dB, represents the level of the main signal 
component relative to the total noise, VRMS, including harmonics. Refer to page 241 for more 
information.

Sine Waveform
A sinusoidal, periodic waveform.

Single Integration
If you specify an accelerometer as the sensor type, single integration results in velocity (the 
engineering units change and are denoted with  “~”). 

SNR
Signal-to-noise ratio, returned in dB, represents the level of the main signal component 
relative to the total noise, VRMS. Refer to page 243 for more information.



Spectral Density
The spectral density describes how the variance of time-series data is distributed with 
frequency. It is computed as follows:

          ________ Spectrum _________   
Change in Frequency x ENBW

where, 

ENBW is the Equivalent Noise Bandwidth of the Windowing function.

For example, if you select PSD (Power Spectral Density) for the Spectrum Function setting 
when configuring the FFT parameters, the spectrum is computed by squaring the magnitude 
of each frequency component in the FFT, dividing this number by the change in frequency 
multiplied by the ENBW, and plotting the results. For example, if measuring acceleration with 
these settings, the units for power spectral density are represented as g2/Hz.

Spectral Leakage
When the signal being analyzed is not periodic, energy from a signal at a specified frequency 
can leak into nearby spectral bins causing spectral amplitude inaccuracies; this is called 
spectral leakage. 

Applying a windowing function controls, but doesn’t completely eliminate, the error by 
multiplying each data frame by a suitable time-domain weighting window.

Spectrum
The frequency spectrum is a representation of a time-domain signal in the frequency domain. 
It is generated by performing an FFT on the signal.  

For example, if you select Spectrum for the Spectrum Function setting when configuring the 
FFT parameters, the spectrum is computed by taking the magnitude of each frequency 
component in the FFT and plotting the results. For example, if measuring acceleration with 
these settings, the units are in g. Typically, Spectrum is best for narrowband, deterministic 
signals.

Square Waveform
A non-sinusoidal waveform that is shaped like a square, alternating between two levels. 

Sweep Waveforms
A sine wave whose frequency changes over time. Swept sine waves provide the ability to test 
a device over a wide frequency range to determine if any resonances occur. 

THD
Total harmonic distortion, returned in dB and %, represents the level of the harmonic 
distortion of the first five harmonics relative to the main signal component. Refer to page 238 
for more information. 

Time Domain
When plotted, amplitudes are graphed in relation to time. Also see Frequency Domain.
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Triangle Waveform
A non-sinusoidal waveform that is shaped like a triangle.

Trigger
An event that starts data acquisition. QuickDAQ supports a number of trigger types, 
including a software trigger, external TTL trigger, and a hardware or software threshold 
trigger.
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A
A coefficients

RTD 93
thermistor 95

About menu option 48
absolute amplitude priority 226
AC coupling 98
acceleration 208, 215, 219
acceleration measurement example 266
Accept button 81, 134
Acquisition Config window

Acquisition tab (Data Logger interface) 125
Freq tab (FFT Analyzer interface) 59, 128
Output tab 56, 61, 138
Recording tab (Data Logger interface) 119
Recording tab (FFT Analyzer interface) 57, 122
Trigger tab (FFT Analyzer interface) 60, 131
Window tab (Advanced FFT Analyzer option) 61, 

136
Window tab (FFT Analysis option) 61, 135

acquisition duration 120
acquisition mode 20
Acquisition Status window

Data Logger interface 81
FFT Analyzer interface 81

Acquisition tab (Data Logger interface) 55, 125
adding channels

Advanced FFT Analysis option 202
Coherence 204
Cross Spectrum 204
FFT Analysis option 202
Frequency Response Function (FRF) 204
single-channel FFT 203
time-domain channel 205
two-channel FFT 204
windowed time-domain channel 204

Advanced FFT Analysis option 19
amplitude display 208, 214, 219
amplitude priority 226
analog input channel settings

A coefficient, RTD 93
A coefficient, thermistor 95
B coefficient, RTD 93
B coefficient, thermistor 95
bridge type 107
C coefficient, RTD 94

C coefficient, thermistor 95
calibrate 103, 108
channel name 88
Configuration and Calibration wizard 100
coupling type 98
current 97
current source 98
direction 99
enable termination resistor 90, 97
enabling channels 87
engineering units 89, 91, 94, 95, 96, 97, 98, 103, 

107, 112
excitation voltage 103, 107
gage factor 107
IEPE 98
input type 88
lead wire resistance 103, 107
maximum range 107
minimum range 107
nominal gage 103, 107
point # 90, 91, 94, 95, 96, 97, 99, 113
Poisson ratio 108
range 88, 98
reference channel 88
remote sense lines 103, 107
resistance 95
resistance range 95
response channel 88
RTD R0 coefficient 93
RTDs 91
sensor offset value 89, 91, 94, 95, 96, 97, 99, 113
sensor scaling factor 89, 99
sensor scaling value 113
sensor type 88, 90, 91, 95
sensor wiring 94, 95, 96
shunt resistor 100
strain 100
thermistors 94
thermocouples 90
transducer capacity 103
transducer rated output 103
voltage 88

analog threshold negative edge trigger 126, 132
analog threshold positive edge trigger 126, 132
apparent mass 215
AppData folder 36
Apply settings to current data button 207
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auto retrigger 134
auto spectrum function 208
Auto-Hide pin 52
Auto-reprocess on parameter change checkbox 207
average 124
averaging mode 212
Averaging tab

Coherence channel 224
Cross Spectrum channel 221
FFT channels 211
FRF channels 217

averaging type 212, 217, 221, 224
Axes Scroll control 71
Axes Zoom control 72
axis color

Data Logger interface 179
FFT Analyzer interface 200

Axis Mouse Mode 46
Scroll 46
Zoom 46

B
B coefficients

RTD 93
thermistor 95

background color
Channel Display window (Data Logger interface) 

184
Channel Display window (FFT Analyzer 

interface) 232
Channel Plot window (Data Logger interface) 179
Channel Plot window (FFT Analyzer interface) 

200
backup configuration file 44
band power cursor style 74
bands, signal

Data Logger interface 174
FFT Analyzer interface 196

bandwidth 128
Bartlett window 135, 136
Base 18
Bessel filter 163
Blackman window 135, 136
BlackmanHarris window 135, 136
bridge configuration

Full Bridge Axial Poisson 107
Full Bridge Bending 107
Full Bridge Bending Poisson 107
Half Bridge Bending 107
Half Bridge Poisson 107

Quarter Bridge 107
Quarter Bridge Temp Comp 107

bridge type 107
bridge-based sensor example 314
burst output mode 142, 157
burst random example 345
Butterworth filter 163
buttons 49

C
C coefficient 93
C coefficients

RTD 94
thermistor 95

calibrate 103, 108
channel configuration 127, 129
Channel Display - Control tab

Data Logger interface 182
FFT Analyzer interface 230

Channel Display - Style tab
Data Logger interface 184
FFT Analyzer interface 232

Channel Display window 78
background color (Data Logger interface) 184
background color (FFT Analyzer interface) 232
columns (Data Logger interface) 183
columns (FFT Analyzer interface) 231
Data Logger interface 180
data reduction method (Data Logger interface) 

183
data reduction method (FFT Analyzer interface) 

232
display update rate (Data Logger interface) 183
display update rate (FFT Analyzer interface) 231
displaying channels (Data Logger interface) 180
displaying channels (FFT Analyzer interface) 228
FFT Analyzer interface 228
foreground color (Data Logger interface) 184
foreground color (FFT Analyzer interface) 232
indicator style (Data Logger interface) 185
indicator style (FFT Analyzer interface) 233
label color (Data Logger interface) 184
label color (FFT Analyzer interface) 232
precision (Data Logger interface) 182
precision (FFT Analyzer interface) 231

channel name 88, 140
Configure Devices dialog 88, 140
Plot and Data Config window 234
Plot and Data Config window (Data Logger 

interface) 169, 180
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Plot and Data Config window (FFT Analyzer 
interface) 191, 228

Channel Plot - Control tab
Data Logger interface 177
FFT Analyzer interface 199

Channel Plot - Style tab
Data Logger interface 179
FFT Analyzer interface 200

Channel Plot window 66
axis color (FFT Analyzer interface) 200
background color (FFT Analyzer interface) 200
controls 71, 72, 73, 74, 75, 76
Data Logger interface 169
displaying channels (Data Logger interface) 169
displaying channels (FFT Analyzer interface) 191
displaying data cursors (FFT Analyzer interface) 

193
FFT Analyzer interface 191
grid line color (FFT Analyzer interface) 200
grouping signal bands (Data Logger interface) 

174
grouping signal bands (FFT Analyzer interface) 

196
specifying plot columns (Data Logger interface) 

172
specifying plot columns (FFT Analyzer interface) 

194
specifying the trace color (Data Logger interface) 

176
specifying the trace color (FFT Analyzer interface) 

198
trace thickness (FFT Analyzer interface) 200
x-axis label (FFT Analyzer interface) 201
y-axis label (FFT Analyzer interface) 201

channel visibility
Channel Display window (Data Logger interface) 

181
Channel Display window (FFT Analyzer 

interface) 229
Data Logger interface 170, 181
FFT Analyzer interface 192, 229, 235
Statistics window (Data Logger interface) 186
Statistics window (FTT Analyzer interface) 235

channels, enabling 87
Chebyshev filter 163
clock prescale 117
Close Hpf Data menu option 37
Coherence channels

adding 204
configuring 222

coherence function 223

Coherent Output Power function 223
color

axis (Data Logger interface) 179
axis (FFT Analyzer interface) 200
background of Channel Display window (Data 

Logger interface) 184
background of Channel Display window (FFT 

Analyzer interface) 232
background of Channel Plot window (FFT 

Analyzer interface) 200
background of the Channel Plot window (Data 

Logger interface) 179
foreground of Channel Display window (Data 

Logger interface) 184
foreground of Channel Display window (FFT 

Analyzer interface) 232
grid line (Data Logger interface) 179
grid line (FFT Analyzer interface) 200
label for the Channel Display window (Data 

Logger interface) 184
label for the Channel Display window (FFT 

Analyzer interface) 232
trace (Data Logger interface) 176
trace (FFT Analyzer interface) 198

Color column
Data Logger interface 176
FFT Analyzer interface 198

Comma Delimited Text file format 38, 40
compliance 215
Config folder 43
Configuration and Calibration wizard 100
configuration file 43

saving and loading 118
Configuration menu 46
configuring channels in the Plot and Data config 

window
Coherence channels 222
Cross Spectrum channels 218
FRF channels 213
single FFT 207

configuring digital filters 162
configuring input channels 84

analog input channels (current) 97
analog input channels (IEPE) 98
analog input channels (resistance) 95
analog input channels (RTDs) 91
analog input channels (strain) 100
analog input channels (thermistors) 94
analog input channels (thermocouples) 90
analog input channels (voltage) 88
changing the channel name 88
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counter channels 115
digital input 113
enabling channels 87
enabling termination resistor 90, 97
engineering units 89, 91, 94, 95, 96, 97
quadrature decoder channels 117
resistance range 95
selecting the input type 88
sensor offset value 89, 91, 94, 95, 96, 97
sensor scaling factor 89
sensor type 88, 90, 91, 95
sensor wiring 96
tachometer channels 113
test point number 90, 91, 94, 95, 96, 97

configuring statistic for FFT plots 225
configuring the plot style

Data Logger interface 179
FFT Analyzer interface 200

continuous acquisition 120, 123
continuous output mode 142, 157
Control tab

Channel Display (Data Logger interface) 182
Channel Display (FFT Analyzer interface) 230
Channel Plot (Data Logger interface) 177
Channel Plot (FFT Analyzer interface) 199

controls of the Channel Plot window 71
Axes Scroll 71
Axes Zoom 72
Copy to Clipboard 75
Data Cursor 74
Link Cursors to Selected 73
Link X Axes to Selected 72
Link Y Axes to Selected 73
Page Setup 76
Preview 76
Print 76
Save Plot Image 75
Select 73
Show Data Point Markers 76
Show Legend 76
Tracking Pause 71
Tracking Resume 71
Zoom All to Fit in View Y 72
Zoom Box 73
Zoom-In All 72
Zoom-Out All 72

conventions used 16
COP function 223
Copy plot data to clipboard menu option 44
Copy plot image to clipboard 44
Copy to Clipboard control 75

cosine taper window 137
counter settings 115

engineering units 115
mSec per Hz 115
start edge 116
stop edge 116

coupling type 98
cross power spectral density function 219
Cross Spectrum channels

adding 204
configuring 218

cross spectrum function 219
csv file format 38, 40
current source 98
cursor style

band power 74
frequency 74
peak-peak 74
period 74
value-XY 74

custom FRF mode 215
cutoff frequency 164

D
dash line style 75
dashdot line style 75
Data Cursor control 74
data cursors

Data Logger interface 171
FFT Analyzer interface 193

data file 36, 49
data file name 38, 41, 119, 120, 123
Data folder 39, 41, 42, 43, 75
Data Logger interface

Acquisition Config window 54
Acquisition Status window 81
Export Data 37
Lock to acquisition time 142, 146, 157
Open Current Data in Excel 42
Plot and Data Config window 63
Recording tab 119

Data Logger menu option 47
data reduction method

Data Logger interface 183
FFT Analyzer interface 232

data-cursor control
Data Logger interface 171
FFT Analyzer interface 193

dB reference 210, 220
dB ripple 165
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dB scaling 209, 216, 220
DC coupling 98
Device Selection window 27
device status 81
differential channel configuration 127, 129
Digital Filter Configuration button 50
Digital Filter Configuration menu option 162
Digital Filter Configuration toolbar button 162
digital filter example 375
digital filters 162
digital input settings 113
digits after decimal point 67, 69
disable plotting during acquisition

FFT Analyzer interface 199
disable plotting during acquisition (Data Logger 

interface) 177
displacement 208, 215, 219
Display Day checkbox (Data Logger interface) 178
display function

Advanced FFT Analysis option 208
Cross Spectrum channel 219
FFT Analysis option 208
FFT channel 208
FRF channel 214

display update rate
Data Logger interface 183
FFT Analyzer interface 231

displaying channels
Channel Display window (Data Logger interface) 

180
Channel Display window (FFT Analyzer 

interface) 228
Channel Plot window (Data Logger interface) 169
Channel Plot window (FFT Analyzer interface) 

191
displaying data cursors

Data Logger interface 171
FFT Analyzer interface 193

docking windows 51
dot line style 75
dynamic performance statistics 236
dynamic stiffness 215

E
edge of tachometer 114
edge sensitivity 226
edge, counters 116
Edit menu 44

Copy plot data to clipboard 44
Copy plot image to clipboard 44

editing label of x-axis 69
effective number of bits 244
enable averaging 212, 217, 221, 224
enable termination resistor 90, 97
enabling channel display

Channel Display window (Data Logger interface) 
181

Channel Display window (FFT Analyzer 
interface) 229

Channel Plot window (Data Logger interface) 170
Channel Plot window (FFT Analyzer interface) 

192
Statistics window (Data Logger interface) 186
Statistics window (FFT Analyzer interface) 235

enabling channels 87
enabling output channels 140
engineering unit offset 89, 91, 94, 95, 96, 97, 99, 113
engineering unit scaling 113
engineering units 89, 91, 94, 95, 96, 97

analog input 98, 103, 107, 112
counter 115
quadrature decoder 117
tachometer 113

ENOB 244
examples 265

acceleration measurement 266
bridge-based sensor 314
digital filter 375
free run swept sine 327
impact testing 281
strain gage 301
triggered burst random 345

excitation voltage 103, 107
Exit menu option 44
Exit without saving current configuration menu 

option 44
exponential averaging 212, 217, 221, 224
exponential frequency change (sweep) 145
exponential window 137
Export Data button 49
Export Data menu option 37

Data Logger interface 37
FFT Analyzer interface 39

external TTL negative-edge trigger 126
external TTL positive-edge trigger 126, 132

F
features 18
FFT Analysis option 18
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FFT Analyzer interface
Acquisition Config window 57
Acquisition Status window 81
Export Data 39
Lock to acquisition time 142, 146, 157
Lock to analysis frame time 142, 157
Open Current Data in Excel 42
Plot and Data Config window 64
Recording tab 122

FFT Analyzer menu option 47
FFT size 129
file formats

csv 38, 40
txt 38, 40
uff 40

File menu 36
Close Hpf Data File menu 37
Exit 44
Exit without saving current configuration 44
Export Data menu 37, 39
Load Configuration 43
New Hpf Data File 36
Open Current Data in Excel 42
Open Export Data Folder 43
Open Hpf Data File 36
Open Hpf Data Folder 43
Page Setup 44
Print 44
Print Preview 44
Save Configuration 43
Save Current Plot Image 42

file reader mode 20
filename base 120, 123
filename generation 38, 41, 119, 123
filter status indicator 163
filter type 126, 130
filters

band-pass 164
band-stop 164
Bessel 163
Butterworth 163
category 164
channels 163
Chebyshev 163
cutoff frequency 164
dB ripple 165
filter order 164
frequency response 165
high-pass 164
IIR 162
impulse response 165, 166

low-pass 164
status indicators 163
types 163

fixed waveforms 141
flat top window 136
force window 137
foreground color

Channel Display window (Data Logger interface) 
184

Channel Display window (FFT Analyzer 
interface) 232

format of axis
x-axis 69
y-axis 68

free run swept sine example 327
free run trigger 132
Freq tab (FFT Analyzer interface) 59, 128
frequency cursor style 74
frequency of acquisition 125
frequency response 165
FRF channels

adding 204
configuring 213

FRF estimator 214
FRF mode 215
Full Bridge Axial Poisson configuration 107
Full Bridge Bending configuration 107
Full Bridge Bending Poisson configuration 107
full-bridge-based sensor parameters 102
Function tab

Coherence channel 222
Cross Spectrum channel 218
FFT channels 207
FRF channels 214

G
gage factor 107
Gaussian distribution 153
getting started 27
glossary 387
grid line color

Data Logger interface 179
FFT Analyzer interface 200

gridlines
x-axis 69
y-axis 67

grouping signal bands
Data Logger interface 174
FFT Analyzer interface 196
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H
H1 214
H2 214
H3 214
Half Bridge Bending configuration 107
Half Bridge Poisson configuration 107
hammer impact test 281
Hamming window 135, 136
Hanning window 135, 136
hardware TEDS 102
header

Channel Plot window (Data Logger interface) 179
Channel Plot window (FFT Analyzer interface) 

200
height of the plot

Data Logger interface 178
FFT Analyzer interface 200

Help button 50
Help menu 48

About 48
License Info 48
User Manual 48

Hide Unused Channels checkbox
Data Logger interface 182
FFT Analyzer interface 230

Hide/show columns button
Color (Data Logger interface) 176
Color (FFT Analyzer interface) 198
Plot Column (Data Logger interface) 174
Plot Column (FFT Analyzer interface) 195
Show Cursor (Data Logger interface) 172
Show Cursor (FFT Analyzer interface) 194
Signal Group (Data Logger interface) 175
Signal Group (FFT Analyzer interface) 197
Visible Display (Data Logger interface) 181
Visible Display (FFT Analyzer interface) 229
Visible Plot (Data Logger interface) 170
Visible Plot (FFT Analysis interface) 192
Visible Statistics (Data Logger interface) 187
Visible Statistics (FFT Analyzer interface) 235

hiding columns
Color column (Data Logger interface) 176
Color column (FFT Analyzer interface) 198
Plot column (Data Logger interface) 174
Plot column (FFT Analyzer interface) 195
Show Cursor column (Data Logger interface) 172
Show Cursor column (FFT Analyzer interface) 

194
Signal Group column (Data Logger interface) 175

Signal Group column (FFT Analyzer interface) 
197

Visible Display column (Data Logger interface) 
181

Visible Display column (FFT Analyzer interface) 
229

Visible Plot column (Data Logger interface) 170
Visible Statistics column (Data Logger interface) 

187
Visible Statistics column (FFT Analyzer interface) 

235
hiding windows 52

I
IBF 237
IIR filters 162
imaginary display 208, 214, 219
impact testing example 281
impedance 215
impulse response 165, 166
index mode 117
indicator style

Channel Display window (Data Logger interface) 
185

Channel Display window (FFT Analyzer 
interface) 233

inertance 215
input below full-scale 237
Input Channel Configuration button 50
Input Channel Configuration menu option 84
Input Channel Configuration toolbar button 84
input type 88

Configure Devices dialog 88
input voltage range 88, 98, 127, 129
installing the software 26
integration type 208, 215, 219
interface 34
interval 121, 128
IP address 28

L
label

X-axis (Data Logger interface) 179
X-axis (FFT Analyzer interface) 201
Y-axis (Data Logger interface) 179
Y-axis (FFT Analyzer interface) 201
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label color
Channel Display window (Data Logger interface) 

184
Channel Display window (FFT Analyzer 

interface) 232
label for x-axis, editing 69
LAN triggers 132
lead wire resistance 103, 107
left edge 70
License Info menu option 48
licensing requirements 21
lin/log scaling

x-axis 69
y-axis 68

line style
dash 75
dashdot 75
dot 75
solid 75

linear averaging 212, 217, 221, 224
linear frequency change (sweep) 145
linear scaling 209, 216, 220, 223
Link Cursors to Selected control 73
Link Time Series Data checkbox 81, 227
Link X Axes to Selected control 72
Link Y Axes to Selected control 73
Load Configuration menu option 43
Lock to acquisition time 159

Data Logger interface 142, 146, 157
FFT Analyzer interface 142, 146, 157

Lock to analysis frame time 142, 146, 157, 159
Lock to analysis freq 158
log10 scaling 209, 216, 220, 223
logarithmic frequency change (sweep) 145
loop sweep mode 145
LXI triggers 132

M
maximum number of peaks to detect 226
maximum range 107
maximum RPM value 113
maximum value 244
mean value 244
menus 36

Configuration 46
Edit 44
File 36
Help 48
Mode 47
Plot 45

Record 45
Windows 46

minimum range 107
minimum value 244
mobility 215
Mode menu 47

Data Logger 47
FFT Analyzer interface 47

modes of operation 20
acquisition 20
file reader 20

monitoring the analog output signal 257, 364
moving columns

Color column (Data Logger interface) 176
Color column (FFT Analyzer interface) 198
Plot column (Data Logger interface) 174
Plot column (FFT Analyzer interface) 195
Show Cursor column (Data Logger interface) 172
Show Cursor column (FFT Analyzer interface) 

194
Signal Group column (Data Logger interface) 175
Signal Group column (FFT Analyzer interface) 

198
Visible Display column (Data Logger interface) 

181
Visible Display column (FFT Analyzer interface) 

229
Visible Plot column (Data Logger interface) 170
Visible Plot column (FFT Analyzer interface) 192
Visible Statistics column (Data Logger interface) 

187
Visible Statistics column (FFT Analyzer interface) 

235
moving windows 51
Multi-channel Actions button

Disable all Channels 87
Disable all Selected Channels 87
Enable all Channels 87
Enable all Selected Channels 87
Selected channels hidden in Channel Display 

(Data Logger interface) 181
Selected channels hidden in Channel Display 

(FFT Analyzer interface) 229
Selected channels hidden in Channel Plot (Data 

Logger interface) 170
Selected channels hidden in Channel Plot (FFT 

Analyzer interface) 192
Selected channels hidden in Statistics Display 

(Data Logger interface) 186
Selected channels hidden in Statistics Display 

(FFT Analyzer interface) 235
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Selected channels Plot Column (Data Logger 
interface) 173

Selected channels Plot Column (FFT Analyzer 
interface) 195

Selected channels Signal Group (Data Logger 
interface) 175

Selected channels Signal Group (FFT Analyzer 
interface) 197

Selected channels visible in Channel Display 
(Data Logger interface) 181

Selected channels visible in Channel Display (FFT 
Analyzer interface) 229

Selected channels visible in Channel Plot (Data 
Logger interface) 170

Selected channels visible in Channel Plot (FFT 
Analyzer interface) 192

Selected channels visible in Statistics Display 
(Data Logger interface) 186

Selected channels visible in Statistics Display (FFT 
Analyzer interface) 235

Selected data cursors hidden 171, 193
Selected data cursors visible 171, 193
Set all Channel Coupling 98
Set all Channel Current Source 98
Set all Channel Units 99
Set all Filter Types 164
Set all Multi-Range Channels 89
Set all RTD Channels 92
Set all Selected Channel Units 89, 99
Set all Thermocouple Channels 90
Set all Voltage Channel Units 89

muting the output signal 160
mV per engineering unit 89, 99

N
naming channels 88, 140, 234

Data Logger interface 169, 180
FFT Analyzer interface 191, 228

New HPF Data File button 49
New Hpf Data menu option 36
noise waveforms 150
nominal gage 103, 107
number of averages 124, 128
number of poles 164
number of records 124
number of scans 121, 128
Nyquist display 208, 214, 219

O
offset 89, 91, 94, 95, 96, 97, 99, 113, 140
offset nulling 103, 108
Open Current Data in Excel button 49
Open Current Data in Excel menu option

Data Logger interface 42
FFT Analyzer interface 42

Open Current Data in Excel toolbar button 42
Open Export Data Folder menu option 43
Open HPF Data File button 49
Open Hpf Data Folder menu option 43
Open Hpf Data menu option 36
order of filter 164
output frequency 141, 158
output frequency change 145
output mode 142, 157
Output tab 138

channel name 140
Data Logger interface 56
enabling channels 140
FFT Analyzer interface 61
muting and unmuting the output signal 160
offset 140
peak voltage 140
Start methods 159
Stop methods 159
waveform types 140

P
page left 70
page right 71
Page Setup control 76
Page Setup menu option 44
Pause menu option 45
pause tracking 70
peak detection 226
peak hold averaging 212
peak scaling 210, 220
peak to peak scaling 210, 220
peak voltage 140
peak-peak cursor style 74
period cursor style 74
phase display 208, 214, 219
pink noise 155
Plot and Data Config window 63

adding channels using the Advanced FFT 
Analysis option 202

adding channels using the FFT Analysis option 
202

Data Logger interface 63
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FFT Analyzer interface 64
removing channels 206

Plot Area Mouse Mode 45
Cursor 45
Select 45
Zoom 45

plot columns
changing the value for all channels at once (Data 

Logger interface) 173
changing the value for all channels at once (FFT 

Analyzer interface) 195
Data Logger interface 172
FFT Analyzer interface 194
moving (Data Logger interface) 174
moving (FFT Analyzer interface) 195
showing or hiding (Data Logger interface) 174
showing or hiding (FFT Analyzer interface) 195

plot header
Data Logger interface 179
FFT Analyzer interface 200

plot height
Data Logger interface 178
FFT Analyzer interface 200

Plot menu 45
Cursor (Plot Area Mouse Mode) 45
Scroll (Axis Mouse Mode) 46
Select (Plot Area Mouse Mode) 45
Zoom (Axis Mouse Mode) 46
Zoom (Plot Area Mouse Mode) 45

plot style
Data Logger interface 179
FFT Analyzer interface 200

plot update rate
Data Logger interface 177
FFT Analyzer interface 199

point # 90, 91, 94, 95, 96, 97, 99, 113
Poisson ratio 108
poles, filter 164
power options 384
power spectral density function 208
precision

Channel Display window (Data Logger interface 
182

Channel Display window (FFT Analyzer 
interface) 231

x-axis 69
y-axis 67

pre-trigger data 134
Preview control 76
Print control 76
Print menu option 44

Print Preview menu option 44
priority, absolute amplitude 226
PSD 208
pseudo random noise 158

Q
quadrature decoder channel settings 117
quadrature decoder settings 117

clock prescale 117
engineering units 117
index mode 117
pulses/rev 117
X4 scaling 117

Quarter Bridge configuration 107
Quarter Bridge Temp Comp configuration 107
QuickDAQ options

Advanced FFT Analysis 19
Base 18
FFT Analysis 18

R
R0 coefficients 93
ramp down time 142, 147, 158
ramp up time 142, 147, 158
ramp wave 141
random noise 151
random normal noise 153
range 88, 98
real display 208, 214, 219
record 124
Record button 49
Record menu 45

Pause 45
Start 45
Stop 45

Record Number 81, 227
Recording tab

Data Logger interface 54, 119
FFT Analyzer interface 57, 122

rectangular window 135, 136
reference channel 88, 214, 219, 223
reference integration 219
Reject button 81, 134
related documents 16
remote sense lines 103, 107
removing channels 206
requirements, licensing 21
Reset Windows Layout to Default Layout menu 

option 35, 47
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Reset Windows Layout to Last Saved menu option 
47

resetting the window layout 53
resistance range 95
resizing windows 51
resolution 23
response channels 88
response integration 219
resume tracking 70
retrigger 134
right edge 70
ripple, dB 165
RMS averaging 212, 236
RMS scaling 210, 220
RPM multiplier 114
RPM value 113
RTD channels

A coefficient 93
B coefficient 93
C coefficient 93
R0 coefficient 93

S
sample hpf file 36, 49
sample interval 121, 128
sample rate 121, 128
sampling frequency 125
sampling rate 128
Save Configuration menu option 43
Save Current Plot Image menu option 42
Save Plot Image control 75
scaling 113

x-axis 69
y-axis 67

Scaling tab
Coherence function 223
Cross Spectrum channel 220
FFT channels 209
FRF channels 216

scans 121, 128
scroll here 70
scroll left 71
scroll right 71
scrollbar, x-axis 45, 50, 70, 71
scrolling options 70

left edge 70
page left 70
page right 71
right edge 70
scroll here 70

scroll left 71
scroll right 71

scrolling through FFTs 227
seeing hidden files 36
Select control 73
selecting the type of input for the channel 88
sensitivity, edge 226
sensor direction 99
sensor offset value 89, 91, 94, 95, 96, 97, 99, 113
sensor scaling factor 89, 99
sensor scaling value 113
sensor type 88, 90, 91, 95
sensor wiring 94, 95, 96
setting up the x-axis 68
setting up the y-axis 67
SFDR 240
Show Cursor column

Data Logger interface 171
FFT Analyzer interface 193

show data cursors 171
Data Logger interface 171
FFT Analyzer interface 193

Show Data Point Markers control 76
Show Dynamic Performance Stats 236
show FFT peaks 225
Show Legend control 76
Show Min/Max/Mean Stats 244
Show trigger markers in plot 134
showing columns

Color column (Data Logger interface) 176
Color column (FFT Analyzer interface) 198
Plot column (Data Logger interface) 174
Plot column (FFT Analyzer interface) 195
Show Cursor column (Data Logger interface) 172
Show Cursor column (FFT Analyzer interface) 

194
Signal Group (Data Logger interface) 175
Signal Group (FFT Analyzer interface) 197
Visible Display (Data Logger interface) 181
Visible Display (FFT Analyzer interface) 229
Visible Plot column (Data Logger interface) 170
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